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Introduction

The most effective way for you to become familiar with OptiSystem is to complete the 
tutorials and read the advanced simulation projects in this document. You will learn 
how to use the software by solving problems. Some of the information described here 
is also described in the Quick Start section of the OptiSystem User’s Guide.

This document contains the following sections.

Tutorials
• Lesson 1: Transmitter — External modulated laser

• Lesson 2: Subsystems — Hierarchical simulation

• Lesson 3: Optical Systems — WDM Design

• Lesson 4: Parameter Sweeps — BER x Input power

• Lesson 5: Bidirectional Simulation — Working with multiple iterations

• Lesson 6: Time-Driven Simulation — Working with individual samples

• Lesson 7: Optical Amplifiers — Designing optical fiber amplifiers and fiber lasers

• Lesson 8: Optical Systems — Working with multimode components

Advanced simulation project sections
• Optical transmitters

• Optical fibers

• Optical receivers

• Doped optical fiber amplifiers
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Notes:
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Introductory Tutorials

This section contains the following introductory tutorials.

• Lesson 1: Transmitter — External modulated laser

• Lesson 2: Subsystems — Hierarchical simulation

• Lesson 3: Optical Systems — WDM Design

• Lesson 4: Parameter Sweeps — BER x Input power

• Lesson 5: Bidirectional Simulation — Working with multiple iterations

• Lesson 6: Time-Driven Simulation — Working with individual samples

• Lesson 7: Optical Amplifiers — Designing optical fiber amplifiers and fiber lasers

• Lesson 8: Optical Systems — Working with multimode components



 

4

Notes:
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Lesson 1: Transmitter — External modulated 
laser

This lesson describes how to create a transmitter using an external modulated laser. You will become 
familiar with the Component Library, the Main layout, component parameters, and visualizers.

To start OptiSystem, perform the following procedure:

Starting OptiSystem

Step Action 

1 On the Taskbar, click Start.

2 Select Programs > Optiwave Software > OptiSystem 9> OptiSystem.
OptiSystem opens and the graphical user interface appears (see Figure 1).

Figure 1 OptiSystem graphical user interface
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Main parts of the GUI

The OptiSystem GUI contains the following main windows:

• Project layout

• Dockers

— Component Library

— Project Browser

— Description

• Status Bar

Project layout

The main working area where you insert components into the layout, edit 
components, and create connections between components (see Figure 2).

Figure 2 Project layout window
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Dockers

Use dockers, located in the Main layout, to display information about the active 
(current) project:

— Component Library

— Project Browser

— Description

Component Library

Access components to create the system design (see Figure 3).

Figure 3 Component Library window
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Project Browser

Organize the project to achieve results more efficiently, and navigate through the 
current project (see Figure 4).

Figure 4 Project Browser window



 LESSON 1: TRANSMITTER — EXTERNAL MODULATED LASER

9

Description

Display detailed information about the current project (see Figure 5).

Figure 5 Description window

Status Bar

Displays useful hints about using OptiSystem, and other help. Located below the 
Project layout window.

Figure 6 Status Bar

Menu bar

Contains the menus that are available in OptiSystem (see Figure 7). Many of these 
menu items are also available as buttons on the toolbars or from other lists.

Figure 7 Menu bar
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Using the Component Library

In the following example, you design the external modulated transmitter. You will 
select components from the Component Library and place them in the Main layout.

Note: OptiSystem provides a set of built-in default components.

To use the Component Library, perform the following procedure.

Step Action 

1 To start a new project, from the Main toolbar, select File > New.
A blank Main layout appears in the Project layout window.

2 From the Component Library, select Default > Transmitters Library > 
Optical Sources.

3 Drag the CW Laser to the Main layout (see Figure 8).

Figure 8 Adding a CW Laser to the Main layout

4 From the Component Library, select Default > Transmitters > Modulators 
> Optical.

5 Drag the Mach-Zehnder Modulator to the Main layout (see Figure 9).

Note: By default, the auto connect feature is on. When you place a 
component to the Main layout, the input port of the component connects 
automatically to the output port of a component that it can connect to. To turn 
the auto connect feature off, see “Turning the Auto connect feature off and on” 
on page 12.
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6 From the Component Library, select Default > Transmitters Library > 
Bit Sequence Generators.

7 Drag the Pseudo-Random Bit Sequence Generator to the Main layout.

8 From the Component Library, select Default > Transmitters > 
Pulse Generators > Electrical.

9 Drag the NRZ Pulse Generator to the Main layout (see Figure 9).

Figure 9 Adding components to the Main layout
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Auto connect feature

By default, the Auto Connect on Drop feature is active. There are two ways that 
components can auto connect:

• Auto Connect on Drop: When you place a component from the Component 
Library in the Main layout, the input port of the component connects 
automatically to the nearest output port of another component.

• Auto Connect on Move: When you move a component in the Main layout, the 
input port of the component connects automatically to the nearest output port of 
another component.

Turning the Auto connect feature off and on

To turn the Auto connect feature off and on, perform the following procedure.

Step Action 

1 To turn the Auto connect feature off, click the active Auto Connect on Drop 
button and the Auto Connect on Move button on the Layout Operations 
toolbar.
The buttons are inactive (see Figure 10) and the components no longer 
connect automatically to each other.

Figure 10 Inactive Auto connect buttons

2 To turn the auto connect feature back on, click the inactive Auto Connect on 
Drop button and the Auto Connect on Move button on the Layout 
Operations toolbar.
The buttons are active (see Figure 11) and the components connect 
automatically to each other.

Figure 11 Active Auto connect buttons
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Connecting components manually

The only connectable ports are those which have the same type of signal being 
transferred between them.

The exception to this rule is the ports that can be added to a sub-system and certain 
components in the library that have ports, which support any type of signal (for 
example, Forks).

Note: You can only connect output to input ports and vice versa.

Figure 12 Rubber Band cursor

The rubber band cursor appears when you place the cursor over a port.

To connect components using the layout tool, perform the following procedure.

Step Action 

1 Place the cursor over the initial port.
The cursor changes to the rubber band cursor (chain link) (see Figure 12).
A tool tip appears that indicates the type of signal that is available on this port 
(see Figure 13).

2 Click and drag to the port to be connected.
The ports are connected.

Figure 13 Connecting components symbol

Figure 14 Connecting ports

• To connect the components, click on the port of one component and drag the 
connection to the port of a compatible component (see Figure 16).

a. Connect the Pseudo-Random Bit Sequence Generator output port to 
the NRZ Pulse Generator Bit Sequence input port.
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Figure 15 Connecting components

b. Connect the NRZ Pulse Generator output port to the available Mach-
Zehnder Modulator input port.

c. Connect the CW Laser output port to the Mach-Zehnder Modulator 
input port.

Figure 16 Connecting components

Visualizing the results

OptiSystem allows you to visualize simulation results in a number of ways. The 
Visualizer Library folder in the Component Library allows you to post process and 
display results from a simulation. The visualizer is categorized as an electrical or 
optical visualizer according to the input signal type.

For example, to visualize the electrical signal generated by the NRZ Pulse Generator 
in time domain, use an Oscilloscope Visualizer.
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Visualizing the results

To visualize the results, perform the following procedures.

Step Action 

1 From the Component Library, select Default > Visualizer Library > 
Electrical.

2 Drag the Oscilloscope Visualizer to the Main layout.

The optical signal can be also displayed by selecting visualizers from the 
library. For example, use an Optical Spectrum Analyzer and an Optical 
Time Domain Visualizer to visualize the modulated optical signal in time 
domain.

3 From the Component Library, select Default > Visualizer Library > Optical.

4 Drag the Optical Spectrum Analyzer to the Main layout.

5 Drag the Optical Time Domain Visualizer to the Main layout (see Figure 
17).

Figure 17 Visualizers in Main layout

Connecting visualizers

To visualize the signal from one component, you must connect the component output 
port to the visualizer input port.

You can connect more than one visualizer to one component output port. As a result, 
you can have multiple visualizers attached to the same component output port.

To connect visualizers, perform the following action.
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Action 

• To connect the component and visualizers, click on the output port of the 
component and drag it to the input port of the visualizer (see Figure 18).

Note: You can only connect one component to a visualizer input port.

a. Connect the NRZ Pulse Generator output to the Oscilloscope 
Visualizer input port.

b. Connect the Mach-Zehnder Modulator output to the Optical Spectrum 
Analyzer input port and to the Optical Time Domain Visualizer input 
port.

Figure 18 Connecting components to visualizers
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Visualizers and data monitors

When you connect a visualizer to a component output port, OptiSystem inserts a 
default data monitor to the component output port. You can then connect the 
component to the visualizer.

Note: Visualizers always connect to monitors. You can have multiple visualizers 
attached to the same component output port, because they are actually attached 
to the monitor, not to the component (see the Mach-Zehnder Modulator with 
connections to the OTDV and the OSD in Figure 19). Data monitors are 
represented by a rectangle around the component output port (see Figure 19 for 
examples of monitors on components).

Figure 19 Visualizers and monitors
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Connecting a monitor to a port

Visualizers post-process the data that the data monitor saves. You can connect a 
monitor to a port without connecting to a visualizer, and the monitor will save the data 
after the simulation ends. If you insert a monitor into a port before the simulation 
starts, you can connect visualizer to this monitor after the simulation ends without 
having to run the simulation again.

To connect a monitor to a port, perform the following procedure.

Step Action 

1 From the Layout Tools toolbar, select the Monitor Tool.
The cursor changes to the Monitor tool.

2 Click the CW Laser output port.

3 To disable the Monitor tool, on the Layout Tools toolbar, click the 
Layout tool.
The monitor saves the signals at the CW Laser output.

Note: If a port already has a monitor, clicking the port with the Monitor tool 
removes the existing monitor.
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Component parameters

Viewing and editing component properties

To view the properties of a component, perform the following action.

Action 

• In the Main layout, double click the CW Laser.
The CW Laser Properties dialog box appears (see Figure 20).

Component parameters are organized by categories. The CW Laser has five 
parameter categories.

• Main — includes parameters for accessing a laser (Frequency, Power, Line width, 
Initial phase)

• Polarization

• Simulation

• Noise

• Random numbers

Figure 20 Component parameters
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Each category has a set of parameters. Parameters have the following properties:

• Disp

• Name

• Value

• Units

• Mode

Display parameters in the layout

The first parameter property is Disp. When you select this property, the parameter 
name, value, and unit appear in the Main layout. For example, if you select Disp for 
Frequency and Power, these parameters appear in the Main layout (see Figure 21).

Figure 21 Displaying parameters in the Main layout

Parameter units

Some parameters, such as Frequency and Power, can have multiple units. 
Frequency can be in Hz, THz or nm, and Power can be in W, mW, or dBm (see 
Figure 22). The conversion is automatic.

Note: You must press Enter or click in another cell to update the values.

Figure 22 Parameter units

Changing parameter modes: arithmetic expressions

Each parameter can have three modes: Normal, Sweep and Script. Script mode 
allows you to enter arithmetic expressions and to access parameters that are defined 
globally.
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To change parameter modes, perform the following procedure.

Step Action 

1 In the Main layout, double-click the CW Laser.
The CW Laser Properties dialog box appears (see Figure 23).

2 Click in the Mode cell beside Frequency.
A drop-down list appears.

3 From the drop-down list, select Script.

4 Click in the Value cell beside Frequency.

5 In the Parameter Script Editor dialog box, type:

193.1+0.1

6 Click Evaluate, and OK.

7 Click Evaluate Script.
The value of the script expression appears in the message window at the 
bottom of the CW Laser Properties dialog box. The Frequency result is 
193.200000.

8 To save the settings and return to the Main layout, click OK.

Figure 23 Scripted parameters
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Accessing visualizer parameters

To access the parameters for a visualizer, perform the following procedure.

Note: You must right-click on a visualizer to access the parameters. Double-
clicking on a visualizer brings up a dialog box to visualize the graphs and results 
generated during the simulation, not the parameters.

Step Action 

1 In the Main layout, select and right-click on the Optical Spectrum Analyzer.
A context menu appears (see Figure 24).

2 From the context menu, select Component Properties.
The Optical Spectrum Analyzer Properties dialog box appears (see Figure 
25).

Figure 24 Layout menu
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Figure 25 Visualizers parameter dialog

3 To save the settings and return to the Main layout, click OK.
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Running the simulation

OptiSystem allows you to control the calculation in three different ways: 

• Calculate the whole project: all sweep iterations for multiple layouts 

• Calculate all sweep iterations in the active layout: all sweep iterations for the 
current layout

• Calculate current sweep iteration: current sweep iteration for the current layout

By default, you will calculate the whole project, since there are currently no multiple 
layouts and no sweep iterations.

To run a simulation, perform the following procedure.

Step Action 

1 From the File menu, select Calculate.
The OptiSystem Calculations dialog box appears (see Figure 26).

2 In the OptiSystem Calculations dialog box, click Run to start the simulation 
(see Figure 26).
The calculation output appears in the dialog box, and the simulation results 
appear below the components that were included in the simulation in the 
Main layout.

Figure 26 Running the simulation

Run

Calculation results appear here.
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Saving the simulation results

OptiSystem allows you to save the data from the monitors. This allows you to save 
the project file with the signals from the monitors. Next time you load the file, the 
visualizers will recalculate the graphs and results from the monitors.

To save the simulation results, perform the following procedure.

Step Action 

1 After the calculation ends, from the Tools menu, select Options.
The Options dialog box appears (see Figure 27).

2 Select Save Monitor Data, and click Save.
The results are saved with the project file.

3 Select File > Calculate.
The Optisystem Calculations dialog box appears.

4 In the OptiSystem Calculations dialog box, click Run to start the simulation 
(see Figure 26).

5 When the calculation is finished, select File > Save As.
The Save As dialog box appears (see Figure 28).

6 Save the project.

Note: When saving monitors the project file size may become very large. 
There is also a delay when reloading the project, due to the fact that 
visualizers will recalculate during the loading of the file.

Figure 27 Options dialog box—Save Monitor Data selection
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Figure 28 Save As dialog box

Displaying results from a visualizer

To display results from a visualizer, perform the following action.

Action 

• Double-click a visualizer to view the graphs and results that the simulation 
generates.

Note: Double-click again to close the dialog box.

Oscilloscope

To visualize electrical signals in time domain with an oscilloscope (see Figure 29), 
perform the following action.

Action 

• Double-click the Oscilloscope Visualizer.
The Oscilloscope Visualizer dialog box appears.
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Since OptiSystem can propagate the signal and noise separately, you can visualize 
the results separately. Use the tabs on the left side of the graph to select the 
representation that you want to view.

• Signal

• Noise

• Signal + Noise

• All

Figure 29 Oscilloscope
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Optical Spectrum Analyzer

To visualize optical signals in frequency domain with an Optical Spectrum Analyzer 
(see Figure 30), perform the following action.

Action 

• Double-click the Optical Spectrum Analyzer.
The Optical Spectrum Analyzer dialog box appears.

Since OptiSystem uses a mixed signal representation, you can visualize the signal 
according to the representation. Use the tabs on the left side of the graph to select the 
representation that you want to view.

• Sampled

• Parameterized

• Noise

• All

To access the optical signal polarization, use the tabs at the bottom of the graph.

• Power: Total power

• Power X: Power from polarization X

• Power Y: Power from polarization Y

Figure 30 OSA
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Optical Time Domain Visualizer

To visualize optical signals in time domain with an Optical Time Domain Visualizer 
(see Figure 31), perform the following procedure.

Action 

• Double-click the Optical Time Domain Visualizer.
The Optical Time Domain Visualizer dialog box appears.

In time domain, OptiSystem translates the optical signal and the power spectral 
density of the noise to numerical noise in time domain. Use the tabs at the bottom of 
the graph to select the representation that you want to view.

Power: Total power

Power X: Power from polarization X

Power Y: Power from polarization Y

Note: When you select polarization X or Y, you can also select to display the 
phase or chirp of the signal for that particular polarization. 

Figure 31 Optical Time Domain Visualizer
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Info-Window

When you open the Info-Window, it appears in the work area of a visualizer graph. 
By default, the Info-Window displays the current position (in database coordinates) 
of the cursor. When you zoom, pan, or trace the graph, the coordinates in the 
Info-Window change to reflect the coordinates of the cursor.

Accessing the Info-Window

To access the Info-Window, perform the following procedure.

Step Action 

1 Double-click a visualizer to view the graph.

2 To open the Info-Window, right-click anywhere on the graph and select the 
Info tool from the graph toolbox that appears (see Figure 32),

or

Click the Graph Menu button (top left corner of graph) and select 
InfoWindow.
The Info-Window appears beside the graph.

Note: Enlarge the graph window to increase the size of the graph.

Figure 32 Graph toolbox
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Zoom, Pan, and Trace tools

The Zoom, Pan, and Trace tools help you analyze and extract information from the 
graphs.

Zooming into a graph

To zoom into a graph, perform the following procedure.

Step Action 

1 To open the Optical Spectrum Analyzer display, double-click the Optical 
Spectrum Analyzer.

2 Open the Info-Window (see Accessing the Info-Window).

3 To access the Zoom tool, right-click anywhere on the graph and select the 
Zoom tool from the graph toolbox that appears,

or

Click the Graph Menu button and select Zoom.
The cursor changes into a magnifying glass.

4 Click and drag the magnifying glass cursor over the area of the graph that you 
want to zoom into.
The cursor coordinates appear in the Info-Window.

Note: By default, the zoom operation zooms into the center of the center of 
the grid.

5 Double-click anywhere on the graph to return to the original size.

Panning a graph

To pan a graph and view a specific area, perform the following procedure.

Step Action 

1 To open the Optical Spectrum Analyzer display, double-click the Optical 
Spectrum Analyzer.

2 Open the Info-Window (see Accessing the Info-Window).

3 To access the Pan tool, right-click anywhere on the graph and select the Pan 
from the graph toolbox that appears.

or

Click the Graph Menu button and select Pan.
The cursor changes into a hand.

4 Use the Pan tool to move the graph and view a specific area of the graph.
The cursor coordinates appear in the Info-Window.
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Tracing a graph

To trace a graph and obtain the values for each point in the graph, perform the 
following procedure.

Step Action 

1 To open the Optical Spectrum Analyzer display, double-click the Optical 
Spectrum Analyzer.

2 Open the Info-Window (see Accessing the Info-Window).

3 To access the Tracer tool, right-click anywhere on the graph and select 
Tracer from the graph toolbox that appears.

or

Click the Graph Menu button and select Tracer.
The cursor changes into a double-headed arrow

4 To view the X and Y line coordinates, click anywhere in the graph.
The X and Y line coordinates appear.

5 Move the X and Y line coordinates to the position on the graph curve that you 
want to view the coordinates for.
The cursor and Tracer coordinates appear in the Info-Window.
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Saving graphs

You can obtain the table of points with the values for each point in the graph and then 
save this as a test file. Copy the graph to the clipboard as a bitmap, or export the 
graph in different file formats — for example, metafile or bitmap.

To save a graph, perform the following procedure.

Step Action 

1 From the Graph Menu button, select Export Data.
The Data Table dialog box appears.

2 To save the data as a text file, click Export Curve.
The Save As dialog box appears (see Figure 33).

3 Select the folder where you want to save the data.

4 Type a name for the file, and click Save.

5 To return to the graph, click OK.

Figure 33 Graph menu dialog
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Figure 34 Data Export dialog
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Notes:
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Lesson 2: Subsystems — Hierarchical 
simulation

A subsystem is like a component — it has an icon, parameters, and input and output 
ports. You build a subsystem using a group of components or other subsystems. You 
can easily create a subsystem by grouping selected components in the layout (see 
Figure 1). 

Subsystems help you to create your own components based on the Component 
Library without programming, and to organize the layout in different hierarchical levels 
when there are a large number of components in different levels.

Figure 1 Hierarchical simulation

This lesson describes how to create a subsystem using the External Modulated Laser 
subsystem from Lesson 1: Transmitter — External modulated laser. You will become 
familiar with subsystems and the Component Library.

Loading a sample file

To load a sample file, perform the following procedure.

Step Action 

1 From the File menu, select Open.

2 From your C: drive, select Program Files > Optiwave Software > 
OptiSystem 9 > samples > Introductory tutorials > “Lesson 2 
Subsystems - Hierarchical simulation.osd”.
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Creating a subsystem

To create a subsystem, perform the following procedure.

Step Action 

1 In the Main layout, select the components that you want to include in the 
subsystem.
A box appears around the selected components (see Figure 2)..

2 Right-click the selection.
A context menu appears (see Figure 24 from Lesson 1).

3 From the context menu, select Create Subsystem.
The subsystem appears in a glass box. When you look inside the subsystem, 
a subsystem tab appears at the bottom of the Main layout (see Figure 3).

Note: The visualizers that are not included in the selection are disconnected. 
The subsystem does not add additional ports to connect the visualizers.

Figure 2 Creating a subsystem—Selected components in the Main layout

Looking inside a subsystem

To look inside a subsystem, perform the following procedure.

Step Action 

1 Select the subsystem glass box and right-click.
A context menu appears (see Figure 3)

2 From the context menu, select Look Inside.
The subsystem opens and a Subsystem tab appears beside the 
Main layout tab at the bottom of the subsystem layout window (see Figure 
3).
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Figure 3 Looking inside a subsystem

3 To return to the Main layout and close the subsystem, right-click in the 
subsystem layout and select Close Subsystem from the context menu (see 
Figure 24 from Lesson 1),

or

To return the Main layout and leave the subsystem open, click the Main 
Layout tab.
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Creating a subsystem output port

You can change parameters and create ports in order to access the signals from the 
subsystem.

Step Action 

1 Select the subsystem glass box and right-click.
A context menu appears.

2 From the context menu, select Look Inside.
The subsystem opens.

3 From the Layout Tools toolbar, select Draw – Output Port Tool.
The cursor changes into a cross-hatch.

4 Position the cursor on the edge of the subsystem layout where you want to 
add the output port.
The cross-hatch changes into an output port.

5 Click to place the output port.
The output port is created (see Figure 5).

Connecting a component output port to a subsystem output port

To connect the Mach-Zehnder Modulator output port to the subsystem output port, 
perform the following procedure.

Step Action 

1 From the Layout Tools toolbar, select Layout Tool .
The cursor changes into the Layout Tool.

2 Click the Mach-Zehnder output port.
The cursor changes into a link (see Figure 4).

3 To connect the Mach-Zehnder output port to the subsystem output port, drag 
the cursor from the Mach-Zehnder output port to the subsystem output port 
(see Figure 5).
The output ports are connected.

4 Click the Main Layout tab to return to the Main layout.
The output port appears in the subsystem.

Note: Use the same procedure to create input ports. Because this is a 
transmitter, you will not create input ports in this lesson.
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Figure 4 Link tool in the subsystem

Figure 5 Linking output ports

Changing the port position and location

To change the port position and location, perform the following procedure.

Step Action 

1 In the Main layout, double-click the subsystem port,

or

In the subsystem, double-click the port.
The Port Properties dialog box appears (see Figure 6).

2 Select the position in the subsystem that you want to move the port to:

• Top

• Bottom

• Left

• Right
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3 Move the slider to specify the exact position that you want to select.

4 To return to the Main layout, click OK.

Figure 6 Port properties
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Subsystem properties — name and icon

You can change the name and add an icon for a subsystem by changing the 
subsystem parameters.

Changing a subsystem name

To change the subsystem name, perform the following procedure.

Step Action 

1 In the Main layout, double-click on the subsystem.
The Subsystem Properties dialog box appears.

2 In the Label field, type External Modulated Transmitter (see Figure 7).

3 To return to the Main layout, click OK.
The new subsystem name appears below the subsystem glass box and on 
the subsystem tab (see Figure 8).

Figure 7 Subsystem properties dialog
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Figure 8 Subsystem modified tab name

Adding a subsystem icon

You can load a user-defined image from a file to use as the a subsystem icon.

To add a subsystem icon, perform the following procedure.

Step Action 

1 In the Main layout, double-click the External Modulated Transmitter 
subsystem glass box.
The External Modulated Transmitter Properties dialog box appears.

2 Click the Value cell beside Subsystem Representation.
A drop-down list appears.

3 From the drop-down list, select User Image.

4 Click the Value cell beside Image Filename, and click 
The Open dialog box appears (see Figure 9).

5 Select the image that you want to use as the subsystem icon, and click Open.

Note: You can use the image External.bmp in the samples directory.
The image you selected appears as the External Modulated Transmitter 
subsystem icon (see Figure 10).

6 To return to the Main layout, click OK in the External Modulated 
Transmitter properties dialog box.

Figure 9 Subsystem dialog - User icon import
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Figure 10 User imported subsystem icon in Project layout

Adding global parameters to a subsystem

In this example, use the External Modulated Transmitter subsystem that you 
created. To access any parameter inside of the External Modulated Transmitter, 
look inside of the subsystem. 

To change the subsystem component parameter values without looking inside each 
time you need to access them, you can create global parameters (see Figure 11).

In the following procedures, you will export the Power and Frequency parameters so 
that you will be able to access them without looking inside the External Modulated 
Transmitter subsystem.

To add a global parameter to a subsystem, perform the following procedure.

Step Action 

1 In the Main layout, double-click External Modulated Transmitter 
subsystem.
The External Modulated Transmitter Properties dialog box appears.

2 Click Add Param.
The Add Parameter dialog box appears (see Figure 11).

3 Type the following values:

• Name: Frequency

• Type: floating-point

• Category: Main

• Minimum value: 100

• Maximum value: 200

• Current value: 193.1

• Units: THz

4 Click Add.
The Frequency parameter is added to the Main category. A message 
appears in the message window at the bottom of the dialog box to advise you 
that the Frequency parameter has been added.
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5 Click Add Param.
The Add Parameter dialog box appears.

6 In the Add Parameter dialog box, type the following values:

• Name: Power

• Type: floating-point

• Category: Main

• Minimum value: -100

• Maximum value: 30

• Current value: 0

• Units: dBm

7 Click Add.
The Power parameter is added to the Main category. A message appears in 
the message window at the bottom of the dialog box to advise you that the 
Power parameter has been added.

Figure 11 Add Parameter dialog
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Figure 12 Frequency parameter added to External Modulated Transmitter

Accessing global parameters

In the last section, you added two parameters to the subsystem. Now you must create 
a reference between the components inside the subsystem and the global 
parameters (see Figure 13).

To access global parameters, perform the following procedure.

Step Action 

1 Right-click on the External Modulated Transmitter subsystem.
A context menu appears.

2 Select Look inside.
The subsystem layout appears.

3 Double-click the CW Laser.
The CW Laser Properties dialog box appears.

4 Click in the Mode cell beside Frequency and select Script from the drop-
down list.

5 Click in the Units cell beside Frequency and select THz from the drop-down 
list.

6 Click the button in the Value cell beside Frequency.
The Parameter Script Editor dialog box appears.
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7 Type Frequency and click OK.

8 Click in the Mode cell beside Power and select Script from the drop-down 
list.

9 Click in the Units cell beside Power and select dBm from the drop-down list.

10 Click the button in the Value cell beside Power.
The Parameter Script Editor dialog box appears.

11 Type Power and click OK.

12 To return to the subsystem layout, click OK.

13 To return to the Main layout, click the Main Layout tab.

Figure 13 Using script parameters

For example, now when you change the value of the Frequency parameter for the 
External Modulated Transmitter subsystem, you will change the values for the CW 
Laser inside the External Modulated Transmitter subsystem.
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Component Library

The OptiSystem Component Library consists of four sub-libraries (see Figure 14).

• Default: Read-only — you cannot add or change the parameters of a default 
component.

• Custom: Allows you to add new components and expand the Component Library.

Note: You can base new components on components from the Default library. 
However, the component name must be different from the name of the 
component in the Default library. You can also include subsystems in the Custom 
library.

• Favorites: Allows you to add components to a library that includes the ones you 
use most frequently.

• Recently used: Components that you have used in recent projects are added 
automatically to the Recently used library.

Figure 14 Component Library

Before you add the External Modulated Transmitter to the Custom library, you will 
create a new folder named Transmitters (see Figure 15).
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Creating sub folders in the Custom Library

To create a a sub folder in the Custom library, perform the following procedure.

Step Action 

1 From the Component Library, select Custom.
The Custom library opens.

2 Right-click in the background of the Custom library.
A context menu appears (see Figure 15).

3 Select Add Folder.
The New Folder dialog box appears (see Figure 16).

4 Type Transmitters and click OK.
A new folder named Transmitters appears in the Custom library in the 
Component Library (see Figure 17).

Figure 15 Creating a custom folder menu

Figure 16 Add Folder dialog

Figure 17 Added folder in Custom library
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Adding a component to the library

You can drag components to any folder in the Custom library. To add the External 
Modulated Transmitter to the Custom library in the Transmitters folder (see Figure 
18), perform the following procedure.

Step Action 

1 Double-click the Transmitters folder in the Custom library.

2 In the Main layout, select the External Modulated Transmitter component.

3 Drag the External Modulated Transmitter subsystem into the Transmitters 
folder.
The External Modulated Transmitter subsystem appears in the 
Transmitters folder.

Figure 18 Added component in Custom Library

Creating additional ports

To access the electrical signal from the NRZ Pulse Generator inside the External 
Modulated Transmitter subsystem, create an additional output port in the subsystem 
(see Figure 19).

To create a port, perform the following procedure.

Step Action 

1 In the Main layout, right-click on the External Modulated Transmitter.
A context menu appears.

2 Select Look Inside.
The subsystem layout appears.
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3 Create a new output port in the subsystem (see “Creating a subsystem output 
port” on page 40).

Figure 19 Adding a new output port to the subsystem

Output port

Adding a fork to the subsystem

You cannot connect the NRZ Pulse Generator output to this port because it's already 
connected to the Mach-Zehnder Modulator input. To solve this problem, you can 
duplicate the signal from the NRZ Pulse Generator and connect it to both the Mach-
Zehnder Modulator input and subsystem output ports by adding a fork (see Figure 
20).

To add a fork to the subsystem, perform the following procedure.

Note: To increase the size of the layout, press Ctrl+Shift and drag the cursor 
from the top left corner of the Main layout to the bottom right corner.

Step Action 

1 From the Component Library, select Default > Tools Library. 

2 Drag the Fork 1x2 to the Main layout.

3 Select the blue connection between the NRZ Pulse Generator and the 
Mach-Zehnder Modulator.
The selected connection changes to red.

4 Press Delete to delete the connection.

5 Connect the NRZ Pulse Generator output to the Fork input.
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6 Connect the first Fork output to the subsystem output port.

7 Connect the second Fork output to the available Mach-Zehnder Modulator 
input port (see Figure 20).

Note: To delete the internal data monitors, from the Layout Tools toolbar 
select the Monitor tool and click the monitor in each component output port.

Figure 20 External Modulated Transmitter with two output ports

8 To return to the Main layout, click the Main Layout tab.
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Saving the modified subsystem

To save the modified subsystem, perform the following procedure.

Step Action 

1 In the Transmitters folder in the Custom library, select and right-click the 
External Modulated Transmitter.
A context menu appears.

2 Select Delete.

3 Drag the modified External Modulated Transmitter from the Main layout 
into the Transmitters folder in the Custom library.

Running the External Modulated Transmitter simulation

To run the simulation for the External Modulated Transmitter, perform the following 
procedure.

Note: Before you run the simulation, you must connect the External Modulated 
Transmitter output port to a component or visualizer.

Step Action 

1 Connect the first External Modulated Transmitter output to the 
Oscilloscope Visualizer.

2 Connect the second External Modulated Transmitter output port to the 
Optical Spectrum Analyzer and to the Optical Time Domain Visualizer.

3 Run the simulation:

a. Click Calculate.

b. Click the PLAY button.
The results appear in the Calculation Output window.

4 To view the graphs of the results, double-click each visualizer (see Figure 21).

Note: The center frequency and power of the transmitter are defined by the 
values of the Frequency and Power parameters.
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Figure 21 Results from External Modulated Transmitter
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Notes:
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Lesson 3: Optical Systems — WDM Design 

This lesson describes how to simulate a WDM system with 8 channels. You will 
become familiar with the Component Library, parameter groups, and visualizers such 
as the BER Analyzer.

Global parameters

For this simulation we will use default parameters for the Bit rate, Bit sequence 
length, and Sample rate.

Viewing the global parameters

To view the default global parameters, perform the following procedure.

Step Action 

1 From the File menu, select New.
A blank Main layout appears in the Project layout window.

2 Double-click anywhere in the Main layout.
The Layout 1 Parameters dialog box appears (see Figure 1).

The default global parameters used for this simulation are:

• Bit rate: 2500000000 Bits/s

• Sequence length: 128 bits
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• Time window: 5.12e-008

Figure 1 Global parameters
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Transmitters

To create the transmitters for the WDM system with 8 channels, perform the following 
procedure.

Step Action 

Note: To increase the size of the layout, press Ctrl+Shift and drag the cursor 
from the top left corner of the Main layout to the bottom right corner.

1 Create an external modulated laser using the procedures in Lesson 1: 
Transmitter — External modulated laser.

2 Select the four external modulated laser components.

3 Copy and paste the selected components to create a total of eight 
transmitters (see Figure 2).

Figure 2 Creating eight external modulated lasers
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4 From the Component Library, select Default > WDM Multiplexers Library > 
Multiplexers.

5 Drag the WDM Mux 8x1 to the Main layout.

6 Connect the Mach-Zehnder Modulator outputs to the WDM Mux 8x1 inputs.

Note: You can select the values for the Mux internal filters to be displayed in 
the layout by selecting the Disp option in the Channels tab of the Mux 
properties dialog box (see Figure 3).

Figure 3 Displaying multiplexer frequency channels
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Parameter groups

To enter the frequency values for each channel, double-click each CW Laser and 
enter the frequency value. To simplify the process of entering parameter values for 
each component, use the Parameter groups feature.

Accessing the Parameter groups table

The Parameter groups table gives you access to relevant parameters for the WDM 
simulation (such as Frequency and Power) in one place. You can go into each 
component and enter the values to change the parameters.

To access a parameter group, perform the following procedure.

Step Action 

1 From the Main toolbar, select Layout > Parameter groups.
The Parameter Groups dialog box appears (see Figure 4).

Note: Typically you can access the following parameters from the Parameter 
Groups table (see Figure 4):

• Bit rate

• Convert noise bins

• Frequency

• Iterations

• Output signal type

• Power

• Sample rate

You can also enter the units for the parameter group and edit the parameter 
values by typing new values or using the tools from the context menu.
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Figure 4 Parameter groups

2 Click the Value column.
The Value column is highlighted.

3 In the Parameters Groups table, select the Value column and right-click.
A context menu appears.

4 Select Spread.
The Parameter Group Spread dialog box appears (see Figure 5).

5 In the Start Value text box, type:

193.1

6 In the Increment text box, type:

0.1

7 To return to the Main layout, click Close.
The frequencies in the Value column are updated from 193.1 THz to 
193.8 THz (see Figure 5).
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Figure 5 Entering frequency values

Testing the transmitter

To verify the system setting for this design, use an Optical Spectrum Analyzer and 
a WDM analyzer to obtain the signal spectrum and the total power for each channel.

To test the transmitter, perform the following procedure.

Step Action 

1 From the Component Library, select Default > Visualizer Library > Optical.

2 Drag the Optical Spectrum Analyzer to the Main layout.

3 Drag the WDM Analyzer to the Main layout.

4 Connect the Optical Spectrum Analyzer input and the WDM Analyzer input 
to the WDM Mux output.

5 Run the simulation:

a. Click Calculate.
The Calculation dialog box appears.

b. Click the Run button.
The calculation progress appears in the Calculation dialog box.

6 Double-click Optical Spectrum Analyzer to view the graph (see Figure 6).
The graph appears and displays eight equally-spaced channels.

7 Double-click the WDM Analyzer to view the numerical results (see Figure 6).
The WDM Analyzer dialog box appears and displays the numerical results 
for the eight channels.

Note: The average signal power for each channel is approximately -3.3 dBm 
for a resolution bandwidth of 0.1 nm.
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Figure 6 Simulation results from the visualizers

Fiber + EDFA spans

To create a fiber connected to an EDFA, perform the following procedure.

Step Action 

1 From the Component Library, select Default > Optical Fibers Library.

2 Drag the Optical Fiber to the Main layout.

3 Double-click the Optical Fiber.
The Optical Fiber Properties dialog box appears.

4 To change the parameter length to 80 km, click the Value cell beside Length, 
and type:

80
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5 To return to the Main layout, click OK.

6 From the Component Library, select Default > Amplifiers Library > Optical.

7 Drag the Optical Amplifier to the Main layout.

8 In the EDFA Parameters, change Operation Mode to Power Control.

9 Connect the Optical Fiber output to the EDFA Ideal input (see Figure 7).

Figure 7 Fiber + EDFA span

Connecting the Loop Control

The Loop Control allows you to set the number of times the signal propagates in the 
components that are connected between the Loop Control input and output ports. 
Use the Loop Control to calculate the system performance based on the number of 
fibers and EDFA spans.
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To connect the Loop Control, perform the following procedure.

Step Action 

1 From the Component Library, select Default > Tools Library.

2 Drag the Loop Control to the Main layout.

3 Connect the output port of the WDM Mux 8x1 to the first Loop Control input 
port.

4 Connect the first Loop Control output port to the Optical Fiber input port 
(see Figure 8).

5 Connect the output port of the second EDFA Ideal (connected to the Optical 
Fiber) to the Loop Control input port (see Figure 8).

Figure 8 Loop control

Setting the number of signal round trips

You define the number of round trips that the signal makes through the loop by setting 
the Number of loops parameter in the Loop Control.

To set the number of signal round trips, perform the following procedure.

Step Action 

1 Double-click the Loop Control.
The Loop Control Properties dialog box appears (see Figure 9).



 LESSON 3: OPTICAL SYSTEMS — WDM DESIGN

67

Figure 9 Loop control parameters

2 To set the number of signal round trips, click the Value cell beside number of 
loops, highlight the 0, and type:

3

Note: The signal will propagate 3 x 80km = 240 km.

3 To return to the Main layout, click OK.

4 From the Component Library, select Default > Optical Fibers Library.

5 Drag the Optical Fiber to the Main layout.

6 Set the fiber Length to 100km.

7 From the Component Library, select Default > WDM Multiplexers Library > 
Demultiplexers.

8 Drag the WDM Demux 1x8 to the Main layout.

9 Connect the second Loop Control output port to the Optical Fiber and then 
to the WDM Demux 1x8 input port (see Figure 10).

10 To view the WDM Demux 1x8 frequencies:

a. Double-click the WDM Demux 1x8
The WDM Demux 1x8 Properties dialog box appears.

b. Select the Channels tab.

c. In the Disp column, select the check box beside each frequency.

d. To return to the Main layout, click OK.
The eight frequencies and their values appear below the WDM 
Demux 1x8 (see Figure 10).
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Figure 10 Demultiplexer

Obtaining results after the demultiplexer

To verify the system setting for this design, you will use an Optical Spectrum 
Analyzer, a WDM Analyzer, and an Optical Time Domain Visualizer.

To obtain the signal results in time and frequency and the total power for each channel 
after the signal passes through the WDM Demux 1x8, perform the following 
procedure.

Step Action 

1 From the Component Library, select Default > Visualizer Library > Optical.

2 Drag the Optical Time Domain Visualizer to the Main layout.

3 Drag the Optical Spectrum Analyzer to the Main layout.

4 Drag the WDM Analyzer to the Main layout.

5 Connect each of the visualizers to the first output port on the WDM Demux 
1x8 (193.1 THz).

6 Run the simulation:

a. Click Calculate.

b. Click the Run button.
The calculation progress appears in the Calculation dialog box.

Note: This simulation will take some time.



 LESSON 3: OPTICAL SYSTEMS — WDM DESIGN

69

7 Double-click the visualizers to view the results and graphs (see Figure 11).

Figure 11 Simulation results from the visualizers
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Adding a receiver

To add a photodetector, an electrical amplifier, and a Bessel filter to the design, 
perform the following procedure.

Step Action 

1 From the Component Library, select Default > Receivers Library > 
Photodetectors.

2 Drag the Photodetector PIN to the Main layout.

3 Set the Thermal Noise parameter to 10-21.

4 From the Component Library, select Default > Filters Library > Electrical.

5 Drag the Low Pass Bessel Filter to the Main layout.

6 Connect the first output port on the WDM Demux 1x8 to the Photodetector 
PIN input port.

7 Connect the Photodetector PIN output port to the Low Pass Bessel Filter 
input port (see Figure 12).

Figure 12 Adding the receiver to the WDM system

Note: This design could be made using the WDM Transmitter component from 
the Optical Transmitters library. Fewer steps are required if you use this 
component. When using the WDM Transmitter, the receiver will require the 
3R Regenerator component from the Receivers library (see sample file 
Lesson3B.osd).
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Figure 13 WDM Transmitter layout design (Lesson 3B.osd)
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BER Analyzer

The BER Analyzer calculates system performance. It can predict the BER, Q-factor, 
threshold, and Eye aperture of a system. You can view the BER patterns and the BER 
value in each point of the Eye diagram using 3D graphs.

Adding the BER Analyzer

To add the BER Analyzer to the system, perform the following procedure.

Step Action 

1 From the Component Library, select Default > Visualizer Library > 
Electrical.

2 Drag the BER Analyzer to the Main layout.

Note: The first BER Analyzer input port receives the binary signal.

3 Connect the output port of the first Pseudo-Random Bit Sequence 
Generator to the first BER Analyzer input port.

Note: The second BER Analyzer input port receives the original sampled 
signal. It compensates the delay between the signals that are transmitted and 
received.

4 Connect the output of the first NRZ Pulse Generator to the second 
BER Analyzer input port.

5 Connect the Low Pass Bessel Filter output port to third BER Analyzer input 
port (see Figure 14).

Figure 14 Connecting the BER Analyzer

6 Run the simulation:

a. Click Calculate.

b. Click the Run button.
The calculation progress appears in the Calculation dialog box.

Note: This simulation will take some time.
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7 To display the results and graphs, double-click the BER Analyzer.

Viewing the BER Analyzer graphs and results

To view the BER Analyzer graphs and results, perform the following procedure.

Step Action 

1 Double-click the BER Analyzer.
The BER Analyzer window appears and displays a graph.

2 Select Show Eye Diagram.
The graph is redrawn and displays the Eye Diagram.

Note: When you open the BER Analyzer, the following graphs appear 
together with the Eye Diagram (see Figure 15):

– Q-Factor: Maximum value for the Q-Factor versus Decision Instant.

– Min BER: Minimum value for the BER versus Decision Instant.

– Threshold: Threshold value versus Decision Instant that gives the 
maximum Q-Factor and the Min BER.

– Height: Eye height versus Decision Instant.

– BER Pattern: When Calculate Patterns is selected, displays the regions 
where the BER value is less than the user-defined values.

Figure 15 BER Analyzer graphs
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The Analysis group box displays the following values (see Figure 16):

• Maximum Q-Factor

• Minimum BER

• Maximum eye aperture

• Threshold

• Decision Instant at the Max Q-Factor/ Min BER

Figure 16 BER Analyzer results

Calculating BER patterns

To calculate the BER patterns, perform the following procedure.

Step Action 

Note: The Calculate Patterns check box is only available when you select 
the BER Pattern tab (see Figure 17).

1 In the BER Analyzer window, select the BER Pattern tab.
The graph changes to display the BER Patterns graph.

2 Select the Calculate Patterns check box.
The visualizer recalculates the results and displays a new graph.
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Figure 17 Calculating BER patterns

Calculating the 3D BER graph

To calculate the 3D BER, perform the following procedure.

Step Action 

Note: You must enable the calculation of the BER patterns and the 3D graph.

1 Right-click the BER Analyzer.
A context menu appears.

2 Select Component Properties.
The BER Analyzer Properties dialog box appears.

3 Select the BER Patterns tab (see Figure 18).

4 Select the Value cell beside Calculate Patterns.

5 Select the Value cell beside Calculate 3D graph.

6 In the Disp column, select Calculate Patterns and Calculate 3D graph.

7 To recalculate the results and return to the Main layout, click OK.
The visualizer recalculates the graphs and results.
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Figure 18 Calculating 3D graph

Viewing the 3D graph

To view the 3D graph, perform the following procedure.

Step Action 

1 If the Project Browser is closed:

• From the Main toolbar, select View > Project Browser,

or

• Press Ctrl+2.

2 In the Project Browser, expand the BER Analyzer component.
A list of available options appears.

3 Expand the Graphs item in the list.
A list of BER Analyzer available graphs appears.

4 From the list of BER Analyzer graph items, right-click the BER Pattern 3D 
Graph.

5 Select Quick View.
The 3D graph appears (see Figure 19).
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Figure 19 3D graphs from the project browser
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Lesson 4: Parameter Sweeps — BER x Input 
power

This lesson describes how to combine the results from the BER/Eye Analyzer with the signal input power 
using parameter sweeps. You will become familiar with parameter sweeps, graph builder, results, graphs, 
and views.

The first three procedures describe how to iterate the Power parameter for the CW Laser component.

Opening the sample file

Use the sample file Lesson4 Parameter Sweeps - BER x Input power.osd. 
To open the file, perform the following procedure.

Step Action 

1 From the Main toolbar, select File > Open.
The Open dialog box appears.

2 From your C: drive, select Program Files > Optiwave Software > 
OptiSystem 9 > samples > Introductory tutorials > “Lesson4 Parameter 
Sweeps - BER x Input power.osd”.
The sample file appears (see Figure 1).

Figure 1 Sample file that calculates BER x Input power
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Selecting the parameter to iterate using the Sweep mode

To select the parameter to iterate using the Sweep mode, perform the following 
procedure.

Step Action 

1 Double-click the CW Laser.
The CW Laser Properties dialog box appears (see Figure 2).

2 In the Power row, click the Mode cell.
A drop-down list appears.

3 Select Sweep.

Figure 2 Changing the parameter mode to Sweep

4 To save the settings, click OK.
The CW Laser Properties dialog box closes.
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Changing the number of sweep iterations

We want to be able to calculate the design using different values of the input power.

To change the number of sweep iterations, perform the following procedure.

Step Action 

1 From the Layout menu, select Set Total Sweep Iterations.
The Total Parameter Sweep Iterations dialog box appears (see Figure 3).

2 In the Total Iterations, type:

10

3 To set the value and return to the Main layout, click OK.

Figure 3 Adding iterations
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Changing the values of sweep iterations

To change the values of sweep iterations, perform the following procedure.

Step Action 

1 From the Layout menu, select Parameter Sweeps.
The Parameter Sweeps dialog box appears.

2 Select the Power column (all cells).
The selected cells are highlighted.

3 Under Spread Tools, click Linear.
The Parameter Iteration Spread dialog box appears (see Figure 4).

4 In Start Value, type:

–10

5 In End Value, type:

10

6 To set the values, click OK.
The Parameter Iteration Spread dialog box closes.

7 To return to the Main layout, click OK.
The Parameter Sweeps dialog box closes.

Figure 4 Entering values for all iterations
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Running the simulation

To run the simulation, perform the following procedure.

Step Action 

1 Click Calculate.

2 Click the Run button.
The calculation progress appears in the Calculations dialog box window.

Obtaining results using the Report Page

To create a graph showing the BER versus the power, you must obtain the results 
generated by the BER Analyzer.

To obtain results using the Report Page, perform the following procedure.

Step Action 

1 Select the Report tab in the Project layout window.
The Report window appears.

2 Click the Opti2DGraph button on the Report toolbar and draw a 2D graph in 
the report window.
The 2D graph appears in the Report window.

3 In the Project Browser, select the parameter Power from the CW Laser, and 
drag it to the 2D graph X-axis (a grey triangle appears in the graph in the 
bottom right corner).
The graph appears in the Report window.

4 In the Project Browser, select the Min. log of BER result from the 
BER Analyzer component, and drag it into the Y-axis of the graph (the grey 
triangle appears in the top left corner).
The result is plotted in the graph.
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Figure 5 Building the graph
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Browsing parameter sweep iterations

You can open the BER Visualizer and obtain the Eye diagrams and graphs, such as 
Q-factor and BER, for different iterations changing the current sweep iteration.

To browse parameter sweep iterations, perform the following procedure.

Step Action 

1 In the Main layout, double-click the BER Analyzer.
The BER Analyzer graph opens.

2 Select the Show Eye Diagram check box.
The graph changes to display the Eye Diagram.

3 In the toolbar, change the Sweep iteration (see Figure 6).

Note: You obtain different results for each iteration, one for each input power 
value.

Figure 6 Browsing through the parameter sweep iterations, the Eye diagram, and Q-Factor for each value 
of laser power
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Combining graphs from sweep iterations

Visualizers can generate graphs for all sweep iterations.

You can access the graphs for all sweep iterations by using the Graph subfolder in 
the Project Browser.

Note: A visualizer will display only the current sweep iteration when you access 
the graphs by double-clicking on the graph and browsing for different iterations.

To combine graphs from sweep iterations, perform the following procedure.

Step Action 

1 If the Project Browser is closed:

• From the Main toolbar, select View > Project Browser

or

• press Ctrl+2.

2 Expand the Graphs subfolder for the BER Analyzer.
The list of available graphs appears.

3 Right-click Q Factor, and select Quick view,

or

4 Drag and drop the graph into the Report Page.
A graph appears and displays the iterations for each input power value (see 
Figure 7).

Figure 7 Multiple iterations graph
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Lesson 5: Bidirectional Simulation — Working 
with multiple iterations

Besides the typical global simulation parameters of OptiSystem, such as Bit rate, 
Samples per bit and Sequence length, there are two additional parameters that are 
very important when designing bidirectional systems or systems with closed loops, 
such as ring networks. 

These parameters are 

• Iterations

• Initial delay

Iterations force a component to calculate again until it generates, at the output ports, 
the Iterations number of signals. 

Initial delay forces a component to generate a null signal for each output port.

Because the majority of OptiSystem components will not calculate if a signal is not 
available at the input ports, the Iterations and Initial delay parameter will help the user 
to avoid a situation in which the simulation will not perform because a component 
cannot find signals at the input port - and the system will be deadlocked.

The concept of multiple iterations and delays is very confusing, because it does not 
have a physical meaning. It is a simulation technique and requires an understanding 
of the calculation scheduler of OptiSystem. 

A basic bidirectional simulation

System setup
• Using the default global parameters, we can start adding the components to 

design the basic bidirectional system. 

From the component library, drag and drop the following component in to the layout:

• From "Default/Transmitters Library/Optical Sources", drag and drop the "CW 
Laser" into the layout.

• Change the laser parameter Linewidth to 0 MHz.

• From "Default/Passives/Optical/Isolators", drag and drop the "Isolator" 
components into the layout.

• Change the Isolator parameter Insertion loss to 3 dB.

• From "Default/Visualizers Library/Optical", drag and drop 3 of the "Optical 
Spectrum Analyzer" into the layout.



 LESSON 5: BIDIRECTIONAL SIMULATION — WORKING WITH MULTIPLE ITERATIONS

88

The next step is to connect the components according to the Figure 1. Do not forget 
to connect the Isolator Input 2 at the Output 2.

Figure 1 Basic bidirectional system

Running the simulation

We can run this simulation and analyze the results:

• To run the simulation you can go to the File menu and select Calculate. You can 
also press Control+F5 or use the calculate button in the toolbar. After you select 
Calculate, the calculation dialog box should appear.

• In the calculation dialog box, press the Play button.The calculation should 
perform without errors.

Viewing the results - system deadlock

In order to see the results, double click at each of the OSA visualizers. 

The OSA connected at the CW Laser output will have a signal as presented in Figure 
2. 

As expected, we have a CW signal centered at 193.1 THz with peak power around 0 
dBm. However, the other two OSAs have no signals, and this is also expected. 

Why is this expected? It is expected because the Isolator does not have a signal at 
each input port. The laser will send a signal to the first input port of the isolator. 
However, the isolator will not calculate if a signal is not available at the second port - 
the system is deadlocked. 
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Figure 2 CW Laser output

Using delays

What if we add a delay at the second input port of the Isolator? 

• From "Default/Tool library", drag and drop the "Optical Delay" into the layout.

• Add another OSA to the system.

• Connect the component according to Figure 3.

The delay component is important because, unlike the Isolator, it will calculate without 
having a signal at the input port. If the laser and the delay calculate, the Isolator will 
have signals available at both input ports. 

Run the simulation again and open the visualizers.
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Figure 3 Basic bidirectional system using a delay

Viewing the results

Let's take a look at the signal at the second port of the Isolator. As expected, the input 
signal was attenuated by the isolator insertion loss and the peak power is -3 dBm. The 
OSA at the first isolator output shows the value of the return loss of the device and 
the peak power is -60 dBm.

Now, let's see the signal at the Delay output. If we open the OSA at the delay output 
there is no signal - it is empty. This is the result of the first calculation of the delay. 
There was no input signal and the delay generated a null signal. This null signal and 
the laser signal were sent to the Isolator inputs. The isolator calculated with these two 
signals and generated a signal per output port. 

One of the signals went back to the delay, which will then transfer the signal to its 
output port. This means there are two signals at the delay output: the null signal and 
the signal from the isolator.

In order to browse through the signals at the delay output you should use the Signal 
index parameter from the OSA. Set the signal index to 1 and you will see the signal 
from the isolator, with peak power of -3 dBm (Figure 4).
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Figure 4 Second signal at the delay output

This means we could calculate using the isolator, however the results are not exactly 
what we expect in this type of bidirectional system. There is a feedback between the 
second isolator input and output port that did not cause any effect in our results. We 
should force the signal to “circulate” between the laser, isolator and delay in order to 
see the signal evolution in the system. 

In order to force the signal to circulate multiple types in the system, we can force the 
laser to generate the same signal multiple times, forcing the component to calculate 
multiple times - because there will be signals available at the input ports of the isolator 
and delay. 
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Using Iterations parameter

Change the global parameter Iterations to 10, run the simulation again.

Viewing the results

Let's see the results from the OSAs. The laser generated 10 signals. You can change 
the signal index parameter at the laser output and see that the signal power does not 
change. This is expected, because we have 10 copies of the same signal. 

We expect the second isolator output signal to have -3dBm of power. However we 
don't know the power at the first isolator output port. This port will have the laser input 
power reflected by the return loss, plus the feedback signal attenuated by the isolator 
insertion loss. 

Look at the OSA at the isolator outputs in order to evaluate the results. Do not forget 
to change the signal index!

By changing the signal index you can see how the power changes per iteration. We 
are using 10 iterations but 2 or 3 should be enough to give a “steady-state” value for 
the output power of the OSAs.

Cascading devices

Let's make the system more complicated:

• Duplicate the Isolator.

• Connect the component according to Figure 5.

From what we learned until now, it seems obvious that this system will be deadlocked 
because the two Isolators will not have signals at the input ports. 

You can run the simulation and you will see that the 10 signals from the laser will not 
reach all the visualizers. In order to make the system work, we should add more 
delays:

• Duplicate the delay twice.

• Connect the component according to Figure 6.

If you run the simulation again, the system will run properly. You should increase the 
OSA signals index in order to visualize the proper results. 
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Figure 5 Basic bidirectional system cascading two isolators

Figure 6 Basic bidirectional system cascading two isolators and delays
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Using Initial delay parameter

The main problem with cascading these devices is that the user should add delays 
per each input port, and this can be cumbersome for some designs. This is why 
OptiSystem allows the user to include a delay by default for each input port:

• Remove the delays.

• Connect the component according to Figure 7.

• In the global parameters, enable parameter Initial delay.

• Run the simulation.

This time we have a clean design, without multiple delays. The final results are the 
same as adding the delays. 

There is one main difference between the designs of Figure 6 and 7. By enabling the 
global parameter initial delay, all components will generate a null signal, including the 
laser component. This is not true for Figure 6, in which only the delays generated the 
null signals.

Figure 7 Basic bidirectional system with two isolators in cascade
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Tools library

OptiSystem Tools Library has components that can manipulate signals and signal 
buffers. 

Signals can be duplicated, selected, initialized, etc. For example, Figure 8 presents a 
system that is equivalent to Figure 6, without using global parameters: Iterations = 1 
and Initial delay = disabled.

• Repeat the steps to generate Figure 6 layout.

• Set the global iterations parameter to 1.

• Set the Initial delay parameter to disabled status.

• From "Default/Tool library", drag and drop the "Duplicator" into the layout.

• Change the parameter Iterations mode to Normal. Set the value to 10.

• From "Default/Tool library", drag and drop the "Buffer selector" into the layout.

• Change the parameter Iterations and Selection mode to Normal. Set the value of 
Iterations to 10 and Selection to 9.

• Connect the component according to Figure 8.

• Run the simulation.

Figure 8 Bidirectional system using duplicator, delay and selector

This time the duplicator component will do the job of generating multiple signals. It will 
generate 10 copies of the signal from the laser. The selector will select the last signal 
from the input buffer and sent it to the output port. 
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This means the signal index parameter of the OSA connected to the Selector will have 
only one value:0. This is because the other signals were filtered by the selector 
component.
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Lesson 6: Time-Driven Simulation — Working 
with individual samples

One of the main features of OptiSystem is the mixed signal representation.

Individual sample is a signal type that allows the users to simulate time-driven 
systems in the electrical and optical domain. By using time-driven simulation, users 
can create designs that have closed loops and feedbacks. 

Additionally, the optical individual sample allow for simulation of WDM systems by 
using multiple bands. Each band shares the same sample rate and time window, but 
they can have different center frequencies.

To manipulate individual samples, there are four new components available in the 
component library:

Signal Processing 
Library/Tools/Electrical/

Signal Processing Library/Tools/ 
Electrical/

Signal Processing 
Library/Tools/Optical/

Signal Processing 
Library/Tools/Optical/

To verify if a component is compatible with individual samples, you should check 
OptiSystem component library documentation.

Component name Folder Icon

Convert To Electrical Individual 
Samples

Convert From Electrical 
Individual Samples

Convert To Optical Individual 
Samples

Convert From Optical Individual 
Samples
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A Time-Driven Simulation

Global parameters

To reduce the calculation time, we should reduce the number of samples of the 
signals that will be calculated during the simulation.

To reduce the number of samples, we can reduce the sequence length and the 
number of samples per bit. 

• In the global parameters dialog box, change the parameter Sequence length to 
16, and the Samples per bit to 32. The Number of samples parameter should be 
512 (Figure 1).

Figure 1 Global parameters

This means that we will have 512 individual samples at the output of the Convert To 
Electrical Individual Samples component, and 512 individual samples per WDM 
channel at the output of the Convert To Optical Individual Samples component.
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System setup

We can start adding the components to design the basic time-driven system. 

From the component library, drag and drop the following component in to the layout:

• From "Default/Transmitters Library/Optical Sources", drag and drop the "CW 
Laser" into the layout.

• From "Default/Transmitters Library/Bit Sequence Generators", drag and drop the 
"Pseudo-Random Bit Sequence Generator" into the layout.

• From "Default/Transmitters Library/Pulse Generators/Electrical", drag and drop 
the "NRZ Pulse Generator" into the layout.

• From "Default/Visualizers Library/Optical", drag and drop the "Optical Time 
Domain Visualizer" into the layout.

• From "Default/Visualizers Library/Electrical", drag and drop the "Oscilloscope 
Visualizer" into the layout.

The next step is to connect the components according to the Figure 2. 

Figure 2 First layout
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Running the simulation

We can run this simulation and analyze the results:

• To run the simulation, you can go to the File menu and select Calculate. You can 
also press Control+F5 or use the calculate button in the toolbar. After you select 
Calculate, the calculation dialog box should appear.

• In the calculation dialog box, press the Play button.

Viewing the results

To see the results, double click at each of the time domain visualizers. The optical and 
electrical signals are available in Figure 3.

These are the graphs of the sampled signals. To convert these signals into individual 
samples, we can use the components from Table 1.

Figure 3 CW Laser output and NRZ pulse generator output

System setup - Individual Samples
• Drag and drop the components from Table 1 into the layout.

• Duplicate the time domain visualizers

• Connect the components according to the Figure 4.

• Run the simulation
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Figure 4 Layout using the individual sample tools

Viewing the results

To see the results, double click at each of the time domain visualizers. 

The optical and electrical signals are available in the Figure 5. You will notice that the 
signals are the same as in Figure 3. 

The CW laser will send a sample signal to the 'Convert to…' component. This 
component will generate 512 samples and send each one of them to the 'Convert 
from…' component. The 512 samples will be combined into a signal that should be 
the same as the original signal from the laser. The same process applies to the 
electrical signal.
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Figure 5 'Convert from…' components outputs

Important remarks
• Visualizers cannot display individual samples. You should use a 'Convert From…' 

component before a visualizer.

• Check if a component is compatible with individual samples before creating a 
project.

• The project scope that requires simulation using individual samples must be 
confined between the 'Convert To...' and 'Convert From…' components.

• For each individual sample a component will run one calculation. This means the 
simulation will be slower when using individual samples.

• Faster simulation can be obtained by disabling calculation scheduler messages. 

Filtering using individual samples

There are two type of filtering techniques used in OptiSystem when working with 
individual samples. 

If a filter has the parameters Digital filter and Digital filter order available, the user can 
enable the FIR filter and enter the number of coefficients for the filter. 

Be aware of the FIR filter latency because the filter will introduce a delay equal to one 
half of the number of coefficients.

If the filter does not have these parameters or if the 'Digital filter' parameter is 
disabled, the individual samples will be attenuated by the value at the filter center 
frequency

In this case, we are assuming that the filter bandwidth is much wider than the sample 
rate. For optical signals, there attenuation will be wavelength dependent. 

This means that every individual sample will have a different value of attenuation 
depending on the filter shape. 

• From "Default/Filters Library/Electrical", drag and drop the "Low Pass Bessel 
Filter" into the layout.

• From "Default/Filters Library/Optical", drag and drop the "Bessel Optical Filter" 
into the layout.
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• For both components, enable the parameter Digital filter.

• Connect the components according to the Figure 6.

• Run the simulation.

Figure 6 Filtering individual samples

Viewing the results

Compare the signals from the two Oscilloscopes (Figure 7). You will see that the 
second signal is delayed and filtered. This is related to the FIR filter used in the low 
pass filter. The same applies to the optical signal.

Figure 7 Electrical signal before and after FIR filter
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Notes:
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Lesson 7: Optical Amplifiers — Designing 
optical fiber amplifiers and fiber lasers

OptiSystem allows the design and simulation of optical fiber amplifiers and fiber 
lasers. 

The projects presented here are available under OptiSystem installation folder 
samples\Optical amplifiers. 

This tutorial will describe part of the library of optical amplifiers. 

There are four categories of components in the library: 

• EDFA

• Raman

• SOA

• Waveguide amplifiers 

The EDFA folder contains the Erbium-doped fiber model and other models to allow 
the simulation of EDFAs in the steady-state condition. Furthermore, the folder 
includes models to simulate erbium-ytterbium codoped fiber, ytterbium-doped fiber 
and dynamic models for the erbium and ytterbium fibers.
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Table 1 Doped fiber models

Amplifiers Library/Optical/EDFA

Amplifiers Library/Optical/EDFA

Amplifiers Library/Optical/EDFA

Amplifiers Library/Optical/EDFA

Amplifiers Library/Optical/EDFA

Amplifiers Library/Optical/EDFA

Amplifiers Library/Optical/EDFA

Amplifiers Library/Optical/EDFA

Amplifiers Library/Optical/EDFA

Amplifiers Library/Optical/EDFA

The second category is the Raman models. These components allow the simulation 
of Raman fiber amplifiers. The Raman folder includes the Raman models for steady 
state and dynamic conditions. 

Component name Folder Icon

Erbium Doped Fiber

EDFA

EDFA Black Box

Optical Amplifier

EDFA Measured

EDF Dynamic

EDF Dynamic Analytical

Er-Yb Codoped Fiber

Yb Doped Fiber

Yb Doped Fiber Dynamic
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Table 2 Raman models

Amplifiers Library/Optical/Raman

Amplifiers Library/Optical/Raman

The tutorial will use passive components that allow the design of amplifiers and 
lasers. These components are spread in different folders at the OptiSystem 
component library and some of them are described at Table 3. These are the 
equivalent components to those found in OptiAmplifier.

Component name Folder Icon

Raman Amplifier - Average 
Power Model

Raman Amplifier - Dynamic 
Model
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Table 3 Passive components

Component name Folder Icon

Isolator Bidirectional Passives Library/Optical/Isolators

Reflector Bidirectional Passives Library/Optical/Reflectors

Attenuator Bidirectional Passives Library/Optical/Attenuators

Pump Coupler Bidirectional Passives Library/Optical/Couplers

Coupler Bidirectional Passives Library/Optical/Couplers

Tap Bidirectional Passives Library/Optical/Taps

Circulator Bidirectional Passives Library/Optical/Circulators

Polarization Combiner 
Bidirectional

Passives Library/Optical/Polarization

Reflective Filter Bidirectional Filters Library/Optical/

3 Port Filter Bidirectional Filters Library/Optical/
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Optical Amplifiers

Global parameters

The first step when using OptiSystem is setting the global parameters. 

As we already know, one of the main parameters is the time window, calculated from 
the bit rate and sequence length. 

For the amplifier and laser design, there are other important parameters that will 
define the number of iterations in the simulations and introduce an initial delay in the 
in the simulation. 

Transmission Filter Bidirectional Filters Library/Optical/

Nx1 Mux Bidirectional WDM Multiplexers Library/Multiplexers

2x2 Switch Bidirectional Network Library/Optical Switches

Component name Folder Icon
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These parameters are the Iterations and Initial delay, and are available in the global 
parameters window (Figure 1). 

Figure 1 Global parameters: Signals tab

For this tutorial we will use the default parameters, except for some global 
parameters.

• In the global parameters dialog box, change the parameter Bit rate to 2.5e9, 
Sequence length to 32, and Samples per bit to 32. The Time window parameter 
should be 1.28e-8 s (Figure 2).
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Figure 2 Global parameters: Simulation parameters tab

System setup

After setting the global parameters, we can start adding the components to design the 
basic EDFA design. 

From the component library, drag and drop the following component in to the layout:

• From "Default/Transmitters Library/Optical Sources", drag and drop the "CW 
Laser" and the "Pump Laser" into the layout.

• From "Default/Amplifiers Library/Optical/Doped Fibers", drag and drop the 
"Erbium Doped Fiber" component into the layout.

• From "Default/Passives Library/Optical/Isolators", drag and drop two "Isolator 
Bidirectional" components and a "Pump Coupler Bidirectional" component into 
the layout.

• From "Default/Receivers Library/Photodetectors", drag and drop a 
"Photodetector PIN" component into the layout.

• From "Default/Visualizers Library/Optical", drag and drop the "Dual Port WDM 
Analyzer" into the layout.

The next step is to connect the components according to Figure 3. As we can see, 
there is one input port in the isolator opened, so to be able to run the simulation it is 
necessary to include an optical null in the design (Figure 3 (b)).
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Figure 3 EDFA layout

(a)

(b)

Signals tab

Although all components are in the layout and correctly connected, we are not able 
yet to run the simulation properly. 

First, because we are considering the signals propagating in both directions, we will 
need more than one global iteration for the results in the system to converge. 

Secondly, in the first iteration there are no backward signals in the left input port of the 
bidirectional components, such as the isolator and pump coupler. This will make the 
simulation stop. 

To resolve the first condition, you just have to increase the number of iterations. 

To resolve the second condition, there are two possible solutions: We can enable in 
the Signals Tab the Initial delay parameter (Figure 4) or we can introduce in the layout 
the component "Optical Delay" (Figure 5).
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Figure 4 Global parameters - Increasing the number of iterations and enabling Initial Delay

Figure 5 Including the "Optical Delay" components in the layout
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Running the simulation

We can run this simulation for the system shown in Figure 3 and analyze the results:

• To run the simulation, you can go to the File menu and select Calculate. You can 
also press Control+F5 or use the calculate button in the toolbar. After you select 
Calculate, the calculation dialog box should appear.

• In the calculation dialog box, press the Play button. The calculation should 
perform without errors.

Viewing the results

To see the results, double click the Dual Port WDM Analyzer. You can see the results 
of each iteration by browsing in the Signal Index parameter. 

Figure 6 shows the results in the WDM analyzer for the 6 iterations and initial delay.

Figure 6 Dual Port WDM Analyzer views for different iterations

Running the simulation

To compare the results in the two different designs, Figure 3 and Figure 5, we can run 
the same simulation for the system showed in Figure 5 and analyze the results:

• To run the simulation, you can go to the File menu and select Calculate. You can 
also press Control+F5 or use the calculate button in the toolbar. After you select 
Calculate, the calculation dialog box should appear.

• In the calculation dialog box, press the Play button. The calculation should 
perform without errors.
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Viewing the results

To see the results, double click the Dual Port WDM Analyzer. You can see the results 
of each iteration by browsing in the Signal Index parameter. 

Figure 7 shows the results in the WDM analyzer for the 6 iterations.

Figure 7 Dual Port WDM Analyzer views for different iterations

As we can see, the second design converges faster than the design with 'Initial Delay'. 
The design from Figure 3 takes more iteration because of the 'Initial delay'.

Viewing the gain versus wavelength

We will build the graph gain as a function of the signal wavelength. 

Starting using the layout from Figure 5:

• Double-click on the CW Laser component. The component properties will appear. 
See Figure 8 (a).

• Change the unit of the Frequency parameter to nm.

• Select the parameter that you want put in sweep mode. In this case the parameter 
is Frequency. Change the mode of the Frequency parameter in the CW Laser 
component from Normal to Sweep. See Figure 8 (b).

• Select the Parameter Sweeps tab at the CW laser properties, or at the menu tool 
bar, or at the Layout menu. See Figure 9.
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Figure 8 CW Laser properties (a) Frequency parameter in Normal and (b) Sweep mode

Figure 9 Parameter Sweeps at (a) the menu tool bar and (b) at the Layout menu

(a)

(b)

• After you click in the Parameter Sweeps tab, a window asking you to set the total 
number of sweep iterations will appear.
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• Click on OK and the windows to enter the number of sweep iterations will appear.

• Choose the number of sweep iterations. In this case we select 20 sweeps. After 
you click the OK button, the Parameter Sweeps tab will appear.

• Now we can enter the value of each sweep iteration, or we can select all the 
sweeps and click in one of the buttons (Linear, Exp, Log, Formula, Gaussian, etc.) 
to spread the values in a range. In our case we clicked in the Linear button. A new 
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window will open to select the wavelength range in which the signal will be 
distributed.

• We chose the range from 1530 nm to 1560 nm, and after we clicked on OK, the 
values were distributed.
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.

Running the simulation
• To run the simulation, you can go to the File menu and select Calculate. You can 

also press Control+F5 or use the calculate button in the toolbar. After you select 
Calculate, the calculation dialog box should appear.

• In this case, we could select to simulate all sweep iterations, or choose a specific 
iteration and select to calculate the current iteration. For this topic, we selected to 
calculate all iterations. See Figure 10.

• In the calculation dialog box, press the Play button. The calculation should 
perform without errors.
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Figure 10 Calculating all sweep iterations

Viewing the results

To see the results, double click the Dual Port WDM Analyzer. You can see the results 
of each iteration (global iteration) in one specific sweep iteration (wavelength) by 
browsing in the Signal Index parameter.

In our case, we kept the Signal Index in the last (global) iteration (5), and we can 
browse in the results for all (wavelengths) sweep iterations by clicking in the icons 
"Next Sweep Iteration" and "Previous Sweep Iteration". 

Figure 11 shows the results in the WDM analyzer for the sweep iteration number 20 
and 19.
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Figure 11 Results for the sweep iteration (a) 20 and (b) 19

(a)

(b)

Building the graph Gain x Wavelength and Noise Figure x Wavelength 
• The next step would be to visualize gain and noise figure for all wavelengths 

simulated. Therefore, we need to build graphs with the results found in the 
simulation.

• For this task, we will use the Report page.

• Go to the Report tab and click on it. See Figure 12.
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Figure 12 View of the GUI with the system layout

• The report page will appear. After that, select the Opti2Dgraph (graph icon 
highlighted) and open in the report page a 2D graph. See Figure 13.
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Figure 13 View of the report page

• After opening the 2D graph, go to the project browser window and open the 
parameter folder of the component that has the information you want. In this case 
we need the wavelength of the CW Laser, so we selected the Frequency 
parameter. See Figure 14.
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Figure 14 View of the report page with the graph opened and the Frequency parameter selected

• ·The Frequency parameter was then dragged to the 2D graph and dropped at the 
X-axis. See Figure 15.
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Figure 15 View of the report page with Frequency parameter being dropped at the graph

• After dropping the Frequency parameter, we have to get the next variable of the 
graph. So go to the Dual Port WDM Analyzer and open the Results folder.

• Choose one of the results that you want plot in your graph. In this case, we 
choose the Gain parameter. Now, drag and drop it in the y-axis in the graph. See 
Figure 16.
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Figure 16 View of the report page with the Gain result being dropped at the graph

• After that, the graph Gain x Wavelength is ready. See Figure 17(a). The same 
procedure was used to build the graph NF x Wavelength.

Figure 17 Graphs (a) Gain x Wavelength and (b) NF x Wavelength
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Optimizing the Fiber length

In addition to using the sweep iterations to analyze the amplifier characteristics (such 
as gain versus signal wavelength and gain versus doped fiber length), the user can 
use the optimization tool to find the best parameters for the amplifier design. 

In this example, we will use the optimization tool to find the best doped fiber length to 
get the maximum signal gain.

• Load the same layout presented at Figure 5. Remember to return the Total 
Number of Sweep Iterations to 1 if you had changed it.

• Run the simulation. This step is necessary to setup the Dual Port WDM Analyzer 
for the optimization.

Figure 18 Layout of the system to be optimized

Viewing the results

After you run the system, double click in the Dual Port WDM Analyzer to see the 
results. 

To see the results in different iterations and set the Signal Index to the last iteration, 
see Figure 19. 

To guarantee the optimization will work correctly, you need to set the visualizer Signal 
Index to the last iteration.
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Figure 19 Dual Port WDM Analyzer set with the results of the last iteration

Setting up the Optimization
• Go to the tools menu and click in Optimizations. See Figure 20.

Figure 20 Optimizations option at the Tools menu

• The Optimizations window will appear.

• There are two options for the optimization: the Single Parameter Optimization 
(SPO) and the Multiple Parameter Optimization (MPO). In our case, we want only 
to optimize the Fiber length as a function of the gain, so we can select the SPO 
and insert it on the project. For example, Figure 21 displays the calculation 
window and the optimization tab.
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Figure 21 Optimizations tab during calculation

• When we insert the SPO optimization, the SPO Setup window will open. See 
Figure 22.

• In the Main tab, select the Optimization Type you want. In this case we selected 
to maximize the result.

• Setup the number of passes and the result tolerance.

Figure 22 SPO Setup window at the Main tab
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• Go to the Parameter tab in the SPO Setup and select the parameter that you want 
to optimize. In this case, Length at the Erbium-doped fiber component. See 
Figure 23.

• After you select the parameter, specify the range of values you want to analyze. 
Be careful in choosing these values, they have to match the unit chosen in the 
Component parameter. For this case there is only one unit, meter. But in some 
cases, such as for power, the unit could be W, mW or dBm.

Figure 23 SPO Setup window at the Parameter tab

• In the Result tab, select the result in the Dual Port WDM Analyzer that you want 
to maximize (Gain). See Figure 24.

• Because we want to maximize the gain, the Target value will not be enabled.

• Click on ok in the SPO Setup.

• To run the simulation you can go to the File menu and select Calculate. See 
Figure 25.

• Before you press the Play button, click in the box to run all optimizations. Then, 
press the Play button.
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Figure 24 SPO Setup window at the Result tab

Figure 25 Calculate window

During the calculation, the parameters and results of each pass will appear in the 
Optimization Tab. See Figure 26(a). 

In the calculation output tab will appear the optimum fiber length where we got the 
maximum gain for the signal at 1530 nm.
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Figure 26 (a) Optimization tab and (b) Calc. Output tab

(a)

(b)
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Lesson 8: Optical Systems — Working with 
multimode components

The multimode component library of OptiSystem allows for simulation of links with 
multimode signals. 

The projects presented here are available under OptiSystem installation folder 
Samples/Multimode. 

The first part of this tutorial will describe the library of spatial optical sources and 
transmitters. These components have the ability to include transverse mode profiles 
in the optical signals.   

There are two categories of components in the library: 

• spatial optical sources/transmitters

• transverse mode generators 

The spatial transmitters are “ready-to-use” components that encapsulate an optical 
source or transmitter and a transverse mode generator.

Table 1 Spatial optical sources, transmitters and pulse generators

Component name Folder Icon

Spatial CW Laser Transmitters Library/Optical Sources/

Spatial Laser Rate Equations Transmitters Library/Optical Sources/

Spatial LED Transmitters Library/Optical Sources/

Spatial Optical Gaussian Pulse 
Generator

Transmitters Library/Pulse 
Generators/Optical/

Spatial Optical Impulse 
Generator

Transmitters Library/Pulse 
Generators/Optical/
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Spatial Optical Sech Pulse 
Generator

Transmitters Library/Pulse 
Generators/Optical/

Spatial Optical Transmitter Transmitters Library/Optical 
Transmitters/

Spatial VCSEL Transmitters Library/Optical Sources/

Component name Folder Icon
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The second category is the transverse mode generators. These components allow for 
adding a transverse mode profile in the optical signal.

Table 2 Transverse mode generators

Transmitters Library/Multimode/

Transmitters Library/Multimode/

Transmitters Library/Multimode/

Transmitters Library/Multimode/

Transmitters Library/Multimode/

This means you can directly use one of the components from Table 1 or you can 
combine any optical source, transmitter of pulse generators with one of the transverse 
mode generators from Table 2 and build a new subsystem.

The second part of the tutorial presents the passive components that allow for 
translation and rotation of the optical field, as well as focusing an optical beam or 
applying an aperture in order to limit the optical beam.

Finally, a description of the receiver and photodetector components is presented.

Component name Folder Icon

Multimode Generator

Laguerre Transverse Mode 
Generator

Hermite Transverse Mode 
Generator

Donut Transverse Mode 
Generator

Measured Transverse Mode 
Generator
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Multimode Transmitters

Global parameters

The first step when using OptiSystem is setting the global parameters. 

As we already know, one of the main parameters is the time window, which is 
calculated from the bit rate and sequence length. 

For multimode simulations, there are additional parameters that will define the space 
window for the transverse mode profiles. These parameters are the Space width X 
and Y and the Grid spacing X and Y, and are available in the global parameters 
window (Figure 1). 

Figure 1 Global parameters: Spatial effects tab

For this tutorial we will use the default parameters, except for the bit rate, that should 
be changed to 10 GB/s

• In the global parameters dialog box, change the parameter Bit rate to 10e9. The 
Time window parameter should be 1.28e-8 s (Figure 2).
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Figure 2 Global parameters: Simulation parameters tab
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System setup

After setting the global parameters, we can start adding the components to design the 
basic multimode transmitter. 

From the component library drag and drop the following component in to the layout:

• From "Default/Transmitters Library/Optical Sources", drag and drop the "CW 
Laser" into the layout.

• From "Default/Transmitters Library/Multimode", drag and drop the "Multimode 
Generator" component into the layout.

• From "Default/Visualizers Library/Optical", drag and drop the "Spatial Visualizer" 
into the layout.

The next step is to connect the components according to Figure 3. 

Figure 3 Multimode transmitter

Spatial effects tab

The spatial effects tab is available for all the spatial optical sources, transmitters and 
pulse generators, as well as for the transverse mode generator components. 

One of the main parameters of the spatial effects tab is the Power ratio array. This 
array is a string list with the power ratios for each mode. 

For example, entering a list of 4 values will allow the user to also specify the properties 
of a particular mode type for each of these values.

• Open the parameters of the “Multimode Generator” component.

• In the spatial effects tab, for the Power ratio array parameter, enter the following 
values: 1 2 3 4.

Notice that the parameter Pol. X m,n index array will automatically increase the 
number of values for the LP index pairs for the generated modes (Figure 4).
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Figure 4 Multimode Generator - changing the number of power ratios

• In the spatial effects tab, for the Pol. X m,n index array parameter, enter the 
following values: 0 0, 2 2, 0 3, 1 3.

This means the multimode generator will generate 4 spatial modes per polarization.

The power ratio per mode will be 0.1, 0.2, 0.3 and 0.4. The total is equal to 1 (100% 
of the input power). 

Each mode will have its own Laguerre-Gaussian profiles, with LP indexes LG00, LG22, 
LG03, LG13. Both polarizations will have the same spatial modes (Mode polarization 
parameter is equal to X=Y). 
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Running the simulation

We can run this simulation and analyze the results:

• To run the simulation, you can go to the File menu and select Calculate. You can 
also press Control+F5 or use the calculate button in the toolbar. After you select 
Calculate, the calculation dialog box should appear.

• In the calculation dialog box, press the Play button. The calculation should 
perform without errors.

Viewing the results

In order to see the results, double click the Spatial visualizer. 

Using the spatial visualizer, you can see the profile of each mode presented at the 
visualizer input port. The user can select the polarization (X or Y), the format (Polar 
or Rectangular) and the graph (Power, Phase, Real or Imaginary part). 

Additionally, the sum of the modes can be displayed, as well as the weightened sum 
(Figure 5). 

Observe that the spatial dimensions of the graphs are the same as defined by the 
global parameters Space width X and Y.

Figure 5 Spatial visualizer can display the Individual, Sum and Weightened sum of modes

In order to browse through the modes that are available at the input port, change the 
mode number parameter and press <Enter>. The visualizer will recalculate the 
graphs and present the individual mode at the parameter mode index. 
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Figure 6 presents the real values using rectangular format for each available mode at 
the input port.

Figure 6 Spatial visualizer displays the real part of the individual modes for each mode index

The combination of the CW Laser and the Multimode Generator component can be 
replaced by the Spatial CW Laser component:

• From "Default/Transmitters Library/Optical Sources", drag and drop the "Spatial 
CW Laser" into the layout.

• In the Spatial CW Laser parameters, use the same parameter values of the spatial 
effects tab from the Multimode Generator

The next step is to connect the components according to the Figure 7. 

You can remove the multimode generator and connect the spatial visualizer to the 
Spatial CW Laser. 

Run the simulation again.
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Figure 7 Multimode transmitter using a Spatial CW Laser

This system, built using a component from Table 1, is equivalent to the one in Figure 
3, which was built using the components from Table 2. 

The results from the spatial visualizer will be the same as presented in Figure 5 and 
Figure 6.

Multimode components and Free-Space Propagation

When coupling a signal from a laser into a multimode fiber, or from the fiber into a 
photodetector, we can use the components from Table 3.

Table 3 Spatial passive components: connector, aperture and lens

Passives Library/Optical/Connectors/

Passives Library/Optical/Multimode/

Passives Library/Optical/Multimode/

Passives Library/Optical/Multimode/

Component name Folder Icon

Spatial Connector

Spatial Aperture

Thin Lens

Vortex Lens
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Spatial connector: translating the optical field

One of the main components is the spatial connector. This components can rotate and 
translate the optical field, as well as propagate the optical signal in free-space. 

• From "Default/Passives Library/Optical/Connectors", drag and drop the "Spatial 
Connector" into the layout.

• For the Spatial Connector, change the parameters X and Y shift to 5 m .

• Add another Spatial Visualize to the layout.

• Connect the components according to Figure 8.

• Run the simulation.

Figure 8 Multimode transmitter and spatial connector

Viewing the results

In order to see the results, double click in the second spatial visualizers and compare 
the graphs before and after the connector. 

The connector applied a spatial shift in both X and Y-axis (Figure 9).
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Figure 9 Spatial visualizer displays the transverse mode before and after the connector

In order to see the effects of free-space propagation in the optical field, we can 
increase the connector parameter Distance:

• For the Spatial Connector, change the parameter Distance to 200 m .

• For the Spatial Visualizers, change the parameters Format to Polar.

• Run the simulation.

Figure 10 compares the transverse mode intensity before and after applying 200 m  
of propagation in free-space, you can see that the second beam is larger.

Figure 10 Spatial visualizer displays the transverse mode intensity after a shift of 5 m  in both X and Y 
directions, before and after 200 m  propagation in free-space
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Spatial connector: rotating the optical field

Besides the translation the optical field and the propagation in free-space, the user 
can rotate the optical field by applying a tilt in the X and Y-axis, or a rotation about the 
Z-axis.

• For the Spatial Connector, change the parameters X and Y shift to 0 m , and the 
Distance to 100 m .

• For the Spatial Connector, change the parameters X and Y tilt to 5 deg.

• Run the simulation.

Viewing the results

In order to see the results, double click in the both spatial visualizers and compare the 
graphs before and after the connector. 

The connector applied a spatial tilt in both X and Y-axis, visible after the free-space 
propagation (Figure 10).

Figure 11 Spatial visualizer displays the transverse mode before and after the 5 deg tilt and 100 m  
propagation
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Thin Lens: focusing the optical beam

By using the thin lens component the user can focus or defocus the optical beam. 

• From "Default/Passives Library/Optical/Multimode", drag and drop the "Thin 
Lens" component into the layout.

• Add another “Spatial Connector” and “Spatial Visualizer' to the layout.

• For the “Spatial CW Laser”, set the parameter Pol. X spot size to 15 m .

• For the first spatial connector, set the shift and tilt parameters to 0, and the 
parameter Distance to 10 m

• For the second spatial connector, set the shift and tilt parameters to 0, and the 
parameter Distance to 65 m .

• For the thin lens, the parameter Focal length to 0.1 mm.

• Connect the components according to Figure 12.

• Run the simulation.

Figure 12 Using the thin lens component to focus the optical beam

Viewing the results

In order to see the results, double click in the spatial visualizers and compare the 
graphs before and after the second connector. The large beam after the first 
connector is reduced by the combination of thin lens and free-space propagation. 

Figure 13 presents the optical field at the output of the first connector and at the output 
of the second connector.
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Figure 13 Spatial visualizer displays the transverse mode before and after focusing the beam using the thin 
lens

Spatial Aperture: limiting the optical field

By using the spatial aperture component the user can reduce the optical field by 
filtering the optical power that falls outside the aperture area. 

• From "Default/Passives Library/Optical/Multimode", drag and drop the "Spatial 
Aperture" into the layout.

• Remove the thin lens and the second connector from the layout.

• Connect the components according to Figure 14.

• Run the simulation.

Figure 14 Using the spatial aperture component to limit the optical beam

Viewing the results
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In order to see the results, double click in the spatial visualizers and compare the 
graphs before and after the spatial aperture. 

The output beam is limited to the aperture diameter of 10 m  (Figure 15). 

You can use the spatial aperture to simulate component misalignments, e.g. 
fiber/detector power coupling. 

Figure 15 Spatial visualizer displays the transverse mode before and after the spatial aperture component
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The user can also select a rectangular square type for the spatial aperture:

• For the spatial aperture, set the parameter Aperture type to “Square”.

• Run the simulation.

Observe that the optical beam will have a square shape after the spatial aperture 
(Figure 16).

Figure 16 Spatial visualizer displays the transverse mode after the square spatial aperture component
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Multimode Receivers

Similar to the multimode transmitter, where the use can select a ready-to-use spatial 
component from the library, or build new spatial components by combining the spatial 
and no-spatial components, OptiSystem has also different multimode receiver 
components (Table 4). These components are a combination of the spatial aperture 
component and the optical receivers or photodetectors.

Table 4 Spatial receivers and photodetectors

Receivers Library/Optical Receivers/

Receivers Library/Photodetectors/

Receivers Library/Photodetectors/

The main parameter of the spatial receivers or photodetectors is related to the 
detector active are, defined by the parameter Width. 

System setup

Using the same previous global parameters, we can start adding the components to 
design the basic multimode link. From the component library drag and drop the 
following component in to the layout:

• From "Default/Transmitters Library/Optical Transmitters", drag and drop the 
"Spatial Optical Transmitter" into the layout.

• For the Transmitter, change the parameter Pol. X. spot size (Spatial effects tab) 
to 15 m .

• From "Default/Receivers Library/Optical Receivers", drag and drop the "Spatial 
Optical Receiver" component into the layout.

• For the Receiver, change the parameter Thermal noise (Noise tab) to 5e-22 
W/Hz. This will give a receiver sensitivity of ~ -17 dBm (10 GB/s, Q = 6).

• From "Default/Visualizers Library/Electrical", drag and drop the "BER Analyzer" 
into the layout.

• From "Default/Visualizers Library/Optical", drag and drop two of the "Optical Time 
Domain Visualizer" into the layout.

• Set all the parameters of the spatial connector to 0.

Using the connector and visualizer from the previous layout, the next step is to 
connect the components according to the Figure 17. 

Component name Folder Icon

Spatial Optical Receiver

Spatial PIN Photodetector

Spatial APD Photodetector
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Figure 17 A multimode link using the spatial transmitter and receiver

Run the simulation and after the simulation is finished observer the results from the 
BER Analyzer.

Viewing the results

The link of Figure 17 is almost ideal, because we do not have any major losses or 
misalignments between the transmitter and receiver. The spatial connector is ideal 
and there is only a small loss due to the difference between the input signal spot size 
and active area of the photodetector (10 m  and the mode spot size of 15 m ).

Figure 18 presents the eye diagram for the system of Figure 17, observe the back-to-
back value of the Q factor.



 LESSON 8: OPTICAL SYSTEMS — WORKING WITH MULTIMODE COMPONENTS

152

Figure 18 BER Analyzer displaying the eye diagram of the ideal link

In order to visualize the effects of misalignment between the transmitter and receiver, 
we will apply a longitudinal shift in the optical field using the spatial connector 
component. 

Using OptiSystem parameter sweep feature, we will apply a spatial shift from 0 to 20 
m  in the optical signal.

• For the Spatial connector, change the mode of the parameter X shift to Sweep.

• Set the total number of sweep iterations to 10.

• In the parameter sweep dialog box, use a linear spread for the parameter X shift 
from 0 m  to 20 m  (Figure 19).



 LESSON 8: OPTICAL SYSTEMS — WORKING WITH MULTIMODE COMPONENTS

153

Figure 19 Using parameter sweep for the connector parameter X shift from 0 to 20 m

• Run the simulation

The simulation will run 10 times, one for each value of the X shift parameter. At the 
end of the calculation, we can browse the results selecting the current sweep iteration, 
or we can visualize the results of Q-Factor versus X shift using the report page.

• Select the report page.

• Drag and drop a 2D graph into the report.

• From the Project Browser, select the Spatial Connector and drag and drop the 
parameter X shift into the X-axis of the graph.

• From the Project Browser, select the BER Analyzer and drag and drop the result 
Max. Q Factor into the Y-axis of the graph (Figure 20).
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Figure 20 Combining parameters and results after using report page

As you can see in the Figure 20, the value of Q is decreasing. This is because the 
optical field is being shifted outside of the photodetector active area, centered at (0,0) 
with a width of 10 m . We can achieve similar results by changing the active area 
width additionally to the shifting of the field.

• For the Spatial connector, change the mode of the parameter X shift to Normal, 
and set the value to 0.

• For the Spatial receiver, change the mode of the parameter Width to Sweep.

• In the parameter sweep dialog box, use a linear spread for the parameter Width 
from 10 to 1 m .

• Run the simulation

• From the Project Browser, select the Spatial Optical Receiver and drag and drop 
the parameter Width into the X-axis of the report page 2D graph.

The result is presented in Figure 21, where we can see the increase of the Q-Factor 
with the increase of the active area of the photodetector.
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Figure 21 The value of Q-Factor versus photodetector active area width

Multimode Fibers and Links
• There are two multimode fibers available in the component library that take in to 

account the spatial properties. They are components that take in to account the 
power coupling and propagation of the multiple fiber modes. 

• The first model is a general-purpose multimode fiber, with user-defined refractive 
index profile, and a numerical mode solver. The second model is a graded-index 
fiber with parabolic index, which uses an analytical mode solver.

Table 6 Multimode fibers

Optical Fibers Library/Multimode/

Measured-Index Multimode Fiber

System setup

Following the same steps to generate the layout of Figure 17, we can add the fiber 
component to design the basic multimode link:

• From "Default/Optical Fibers/Multimode", drag and drop the "Parabolic-Index 
Multimode Fiber" into the layout.

Component name Folder Icon

Measured-Index Multimode Fiber

Parabolic-Index Multimode Fiber
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Add additional visualizers to the layout and connect the system according to the 
Figure 22. 

Figure 22 A link using the multimode fiber

Calculating Fiber Properties

The main parameter of the Parabolic-Index multimode fiber is the Core radius. For this 
link we are using a 50 m  fiber. 

In order to evaluate the fiber properties, such as effective index, group delay and the 
number of modes, we can calculate fiber properties before running the simulation:

• For the Fiber, enable the parameter Calculate graphs (Graphs tab).

We can also calculate the spatial profile graphs for individual modes, and the 
overfilled mode profile: 

• For the Fiber, enable the parameter Spatial profile graphs and Spatial overfilled 
graph (Graphs tab).

• Press OK.

After pressing OK, the modes will be calculated and the mode number, radial and 
spatial graphs will be internally calculated.
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Viewing the fiber properties

In order to see the graphs from the multimode fiber, we should use the Project 
Browser (Figure 23). 

Figure 23 Multimode fiber graphs from the Project Browser

By double-clicking on the graph name, we can see the graphs for the different fiber 
properties. 

For example, Figure 24 presents the Refractive index profile graph. 

Figure 25 presents the mode number graphs, e.g. LP(m,n) indexes m and n, Effective 
index and Group delays.
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Figure 24 Refractive index profile for the parabolic index fiber
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Figure 25 Mode index graphs for the parabolic index fiber

The remaining spatial and radial graph for the individual mode is presented in Figure 
26. 

The spatial overfilled graph is presented in Figure 27. 
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Figure 26 Individual mode intensity radial and spatial profile graphs

Figure 27 Spatial overfilled graph

The fiber graphs will be calculated every time you press OK in the component dialog 
box and after the link calculation. In order to save calculation time, we will disable the 
spatial graphs calculation. 

• For the Fiber, disable the parameter Spatial profile graphs and Spatial overfilled 
graph (Graphs tab).

• Press OK.
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The next step is to calculate the multimode link:

• Run the simulation

• During the calculation, in the calculation dialog box select the 'Calc. schedulers' 
tab.

Observe the calculation progress of the multimode fiber (Figure 28). This is important 
to estimate the time that simulation will take when calculating multimode links.

Figure 28 Calculation progress for the multimode fiber

Viewing the results

We can use the visualizer to display the simulation results. The first results that we 
will look at are the spatial profile of the modes at the fiber output.

In order to browse through the modes available at the fiber output port, change the 
mode number parameter of the third spatial visualizer and press <Enter>. The 
visualizer will recalculate the graphs and present the individual mode at the parameter 
mode index. 

Figure 29 presents the real values using rectangular format for some of the modes:
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Figure 29 Spatial visualizer at the fiber output displaying mode index 0, 5, 12 and 15

We can also visualize the coupling coefficients and the modal delay at the fiber output 
for each input signal wavelength and spatial mode by using the multimode fiber 
calculation report (Figure 30):

• For the Fiber, click on the Report parameter (Numerical tab).
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Figure 30 Calculation report from multimode fiber

The graph with the coupling coefficients and group delay is also available from the 
project browser.

Finally you can visualize the graphs from the BER Analyzer (Figure 31). 
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Figure 31 BER Analyzer at the receiver output

The same steps can be applied to second multimode fiber model, the Measured-
Index Multimode Fiber. 

Because the index is measured, the user should provide the refractive index profile 
with the proper format instead of simply changing the core radius of the parabolic 
index fiber. 
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Optical transmitters

This section begins with an introduction to optical transmitter components.

• Optical transmitters

Following the introduction, the section contains the following advanced and illustrative simulation 
projects.

• LED modulation response

• Semiconductor laser modulation response

• Semiconductor laser—Large signal modulation

• Chirp in Mach-Zehnder Lithium Niobate modulators

• LED spectral distribution

• Semiconductor laser L-I curve

• Laser noise and linewidth

• Vertical-Cavity Surface-Emitting Laser - VCSEL Validation

• Using the Laser Measured Component



 

166

Notes:
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Optical transmitters

The role of the optical transmitter is to:

• convert the electrical signal into optical form, and

• launch the resulting optical signal into the optical fiber.

The optical transmitter consists of the following components:

• optical source

• electrical pulse generator

• optical modulator (see Figure 1).

The launched power is an important design parameter, as indicates how much fiber loss can 
be tolerated. It is often expressed in units of dBm with 1 mW as the reference level (see Figure 
2).

Figure 1 Transmitter components
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Figure 2 Laser Power Units
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LED modulation response

The frequency response of an LED is determined by the carrier dynamics (and 
therefore is limited by the carrier lifetime n ) and the parasitic capacitance of the LED 
(described by the RC constant RC [2].

If a small, constant forward bias is applied, the influence of the parasitic capacitance 
of the LED can be neglected. The LED 3-dB modulation optical bandwidth is defined 
as the modulation frequency at the LED power transfer function is reduced by 3 dB 
[1]. The LED 3-dB modulation optical bandwidth could be expressed as:

f3dB 3 2 n RCn+ = .

We would like to demonstrate the modulation response properties of the LED. The 
project is depicted in Figure 1.

Figure 1 Project layout

The default values of the carrier lifetime  and the RC constant , are 1 ns and 

1 ns, respectively. Therefore, the  is approximately 140 MHz.

Discussion of the numerical parameters: for example, bit rate is 300 Mb/s and 
sequence length 128 bits, therefore, the time window is about 430 ns. Samples per 
bit are 256, therefore, the sample rate is 76 GHz. The default resolution therefore is 
about 2 MHz.

n RC
f3dB
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Let us first keep the carrier lifetime  and the RC constant , which means  

is about 140 MHz, and analyze the closure of the eye diagram as a measure for the 

performance of the system. The results for 100Mb/s and 300Mb/s transmission are 

shown in Figure 2.

Figure 2 System performance with increased bit rate

Clearly the performance of the digital system is considerably worsened by increasing 
the bit rate above the LED 3-dB modulation optical bandwidth.

The influence of the modulation response of the LED can be studied also by keeping 

the bit rate, for example 300 Mb/s, and reducing the carrier lifetime  and the RC 

constant , therefore increasing . Let us assume , 

therefore  will be about 280MHz.

A large improvement in the system performance at 300 Mb/s compared to the latest 
figure should be seen. This is illustrated in Figure 3.

n RC f3dB

n
RC f3dB n RC 0.5ns= =
f3dB
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Figure 3 Improved system performance at 300Mb/s
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Semiconductor laser modulation response 

When using a directly modulated laser for high-speed transmission systems, the 
modulation frequency can be no larger than the frequency of the relaxation 
oscillations. The relaxation oscillation depends on both carrier lifetime and photon 
lifetime. The approximate expression of this dependence is given by:

fres
1

2
------ 1

spph 
1
2
---

---------------------- I
Ith
----- 1– 
 

1
2
---

= (1)

The relaxation oscillation frequency increases with the laser bias current.

In this lesson, we will demonstrate the performance of the high speed system while 
using the modulation frequency and increasing resonance frequency (through the 
improvement in the system performance) with the laser bias current. The project is 
depicted in Figure 1.

Figure 1 Project layout

For the default parameters of our laser rate equation model , 

, , and if we assume modulation peak current , 

Ith 33.45mA=
sp 1ns= ph 3ps= I 40mA=
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and , the corresponding resonance frequency in accordance with the 

above equation will be about 1.3 GHz.

Discussion of the numerical parameters: bit rate is 1.3 Gb/s and sequence length 
128 bits, therefore, the time window is about 98.5 ns. Samples per bit are 512, 
therefore, the sample rate is 670 GHz. The default resolution therefore is 10 MHz.

In Figure 2 and Figure 3, the influence of the increased modulation frequency above 
the resonance one on system performance will be demonstrated. In Figure 2, 
1.3 Gb/s (10Gb/s) transmission is studied. The parameters of the laser rate equations 
are the default ones (I IB 40mA= = ) as previously described.

Figure 2 Increase in modulation frequency above resonance

Clearly, modulation with the frequency well above the resonance one leads to 
unacceptable system performance.

In Figure 3, the influence of the bias current on the resonance frequency, and 
therefore on system performance, for a fixed bit rate will be demonstrated. We use 
1.3 Gb/s transmission, keep all other parameters the same, and use IB 20mA= .

IB 40mA=
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Figure 3 Reduction of bias current

If you compare Figure 3 with Figure 2 (with 1.3 Gb/s transmission and ), 

it is clearly demonstrated that the reduction of the bias current below its threshold 

value leads to a decrease in system performance.

In this lesson we have shown the dependence of the performance of the high speed 
system on the modulation frequency and the laser bias current.

IB 40mA=
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Semiconductor laser—Large signal modulation

The large-signal characteristics are related to the digital on/off switching of the laser 
diode. First, we will demonstrate the delay time required to achieve the population 
inversion to produce the gain. Second, we will demonstrate the typical for the direct 
modulation of semiconductor laser amplitude and phase modulations.

For the laser which is completely turned off, the carrier lifetime will limit the modulation 
rate. For a current pulse Ip , a period of time td  given by:

td 1n
Ip

Ip IB Ith–+
--------------------------- 
 = (1)

is needed to achieve the population inversion to produce a gain. IB  and Ith  are the 
bias and threshold currents, and   the average lifetime of the carriers. From this 
formula could be inferred that the time delay can be eliminated by biasing the diode 
at the lasing threshold current.

We will demonstrate this dependence in Figure 1.

Figure 1 Project layout

Discussion of the numerical parameters: bit rate is 1 Gb/s and sequence length 8 bits, 
therefore, the time window is 8 ns. Samples per bit are 512, therefore, the sample rate 
is about 500 GHz. The default resolution therefore is about 120 MHz.

In Figure 2, the initial electrical pulse is shown.
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Figure 2 Initial electrical pulse

while in the next two figures are shown generated optical pulses with modulation peak 

power current . In the graph on the left of Figure 3, , which 

is below the default value of , and in the graph on the right, 

. In the case ,  according to the above formula 

will be about 0.6 ns, when we have taken .

I 50mA= IB 10mA=
Ith 33.46mA=

IB Ith 10mA= = IB 10mA= td
 sp=
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Figure 3 Generated optical pulses

When we compare the generated optical pulse from the graph on the left with the 

electric pulse, we can see the time delay in the appearance of the optical pulse , 

which is approximately 0.6 ns. If we compare the generated optical pulse from the 

graph on the right with the electric pulse, we see the time delay  is about 0. In both 

cases good agreement with the predictions of the previously discussed formula can 

be seen.

Another basic property of the directly modulated lasers is the amplitude and phase 
modulation of generated optical pulses. The characteristic amplitude modulation is 
well demonstrated in Figure 4. Pulses with a phase modulation are also described as 
chirped. In what follows, we will demonstrate both the amplitude and the phase 
modulations. Two kinds of chirps are distinguished: adiabatic and transient.

The adiabatic chirp can be observed when the "off" state level is nonzero and it is 
dominant at low frequencies.

For the case of 1 Gb/s (modulation peak power current ), we will 

demonstrate the appearance of the adiabatic chirp as a function from the . In the 

next two figures, we will see the amplitude and phase modulation (chirps) for the case 

of , respectively.

td

td

I 50mA=
IB

IB 30 and 40mA=
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Figure 4 Adiabatic chirp

It is clear to see the nonzero off state in the second case and correspondingly, the 
appearance of the adiabatic chirp. 

With Figure 5, we will demonstrate the disappearance of the adiabatic chirp for larger 
frequencies, - 5 Gb/s transmission, keeping all other parameters the same.

Figure 5 Adiabatic chirp disappearance

Obviously very different amplitude and phase modulations can be seen. The adiabatic 
chirp disappears.
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The transient chirp is associated with the time rate of change of the optical power. The 
rate of the change is greatest at the leading edge of the pulse when the bias current 
is below the threshold current. 

In the next two figures the amplitude fluctuations and the corresponding transient 
chirps will be compared for the case of 1 Cb/s transmission with 
IB 20 and 40mA= . In the first case, much greater transient chirp is expected.

Figure 6 Transient adiabatic chirp

Qualitatively different behavior of both amplitude and phase modulations can be 
seen. Note the much larger transient chirp in the first figure.

The large-signal characteristics of directly modulated semiconductor lasers were 
demonstrated. The delay time required to achieve the population inversion to produce 
the gain and typical amplitude and phase modulations were shown. 
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Chirp in Mach-Zehnder Lithium Niobate 
modulators

The objective of this lesson is to demonstrate the relation between the voltage applied 
to the modulator arms and the chirp in the output for MZ Lithium Niobate modulators.

Chirp is a critical element in high bit rate lightwave systems because it can interfere 
in the limit of the system distance [1]. External modulators offer a way to reduce or 
eliminate chirp because the laser source is held in the narrow linewidth, steady-state 
mode. External modulator is typically either a LiNbO3 modulator or an 
electroabsorptive modulator. In this lesson the chirp induced by the LiNbO3 is 
analyzed based on the voltage of operation.

Here the modulator is analyzed in a dual-drive design shown in Figure 1 (where 
V1 – V2= ).

Figure 1 Dual-drive system layout

The modulator is operating in the quadrature mode. This means that the bias voltage 
places the modulator at the midpoint of the optical response curve, and therefore, the 
intensity is at half of its peak value. Figure 2 shows the parameters utilized to setup 
the modulator. The extinction ratio is set to 200dB to avoid any chirp caused by 
asymmetric Y-branch waveguides [2]. The modulator is set to work in a non-
normalized way, which means the electrical input signal will not be normalized.
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In accordance with [3], for a dual-drive modulator with geometry that is exactly the 
same for both arms. The chirp is given in terms of driving voltages:


V1 V2+

V1 V2–
------------------= (1)

where V1  and V2  are the voltage applied to arm 1 and 2, respectively.

Figure 2 Parameters setup for the modulator operating in the "quadrature" point

In agreement with Equation 1, to achieve zero chirp from the modulator, the relation 

between the voltages applied has to be . Figure 3 shows the voltages at 

port 2 and 3 for a determined sequence of pulses.

V1 V2–=
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Figure 3 Electrical signal at Input Port 2 (a) V1pp = 2.0V, and Input port 3 (b) V2pp = 2.0V to achieve a near 
zero chirp from the modulator

The results achieved for these voltages is shown in Figure 4. The amplitude of the 
optical signal varies from 0 to 1mW. The amplitude of the chirp is around 100 Hz (it 
could be considered practically zero due its small value).
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Figure 4 Optical signal at the modulator output

To show the difference in the value of chirp with changes in the voltage applied, the 

peak-to-peak voltages are set to , to give . 

Figure 5 shows the electrical input signals.

Figure 5 Electrical signal at Input Port 2 (a) and Input port 3 (b) to achieve a  0.5=  from the modulator

V1pp 3.0V V2pp 1.0V= =  0.5=
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The chirp achieved is shown in Figure 6. The optical signal seems the same, however, 
the chirp in the signal is much larger than that presented in Figure 4. The amplitude 
of the chirp is around 3 GHz.

Figure 6 Optical signal at the modulator output for  0.5=



 CHIRP IN MACH-ZEHNDER LITHIUM NIOBATE MODULATORS

188

For , the peak-to-peak voltages are set to 

. The result is shown in Figure 7.

Figure 7 Optical signal at the modulator output for  0.5=

As demonstrated in this lesson the chirp at the output signal, in the Mach-zehnder 
modulator, can be controlled by adjusting the voltages applied in the arms of the 
modulator. More information about chirp in Mach-Zehnder modulators can be found 
in the references.
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 0.5–=
V1pp 1.0V V2pp 3.0V= =
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LED spectral distribution

The spectral distribution of the optical source determines the performance of the 
optical system through the dispersion [1], [2]. The spectral distribution of the LED is 
determined by the spectrum of spontaneous emission, which typically has a Gaussian 
shape. In the 1300-1500nm region, the spectral widths of the LED vary from 50 to 
180nm.

The spectral width of the LED with 1300 nm wavelength is analyzed. The project is 
shown in Figure 1.

Figure 1 Project layout

Discussion of the numerical parameters: bit rate is 300Mb/s and sequence length 
2 bits, therefore, the time window is 6.66ns. Samples per bit are 32768, therefore, the 
sample rate is 10THz (56nm). The default resolution therefore is 0.0017nm.
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Figure 2 Spectral distribution

This spectral distribution is obtained with the default resolution. The resolution can be 
changed in the resolution bandwidth of the optical spectrum analyzer. In Figure 3, the 
same spectral distribution with a resolution from 1 nm is depicted.
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Figure 3 Spectral distribution—resolution from 1nm

Approximately 50 nm spectral width of the optical source can be seen. 
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Semiconductor laser L-I curve

The Light - Current (L-I) curve characterizes the emission properties of a 
semiconductor laser as it shows the current that needs to be applied to obtain a 
certain amount of power. 

We will show a L-I curve of our laser rate equation model with default 
Ith 33.45mA= . The project is depicted in Figure 1.

Figure 1 Project layout

(In fact the bit sequence generator and NRZ generator could be disabled, as the 
results are the same.)

Discussion of the numerical parameters: bit rate is 2.5Gb/s and sequence length 
8 bits, therefore, the time window is about 3.2ns. Samples per bit are 64, therefore, 
the sample rate is 160GHz. The default resolution therefore is 312MHz.

The L-I curve is generated after sweeping the parameter bias current from 35 to 125 
mA. Modulation peak current = 0.
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Figure 2 L-I curve—Power vs. bias

Linear dependence on emitted power on the bias current can be well seen.
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Laser noise and linewidth

Laser Intensity Noise.osd (see Figure 1) shows the laser spectral in CW operation 
at several power levels.

Figure 1 Laser Intensity Noise

The laser exhibits fluctuations in its intensity, phase, and frequency, even when the 
laser is biased at a constant current with negligible current fluctuations (see Figure 2).

Figure 2 Laser Noise
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Notes:
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Vertical-Cavity Surface-Emitting Laser - VCSEL 
Validation

The purpose of this lesson is to compare the simulation results of the VCSEL laser 
component with the published articles  [1] and  [2]. 

The first part of the lesson will compare the LI and IV curves of the component for 
different input parameters with the experiments presented in  [2]. 

The second part of the lesson will demonstrate the dynamic behavior of the 
component using the parameters from [2]]. 

Creating a Project

Using the default global parameters, we can start adding the components to design 
the basic VCSEL transmitter. 

From the component library drag and drop the following component sin to the layout:

• From "Default/Transmitters Library/Bit Sequence Generators", drag and drop the 
"Pseudo-Random Bit Sequence Generator" into the layout.

• From "Default/Transmitters Library/Pulse Generators/Electrical", drag and drop 
the "NRZ Pulse Generator" into the layout.

• From "Default/Transmitters Library/Optical Sources", drag and drop the "VCSEL 
Laser" into the layout.

• From "Default/Visualizers Library/Electrical", drag and drop the "Oscilloscope 
Visualizer" into the layout.

• From "Default/Visualizers Library/Optical", drag and drop the "Optical Time 
Domain Visualizer" into the layout.

• From "Default/Visualizers Library/Optical", drag and drop the "Optical Spectrum 
Analyzer" into the layout.

The next step is to connect the components according to the Figure 1.
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Figure 1 VCSEL transmitter
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First device: 863 nm laser 

Parameter setup

The laser parameters of OptiSystem VCSEL component should be the same as the 
863 nm VCSEL from [2].

Table 1 863 nm VCSEL parameters

863 nm

2600

1e-006

2.6e-008

16000

19400000

5e-009

2.28e-012

1e-006

1

40

1.246e-3, -2.545e-5, 2.908e-7, -2.531e-10, 1.022e-12

1

1.721 275, -2.439e4, 1.338e6, -4.154e7, 6.683e8, -4.296e9

 

For this example, the parameter fitting parameter is disabled because we want to use 
the same parameters from [2]. 

If the parameter fitting is enabled, the component will recalculate new parameters and 
they may differ from  [2]. 

We also enabled the graph calculation in order to compare the calculated LI and IV 
curves with the measurements.

Figure 2 presents the main VCSEL parameters for the 863 nm laser. 

Parameter Value

Frequency

Thermal impedance

Thermal time constant

Scaling factor

Gain coefficient

Carrier number at transparency

Carrier lifetime

Photon lifetime

Spontaneous emission factor

Injection efficiency

Max input current

a - Ioff(T)

b - V(T)

c - V(I)
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Figure 2 VCSEL parameters for the 863 nm laser
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Graphs

The user should also provide the LI and IV curves for the device. 

For this example, the data from Figures 1 and 2 from [2] are used. 

By default, the component already has the data stored internally and this will not be 
necessary for the 863 nm laser:

• Go to OptiSystem project browser.

• Select the "VCSEL Laser" component.

• Select the "Graphs" folder.

• Double-click on the "Measured LI curve" (Figure 3).

The graph should be the same as the graph in Figure 2 from [2]. 

Repeat the same steps for the second graph "Measured IV curve". The graph should 
be the same as Figure 3 from [2].

Figure 3 Graphs folder for the VCSEL laser
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Figure 4 LI curve graphs for the VCSEL laser

Figure 5 IV curve graphs for the VCSEL laser
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Parameter sweep

The next step is to simulate for different temperatures in order to compare the 
measured curves from Figure 4 and Figure 5 with the calculation results. 

Create a sweep with the laser parameter Temperature for the values of 20, 40, 60, 
80,100, 120 and 130  Celsius (Figure 6).

Figure 6 Temperature parameter sweep

Running the simulation

We can run this simulation and analyze the results:

• To run the simulation, you can go to the File menu and select Calculate. You can 
also press Control+F5 or use the calculate button in the toolbar. After you select 
Calculate, the calculation dialog box should appear.

• In the calculation dialog box, press the Play button. The calculation should take a 
few seconds.
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Viewing the results

Because we are interested in the LI and IV curves from the simulation, we can select 
the graphs from the project browser: "LI curve" and "IV curve". 

To compare the results with the measurements, repeat the same steps to see the 
measured graphs. However, instead of double-clicking on the graphs, press the Ctrl 
key and the left mouse button to select the "LI curve" and the "LI curve measured":

Figure 7 Multiple graphs selection

Now click the right button of the mouse and select Quick View. 

The graph for the LI curve is presented in the Figure 8. 

As you can see, the simulation is very close to the original measurements, as 
expected by [2]. 

Repeat the same steps for the IV curve, and the graph should look like Figure 9.
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Figure 8 LI curves: The dotted line is the measurement.

Figure 9 IV curves: The dotted line is the measurement.
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Parameter fitting

The next step is to enable Parameter fitting and run the simulation again. 

This time, the component will use the previous parameters as a first guess for the 
parameter-fitting engine and calculate new parameters:

• In the VCSEL laser parameters dialog box, Measurements tab, enable the 
parameter Parameter fitting.

• Close the dialog box and run the simulation

After the simulation is finished, you can compare the LI and IV graphs with Figure 8 
and Figure 9. The graphs will be very similar, however the laser parameters are 
different. 

The laser parameters used in this calculation are available in the project browser 
under the Results folder.
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Second device: 683 nm laser

Parameter setup

The laser parameters of OptiSystem VCSEL component should be the same as the 
683 nm VCSEL from [2].

Table 2 683 nm VCSEL parameters

683 nm

9800

1e-006

2.6e-008

16000

16540000

5e-009

2.064e-012

1e-006

1

5

-2.734e-4, -2.125e-5, 1.837e-7, 3.183e-10

0.829, -1.007e-3, 6.594e-6, -2.18e-8

1.721 275, -2.439e4, 1.338e6, -4.154e7, 6.683e8, -4.296e9

 

To load the measurements from this device, we should enable the Parameter fitting 
parameter and import the measured LI and IV curves.

• In the Measurements tab, click on the parameter LI curves filename.

• Load the file "Measured LI 683 VCSEL.dat".

• Click on the parameter IV curves filename.

• Load the file "Measured IV 683 VCSEL.dat".

• Disable the parameter Parameter fitting.

Figure 10 presents the main VCSEL parameters for the 683 nm laser, after loading 
the files and disabling the parameter fitting:

Parameter Value

Frequency

Thermal impedance

Thermal time constant

Scaling factor

Gain coefficient

Carrier number at transparency

Carrier lifetime

Photon lifetime

Spontaneous emission factor

Injection efficiency

Max input current

a - Ioff(T)

b - V(T)

c - V(I)
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Figure 10 VCSEL parameters for the 683 nm laser
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Graphs

The graphs for "Measured LI curve" should be the same as Figure 4 from [2]. 

See Figure 11.

Figure 11 LI curve graphs for the VCSEL laser

Parameter sweep

The next step is to simulate for different temperatures in order to compare the 
measured curves from Figure 11 with the calculation results. 

Create a sweep with the laser parameter Temperature for the values of 25, 40, 60 and 
80  Celsius. Now run the simulation.
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Viewing the results

The graph for the LI curve is presented in the Figure 12. 

As you can see, the simulation is very close to the original measurements for 25, 40 
and 60  Celsius, as expected by [2]. 

Figure 12 LI curves: The dotted line is the measurement.

Parameter fitting

The next step is to enable Parameter fitting and run the simulation again. 

This time the component will use the previous parameters as a first guess for the 
parameter-fitting engine and calculate new parameters. 

The resultant graph is similar to theFigure 12, and the new parameters are available 
as results in the project browser.
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Third device: 1550 nm laser

Parameter setup

The system parameters for this project should be the same as [1]. 

To compare the results, we will generate one single pulse at 2.4 GBs. 

This means that we should change the global parameters. Also, we should use the 
same rise and fall times for the NRZ pulse generator and replace the PRBS generator 
with a user-defined bit sequence generator:

• In the global parameters dialog box, change the parameter Bit rate to 2.4e9 and 
the parameter Sequence length to 16 (Figure 13).

• Replace the PRBS bit sequence generator with the "User Defined Bit Sequence 
Generator" from "Default/Transmitters Library/Bit Sequence Generators". 
Connect the components according to Figure 14.

• In the User Defined Bit Sequence Generator parameter dialog box, change the 
parameter Bit sequence to "00000010000000" (Figure 15).

• In the NRZ Pulse Generator parameter dialog box, change the parameters Rise 
time and Fall time to 0.25 (Figure 16).

Figure 13 Global parameters for laser 1550 nm setup
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Figure 14 1550 nm transmitter

Figure 15 Bit sequence generator parameters
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Figure 16 NRZ pulse generator parameters

The laser parameters of component should be the same as the laser from [1]. 
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Table 3 1550 nm laser parameters

1550 nm

38

28

False

False

1.5e-010

8500000000

0.4

2.5e-016

1e+018

0.4

1e-009

3e-012

3e-005

1e-017

5

1

For this particular device, we will not use the thermal effects and we will provide the 
same parameters as in [1]. 

This means that the parameters Thermal effects and Reduce parameters will be 
disabled. Because the thermal effects are disabled, the parameters from the 
Measurements tab will not be used in the simulation. 

Figure 17 presents the main VCSEL parameters for the 1550 nm laser:

Parameter Value

Frequency

Bias current

Modulation peak current

Thermal effects

Reduce parameters

Active layer volume

Group velocity

Quantum efficiency

Differential gain coefficient

Carrier density at transparency

Mode confinement factor

Carrier lifetime

Photon lifetime

Spontaneous emission factor

Gain compression coefficient

Linewidth enhancement factor

Injection efficiency
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Figure 17 Parameters for the 1550 nm laser

Parameter sweep

The next step is to simulate for different values of gain compression coefficients in 
order to compare the results from [1] with the calculation results. 

Create a sweep with the laser parameter Gain compression coefficient for the values 
of 1x10-17 and 5x10-17. 

Run the simulation.
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Viewing the results

First we should compare the shape of the electrical pulse with Figure 2a from [1]. 

Double click on the "Oscilloscope Visualizer" in the layout. 

Figure 18 presents the applied pulse at the laser input. The pulse is very similar to the 
one shown in Figure 2a from [1]. The amplitudes of the pulses are slightly different 
because OptiSystem generated a normalized pulse. 

Figure 18 Applied pulse at the laser input

The next step is to compare the optical pulse at the laser output with Figure 2b from 
[1]. 

Using the project browser, select the 'Signal power" graph from the "Optical Time 
Domain Visualizer" (Figure 19). 

Figure 20 presents the optical pulses at the laser output. The results are very similar 
to the Figure 2b from [1].
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Figure 19 Selecting the signal power graphs
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Figure 20 Optical pulse at the laser output for different values of gain compression coefficients
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Using the Laser Measured Component

The purpose of this lesson is to demonstrate how to obtain the laser physical 
parameters from measurements. 

Case 1: Setting the measured values Z, Y, P1 and Ith to obtain the 
correspondent physical parameters:

Using the measured values obtained in [1], set up the measured tab in the laser 
component:

P1 = 1.36 mW @ I bias = 35 mA

Ith = 18 mA

Z1 = 20.52 x 1020 Hz2

Y1 = 21.87 x 109 s-1

Figure 1 Measured values setup
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Figure 2 Main tab parameters

After setting up and calculating the system (See Figure 3), the results obtained from 
the parameter extraction are displayed in the project browser window.
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Figure 3 System layout

Figure 4 Project browser

To compare these results with the ones obtained in reference [1] , a new system was 
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designed with two laser components:

• A laser measured component similar to the one used in Figure 3

• A laser rate equations component that uses the physical parameters obtained in 
the reference  [1].

The system layout is shown in the following figure:

Figure 5 System layout comparing results

Similar results were found using both lasers (Figure 6). The differences presented 
were caused basically by the fact that the physical parameters obtained from [1] did 
not produce the same measured parameters like the ones generated at the laser 
measured. (e.g. the threshold current calculated in the laser rate equations indicate 
17.22 mA and not 18 mA).
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Figure 6 (a) Pulse intensity and (b) chirp
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Case 2: Setting the measured values Z, Y, P, Ith and also setting an 
average RIN value to obtain the correspondent physical parameters

In this case the measured values are the same as presented in the previous case. 
However, the average RIN and bandwidth, in which the average RIN is calculated, 
was added to the list of values.

Figure 7 Measured values setup

To visualize the results generated from the laser parameters, the following system 
was designed:
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Figure 8 System layout

After running the system, the output power measured in the Electrical power meter is 
-27.3 dBm. To visualize the RIN in the RF spectrum analyzer, we have to go to the 
visualizer properties and set its parameters to calculate the spectral density and take 
into consideration the signal power.

Figure 9 Setting the RF spectrum analyzer to calculate the spectral power density using the scale factor of 
27.3 dB

After these changes the RIN can be visualized in the RF spectrum analyzer:
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Figure 10 RIN spectra

This component can help the user to reproduce a laser behavior, however sometimes 
the parameter extraction procedure can not converge depending on the initial 
parameter estimation or the use of values (e.g. unrealistic RIN) that can not be 
reproduced by the laser.

References:

[1] Cartledge, J. C. and Srinivasan, R. C. “Extraction of DFB laser rate equation parameters for 
system simulation purposes”, J. Light. Techn., 15, 852-860, (1997).



227

Optical fibers

This section contains the following advanced simulation projects.

• Effects of group velocity dispersion (GVD) on Gaussian pulse propagation

• Effects of PMD on pulse propagation

• Effects of cross phase modulation (XPM) and four-wave mixing (FWM)

• Combined effects of GVD and SPM on Gaussian pulse propagation

• Combined effects of GVD and SPM on modulational instability

• PMD-induced broadening of ultra-short pulses

• Validation of FWM effect

• Stimulated Raman scattering

• Stimulated Raman scattering—Separated channels

• SPM-induced spectral broadening

• XPM-induced asymmetric spectral broadening

• Kerr shutter

• Bidirectional fiber and Raman design
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Notes:
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Effects of group velocity dispersion (GVD) on 
Gaussian pulse propagation

To demonstrate the influence of the group (GVD) velocity dispersion on pulse 
propagation in optical fibers in "linear" regime. The basic effects related to GVD are:

• GVD induced pulse broadening

• GVD induced pulse chirping

• Pulse compression

The equation, which describes the effect of GVD on optical pulse propagation 
neglecting the losses and nonlinearities, is [1]:

i
E
z
------

2

2
-----

2
E

t2
--------- ,= (1)

where  is the propagation direction,  is the time,  is the electric field envelope, and

 is the GVD parameter, defined as the second derivative of the fiber mode

propagation constant with respect to frequency.

For an input pulse with a Gaussian shape,

E z 0 t=  P0
t

2

2T 0
2

--------- –
 
 
 

 ,exp= (2)

the pulse width  (related to the pulse full width at half maximum by 

) increases with  (the pulse broadens) according to [1]:

(3)

z t E

2
2

2
---------=

T0
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T z  1
z
LD
------ 
  2

+
1 2
T0 ,=
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and, consequently, the peak power changes, due to GVD, are given by:

P z 
P0

1
z
LD
------  
  2

+
1 2

--------------------------------------- .=
(4)

In Equation 3 and Equation 4, the quantity  is the dispersion length.

Its meaning is quite straightforward: after propagating a distance equal to LD , the 
pulse broadens by a factor of 2 .

To demonstrate this, we created the following simple project (Figure 1).

Figure 1 GVD project layout

We set the Bit rate equal to 40 Gb/s, which corresponds to bit duration of 25 ps. Using 

the default value of 0.5 for "width" of the Optical Gaussian Pulse Generator, the 

resulting FWHM of the pulse is 12.5 ps.

The  parameter is then .

Using the value of  at 1.55m for SMF, the dispersion length is:

LD
T 0

2

2
--------=

T0 T0

TFWHM
1.665

----------------- 12.5ps
1.665

---------------- 7.5ps= =

2 20 ps 2
km–
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.

In the Optical Fiber properties, we set the length of the fiber equal to this value, and 

we disable all the effects except GVD (Figure 2).

We calculate the project and the obtained results are presented in Figure 3. We see 
that the pulse is broadened (the peak power decreases in accordance with 
Equation 4). The origin of pulse broadening can be understood be looking at the 
instant frequency of the pulse, namely the chirp.

LD
T 0

2

2
-------- 7.5

2 
20

-------------- 2.812km= = =
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Figure 2 Optical Fiber properties
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This is shown in Figure 4, where the pulse chirp is plotted together with the pulse 
intensity. Whereas the input pulse is chirpless, the instantaneous frequency of the 
output pulse decreases from the leading to the trailing edge of the pulse. The reason 
for this is GVD. In the case of anomalous GVD (2 0 ), the higher frequency ("blue-
shifted") components of the pulse travel faster than the lower frequency (or "red-
shifted") ones [1].

Figure 3 Left plot - input pulse, right plot pulse at 
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Figure 4 Same as in Figure 3. The straight lines represent the chirp
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Note: The leading edge of the pulse is blue shifted and the trailing edge of the 
pulse is red-shifted. Because the "blue" and "red" spectral components tend to 
separate in time, this leads to pulse broadening. However, the pulse spectrum 
remains unchanged, as Figure 5 shows.

Figure 5 Input (left plot) and output (right plot) spectra corresponding to Figure 3 and 4
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If the input pulse is frequency modulated (i.e. chirped), Equation 2 is replaced by:

E z 0 t=  P0
1 iC+

2
--------------- t

2

T 0
2

-----  –
 
 
 

 exp= (5)

and the expression for the dependence of the pulse width on z  is [1]

T z  T0 1
C2z

T 0
2

------------+
 
 
  2 2z

T 0
2

--------
 
 
  2

+
1 2

=
(6)

The pulse broadens monotonically with  if , however, it goes through initial 

narrowing when . In the latter case, the pulse width becomes minimum at 

distance [1]:

and is given by

T zmin 
T0

1 C
2

+ 
1 2

----------------------------= (8)

(7)

z 2C 0
2C 0
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C

1 C
2

+
---------------LD=
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The peak power of the pulse in this case is:

P zmin  P0 1 C
2

+ 
1 2

=
(9)

Initial narrowing of the pulse for the case  can be explained by noticing that 

in this case the frequency modulation (or "chirp") is such that the faster ("blue" in the 

case of anomalous GVD) frequency components are in the trailing edge, and the 

slower (or "red" in the case of anomalous GVD) in the leading edge of the pulse. As 

the pulse propagates, the faster components will overtake the slower ones, leading to 

pulse narrowing. At the same time, the dispersion induced chirp will compensate for 

the initial one. At , full compensation between both will occur. With further 

propagation, the fast and the slow frequency components will tend to separate in time 

from each other and, consequently, pulse broadening will be observed.

To demonstrate this, we use a chirped Gaussian pulse with the chirp parameter 
C 2=  (since 2 0  in our case) (Figure 6).

Figure 6 Setting the chirp parameter to observe pulse compression

Using Equation 7 and Equation 9, we obtain:

 and

.

2C 0

z zmin=

zmin
C

1 C
2

+
---------------LD

2
5
---LD 1.125km= = =

P zmin  P0 1 C
2

+ 
1 2

5 2.23mW= =
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We change the length of the fiber to 1.125km  and calculate the project.

The results for the output pulse shape and chirp are presented in Figure 7. It can be 
seen that an exact compensation between the dispersion induced and initial chirp 
occurs, and that the peak power of the pulse is 2.2mW , as given by Equation 9.

Figure 7 Pulse shape and chirp at z=0 (left) and z=zmin (right)
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Note: There is exact compensation between the initial and the dispersion-
induced chirp.

Reference:

[1] G. P. Agrawal Nonlinear Fiber Optics, Academic Press (2001).
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Effects of PMD on pulse propagation

Polarization mode dispersion (PMD) can cause serious problems in high bit-rate 
transmissions. In this lesson, the PMD emulator component is used to demonstrate 
the distortions in the transmitted signal, caused by first and second order PMD effects. 
The system showed in Figure 1 is utilized in the simulations.

Figure 1 PMD system layout

The system simulates the transmission of a sequence of pulses for a 10 Gb/s bit rate 
in a high PMD fiber with differential group delay of 71 ps, depolarization rate of 
10.8°/GHz, and polarization chromatic dispersion of 1.3ps/GHz. In the simulations, 
attenuation and dispersion are set to zero. The input signal is a sequence of NRZ 
pulses showed in Figure 2.



 EFFECTS OF PMD ON PULSE PROPAGATION

242

Figure 2 Input sequence of pulses

Simulations are carried out for two different polarizations of the optical input signal. 
Figure 3(a) shows the output signal for an input state of polarization (SOP) aligned 
with one of the two principal states of polarization, azimuth = 0 and ellipticity = 0. In 
Figure 3(b), the output signal is the same, but the input SOP is aligned with the other 
axis, azimuth = 90 and ellipticity = 0.

Figure 3(a) Simulation results for input signals with azimuth = 0, ellipticity = 0
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Figure 3(b) Simulation results for input signals with azimuth = 90, ellipticity = 0

In both cases, the main second order effect is due to the depolarization rate 
coefficient, since the polarization chromatic dispersion is too small to create a 
substantial deformation of the output signal.

The presence of power over-shoots on the sequences of "1"s, and the presence of 
energy on the "0"s are due to the imperfect cancellation of the pulses coupled on the 
orthogonal axis. The results found in the simulations are in agreement with the results 
presented in [1].
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Effects of cross phase modulation (XPM) and 
four-wave mixing (FWM)

The purpose of this lesson is to give an idea about the effects associated with cross-
phase modulation (XPM) and four-wave mixing (FWM) accompanying the 
propagation of optical signals at different carrier frequencies in a nonlinear dispersive 
fiber [1].

At first, we create the layout shown in Figure 1. The Numeric tab of the Nonlinear 
Dispersive Fiber Total Field component is shown in Figure 2. Note that the step size 
is much smaller compared to that used to simulate soliton propagation (see 
"Interactions of optical solitons"). Although the power levels here are far below the 
soliton regime, the bandwidth occupied by the signal is larger, and a small enough 
step-size is necessary to calculate the four-wave mixing products resulting from the 
interaction of the input signals accurately (see [2]). In this case the step-size is 
determined by the coherence length of the FWM process rather, than by the nonlinear 
length (associated with the self-phase modulation process).

Figure 1 Project layout
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Figure 2 Nonlinear Dispersive Fiber Total Field Properties dialog box—Numeric tab

The input consists of two Gaussian pulses 800ps spaced in time and 1nm in 
frequency Figure 3. The fiber dispersion is D 16ps nm km = . Note that the 
bandwidth we simulate is bigger than three times that of the input signal. This is done 
to avoid the any aliasing of the FWM products generated by the nonlinear interaction 
of the two pulses.

Figure 3 Input pulses and their spectrum
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Figure 4 Pulses and their spectrum after of propagation in a lossless fiber 50 km
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Figure 5 Pulses and spectrum after 100km of propagation
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The pulse at 1551nm has 2 mW peak power so that SPM is negligible for this pulse 
at 100km fiber length. The pulse at 1550nm has 20mW of peak power and the effects 
of SPM are important for this pulse; the XPM on the 1551 nm pulse will be large. After 
50 km propagation, the two pulses overlap and the spectrum of the pulse at 1551 nm 
is broadened (Figure 2 and Figure 3). This broadening is caused by the effect of XPM. 
It is interesting to note that the spectral broadening of the pulse at 1550 is larger. For 
this pulse the broadening is caused by SPM. On the other hand the broadening for 
the 1551 nm pulse (caused by XPM) is smaller due to the presence of GVD. The edge 
of the stronger pulse moves through the weaker pulse, the overlap time is diminished 
and so is the spectral broadening. At 50 km the four-wave mixing products ("spurious 
frequencies", [2] at 1549 nm and 1551 nm) are evident. Now the bandwidth of the 
signal is three times that of the input signal. If the simulated bandwidth was insufficient 
to accommodate both the signal and the spurious frequencies the power of the FWM 
products would have been falsely translated into the bandwidth of the signal (aliased).
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Figure 6 Figure 4 but including fiber losses

At 100 km, when the pulses are no longer overlapped and the FWM product have 
disappeared. The XPM induced spectral broadening for the pulse at 1551 nm has 
also vanished. This is because the effects accompanying the increase of the pulse 
overlap are opposite to those associated with the pulse separation (see [2]). The 
portion of the interfering pulse with falling intensity produces a frequency shift of the 
opposite sign to that previously produced by the rising edge [1]. This example 
illustrates that dispersion can result in a lessening of the effects of XPM and FWM in 
a lossless fiber. In a fiber with losses, the symmetry responsible for the disappearing 
of the spurious waves is no longer present—when the pulses start to overlap they 
contain more energy then when they start to separate—(as seen in Figure 6), and the 
spurious waves do not disappear.
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Combined effects of GVD and SPM on Gaussian 
pulse propagation

This lesson demonstrates that the effects of SPM and anomalous GVD on the pulse 
propagation are counteracting.

As already discussed, (see the "Group velocity dispersion" in the Tutorials), the effect 
of GVD on the pulse propagation depends on whether or not the pulse is chirped. With 
the proper relation between the initial chirp and the GVD parameters, the pulse 
broadening (which occurs in the absence of any initial chirp) will be preceded by a 
narrowing stage (pulse compression). On the other hand, the SPM alone leads to 
pulse chirping, with the sign of the SPM-induced chirp being opposite to that induced 
by anomalous GVD (see "Effects of SPM" from the Tutorials). This means that in the 
presence of SPM, the GVD induced pulse-broadening will be reduced (in the case of 
anomalous), while extra broadening will occur in the case of normal GVD.

Mathematically [1] the pulse propagation is governed by the nonlinear Schrödinger 
Equation 1:

i
E
z
------

2

2
-----

2
E

t2
---------  E 2

E–= (1)

The relative importance of GVD and SPM effects depends on the value of the 
parameter [1]:

N
2 LD

LNL
---------

P0T0
2

2
---------------= = (2)

where  and  are the dispersion and nonlinear lengths respectively. When 

, the effects of SPM are dominant and when , those of GVD 

dominate.

LD LNL
N > > 1 N < < 1
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To demonstrate their interplay we choose N=1 and used the simple layout shown in 
Figure 1. At 40 Gb/s the value of T0  is T0 7.5ps= .

Figure 1 Layout and parameters
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Figure 2 Results with SPM

z=0 z=LD

z=2LD
z=3LD
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With the default values of:

2
20ps

2
km L D– 2.812km = =

 1.317W
1–
km

1–
n 2 2.6 10

20– W m
2 Aeff 80m2 = = =

in the Nonlinear Dispersive Fiber Total Field component, setting N=1 in Equation 2, 

the peak value  of the pulse power is .

In the Optical Gaussian Pulse Generator, under Main, we enter this value for the 

power.

Figure 3 Results with disabled SPM

z=LD z=2LD

z=3LD

P0 P0 270mW=
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Figure 4 Increased pulse broadening and chirp rate

z=LD z=2LD

z=3LD

Gaussian pulse propagation in the anomalous GVD regime, taking the SPM into 
account, is shown in Figure 2. If the effects of SPM are disabled the corresponding 
results are shown in Figure 3. As one can expect both pulse broadening and pulse 
chirping are reduced due to the presence of SPM (Figure 2). In this case (anomalous 
GVD, Figure 2) the blue shifted frequency components travel faster than red-shifted 
ones. However, SPM generates new frequency components that are red-shifted 
(slow) near the leading edge and blue-shifted (fast) near the trailing edge (see SPM-
induced spectral broadening). This leads to a reduced rate of pulse broadening and 
chirping. In contrast, in the case of normal GVD, the red-shifted frequency 
components generated by SPM near the leading edge are faster than the blue shifted 
components generated at the trailing edge, which leads to an increased pulse 
broadening and chirping rate, as Figure 4 shows.
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Reference:

[1] G. P. Agrawal Nonlinear Fiber Optics, Academic Press (2001).
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Combined effects of GVD and SPM on 
modulational instability

This lesson demonstrates that the propagation of a CW beam inside an optical fiber 
is inherently unstable due to the interplay between the anomalous GVD and SPM.

The layout and the parameters are shown in Figure 1.

Figure 1 Layout and parameters
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The CW Laser is used as a pump source (Figure 2). Its "Linewidth" is set to zero 
because we are interested in the interaction between powerful CW radiation and a 
weak broadband ("white") noise.

Figure 2 CW Laser parameters

The EDFA is used only as a noise source (Figure 3). Its "Gain" is set to zero dB, which 
means that the power of the input signal from the laser is left unchanged and some 
noise is added to it to form the "CW signal + white noise" combination at the input of 
the optical fiber. The Y-polarization (associated with the noise, since the signal from 
the laser is X-polarized, but the noise is unpolarized) has been filtered out. This is 
done for the following reason: at the beginning of each simulation, the optical fiber 
component checks the polarization state of the input signal.
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Figure 3 EDFA parameters
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If two polarization components are detected, the vector model is used, regardless of 
the choice made under the "Main" tab of the fiber component (see Figure 4). The 
vector model takes twice the time necessary for a scalar simulation. The setup for the 
optical fiber component is shown in Figure 4.

Figure 4 Optical fiber component parameters
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Figure 5 shows the input and output fiber spectra.

Figure 5 Fiber input and output spectra with resolution bandwidth of 0.04nm



max
2P0

2
------------= (2)
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It can be seen that the noise components within a certain frequency band around the 

pump are amplified [1] i.e. .

The gain  is given by [1]:

where

 and  is the noise frequency shift with respect to the pump frequency.

Gain Equation 1 is maximum at two frequencies (see Figure 5) given by:

(1)

P  L  P  0  g  L exp=

g

g  
2 C

2 2
– 

1 2
2 0

0                              2 0
=

C
2 4P0

2
------------= 
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In the case detailed in this lesson:

 2
0
------

n2

Aeff
-------- 6.28

1.55 10
6–

--------------------------- 3 10
20–

93 10
12–

------------------------- 0.001307
1
Wm
--------- 1.307

1
Wkm
------------,= = = (3)

and

max
2P0

2
------------ 2 1.3 0.1

20 10
24–

------------------------------ 1.14 10
11 ,= = (4)

so

fmax
max

2
------------ 114 10

9
6.28

----------------------- 18GHz= =
(5)

Essentially, the same value is obtained from Figure 5. The value of the gain at this 
frequency shift from Equation 1 is:

gmaxL g max L 2P0L 2 1.307 0.1 50 13.07,= = = =
(6)

where L  is the fiber length.

Therefore, in dB units, the amplification at this frequency is:

G 101g gL exp  56.7dB= = (7)

From Figure 5, the output power level at this frequency is , 

while the input noise power is frequency independent and is , 

which gives 54dB for the peak amplification.

P max L  38dBm–
P L 0  92dB–=
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Figure 6 Fiber output spectrum with dispersion parameter of 2 20ps
2
km =

Figure 6 gives the output spectrum as obtained when the value of the GVD parameter 

was set to  (normal GVD).

In accordance with Equation 1, no amplification is evident in this case.

Reference:

[1] G. P. Agrawal Nonlinear Fiber Optics, Academic Press (2001).

2 20ps
2
km=
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PMD-induced broadening of ultra-short pulses

This lesson demonstrates the broadening of a "very short" (Dirac  -shaped) pulse 
caused by polarization mode dispersion (PMD). It also shows that the probability 
distribution function of the differential group delays between the principal states of 
polarization generated by the component agrees well with the Maxwellian one.

The "coarse step" method [4], [5] with fiber segments with variable length [6] is used.

This example is an illustration of the low coherence model (see e.g. [3], [7], [8]) i.e. 
the definition of PMD that neglects the coherence of the light. Let I t z   be the time-
dependent intensity at position z along a fiber with high polarization mode coupling, 
when a short (with respect to the polarization mode delay) pulse is launched. The 
following expression for the RMS width of the pulse exists [1] - [3]:

 2 2
h

2

2
----------- 2z

h
----- 1–

2z
h
-----– 

 exp+ 
 =

(1)

where 


t
2
I t z  td
I t z  td

--------------------------
tI t z  td
I t z  td

------------------------

 
 
 
  2

–= 

is one half of the difference of the group delays per unit length between the fast and 
slow axes of the fiber and h  is the mean coupling length.

In the limit z >> h  (high polarization mode coupling) I t z   is close to Gaussian, 
  is its full width and Equation 1 becomes:

 2 2
hz=

(2)

The PMD coefficient parameter in the optical fiber component  is 

.

The layout is shown in Figure 1. Figure 2 gives the parameters of the pulse generator 
and the optical fiber components. Note that all the effects, except PMD, have been 
disabled in the setup of the optical fiber component.

DPMD 
DPMD  2 h=
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Figure 1 Layout parameters and layout

In this case, the pulse width plays the role of the source coherence time. Since the 
pulse width (FWHM) is initially 50 fs (the coherence time of a typical LED is in the 
order of 60 fs), and the differential group delay (the half-width of the Gaussian 
distribution) after 200 km of propagation is several picoseconds, we are well within the 
limits of applicability of the low-coherence model.
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Figure 2 Parameters of pulse generator and nonlinear dispersive fiber

Figure 3 illustrates Equation 2 for one and same PMD coefficient 

( ) and fiber length (200km) but for different coupling lengths.DPMD 0.5ps km=
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The obtained dependence of the pulse RMS width has been fitted with a square-root 

function:

with the fitting given in each case (Figure 3). It can be seen that Equation 2 and the 

obtained results agree well when the number of scattering events is sufficiently large.

Figure 3 Illustration of different coupling lengths


Dfit
2

-------- z=
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Figure 4 gives an idea about the importance of the variable scattering section length 
(non-zero scattering section dispersion) [6]. While in the case of N identical scattering 
segments only N delay times (or partial pulses) are produced, when non-zero value 
for the dispersion of the scattering length is used, the number of delay times (partial 
pulses) is increased (to 2

N
), according to [6].

Figure 4 Lscatt 10km scatt 0= =  (top) scatt 2km=  (bottom). Fiber length is 200km
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Note: Twenty “partial” pulses (or delay times [6]) are evident in the case of fixed 
scattering section lengths.

Figure 5 Intensity distribution after 200km of propagation

Lscatt 500m scatt 100 DPMD 0.5ps  km = = =

Figure 5 gives an example about the output intensity distribution used to calculate the 
curves shown in Figure 3.
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Figure 6 DGD of a fiber (left) with histogram (right)

Note: For a comparison, the Maxwellian distribution corresponding to the 
expectation value of the DGD (   D L= ) is also shown. The values of the 
parameters are:

Next we concentrate on the statistical properties of the PMD simulation module of the 
optical fiber component. This set of results (Figure 6 and Figure 7) pertains to the 
high-coherence model (see e.g.[3], [9]), based on the concept of principal states of 
polarization (PSP). The probability distribution function of the differential group delays 
(DGD) between the PSP is Maxwellian (see e.g. [8]). Jones matrix eigenanalysis [10] 
is used to calculate the DGD between the PSP of the fiber as a function of the carrier 
wavelength of the signal. The results for this dependence, together with the 
histograms obtained from the data, are displayed in Figure 6 and Figure 7.

The theoretical (Maxwellian) distribution functions, corresponding to the expected 

value of the DGD  (in the case of strong polarization mode coupling, 

i.e. fiber length much bigger than the coupling length) are also shown. The histograms 

agree well with the Maxwellian distributions. Increasing the number of DGDs 

(increasing the wavelength range) makes the agreement even better (Figure 6, 

396 DGDs, and Figure 7, 1299 DGD's).

D 0.5
ps

km
----------- Lscatt 50m scatt 10m L 200km= = = =

  D L=
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Figure 7 DGD of a fiber (left) with histogram (right) with different parameters

Note: Parameters are:

Lscatt 1000m scatt 200m= =

The impact of the variable scattering section length on the PMD statistics can be 
demonstrated by the following example. The system considered (RZ, 40GB/s) is 
presented in Figure 8.

Figure 8 Variable scattering length impact on PMD statistics—Layout and parameters
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The thermal noise parameter of the photodetector is set to 3 10
20– W Hz . In the 

optical fiber component all the effects except PMD are disabled, and the reference 
wavelength is set to 1550nm.

Note: In order to study the PMD statistics (probability distribution functions), the 
reference wavelength must be fixed ("User defined reference wavelength 
parameter" in the Optical fiber component must be set to TRUE). Otherwise, the 
PMD-induced system penalties will not show any dependence on the carrier 
wavelength of the signal. On the equivalence between ensemble averaging and 
spectral averaging (see e.g. [7]).

The results for the Q-factor of the system, as a function of the carrier wavelength 
calculated with both fixed and variable scattering section length is shown in Figure 9.
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Figure 9 Q-factor as function of carrier wavelength with fixed and variable scattering section length

In the case when fixed scattering section length is used, the Q-factor is a periodic 
function of the wavelength. No such periodicity appears in the case of variable 
scattering section length calculation. The observed periodicity in the first case is 
related to the spectral periodicity of DGD between the PSPs of the fiber (see e.g. [11]). 
The period of the latter is the inverse DGD induced by a single scattering section [11] 
and its value agrees well with the results presented in Figure 9. When working with 
fixed scattering section length, the spectral interval covered by the simulation must be 
smaller than the spectral period of the DGDs (the inverse of the DGD induced by a 
single scattering section) to ensure the statistical independence of the collected data.
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Validation of FWM effect

This tutorial demonstrates the validity of the FWM algorithm, as well as providing the 
user with some useful designing tips for optimizing simulation time and accuracy.

The layout in was used to obtain results, and can be found in the sample file 
FWM Validation.osd

Figure 1 FWM project layout

In the two CW Lasers, the frequencies are set to 1540 and 1540.5 nm, power set to 
0 dBm, and the linewidth set to 0 (see Figure 2). The linewidth is set to 0 is because 
we are only interested in measuring the total power of the sideband frequencies, so 
the shape of the spectrum is not required.

The channels were then multiplexed together using a 2x1 Mux.

After the Mux, the signals are propagated through 75 km of nonlinear fiber, where they 
experience the effects of Attenuation, Group Velocity Dispersion (GVD), and FWM.

The setup for the SMF-28 fiber component can be see from Figure 3 through to 
Figure 6.
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Figure 2 CW Laser properties dialog box

You can see in Figure 3 that the input and output coupling efficiencies are set to 0.

Figure 3 SMF-28 fiber properties dialog box—Main tab

In Figure 4, the GVD parameter was set to 1 ps/nm/km, so that it follows the example 
in [1].
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Figure 4 SMF-28 fiber properties dialog box—Dispersion tab

In Figure 5, you will see that the Effective Area was set to 642
, and the n2  

constant to 4.3286e-21.

The n2  constant was calculated using the following equation:

n2 4821111 n
2 c=

(1)

where  is the third-order nonlinear susceptibility,  is the refractive index, and 

 is the speed of light.

Now, 1111 6e 15m
3
W s n– 1.48 c 3e8m s= = = .

Therefore,

n2 4821111 n
2 c 48 3.14 2 6e 15–  1.48 2 3e8  4.3286e 21–= = =  

1111 n
c
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Figure 5 SMF-28 fiber properties dialog box—Nonlinear tab

Figure 6 SMF-28 fiber properties dialog box—Numerical tab

If you calculate the project, you will obtain the results see in Figure 7 and Figure 8.
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Figure 7 Input optical spectrum

Figure 8 Output optical spectrum

If you zoom in on the FWM sidebands, you will find that the power is approximately 
-72.7 dBm, compared to -72.3 as predicted by [1].
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Stimulated Raman scattering

This lesson demonstrates the light amplification caused by the stimulated Raman 
scattering effect. The layout and its global parameters are shown in Figure 1.

Figure 1 Layout and global parameters
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Figure 2 shows the setup for the optical fiber component.

Figure 2 Setup parameters
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The spectrum of the input signal consists of a strong pump monochromatic wave 
(100 W) at 1550 nm and a weak (-99 dBm) Stokes wave at 1640 nm (10 THz Stokes 
shift) (see Figure 3).
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Figure 3 Input signal spectrum

Figure 4 gives the output spectrum. The weaker (low frequency) spectral component 
is amplified and the gain is G=99-61.7=37.3 dB.

Figure 4 Output signal spectrum

Raman gain coefficient is given [1] by:

since:  and  [2], [3].

The Raman gain (in dB) is then , where P is 

the pump power and L is the fiber length.

g 2Im 1111 p s–   2 1.307
1

Wkm
------------ 0.18 0.91 0.4281732

1
Wkm
------------== =

Im 1111 10THz   0.91 
2n2

Aeff
------------ 1.307

1
Wkm
------------=

G 10 gPL exp log 37.2dB= =
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Stimulated Raman scattering—Separated 
channels

The purpose of this lesson is to demonstrate light amplification resulting from the 
stimulated Raman scattering effect.

The layout with its global parameters is shown in Figure 1

Figure 1 Layout and global parameters
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The input spectrum (Figure 2) consists of a strong (pump) wave at 193 THz (100W) 
and four weak (probe) waves at frequencies 188 THz, 183 THz, 178THz and 
175.5THz. The powers of the probe-waves are all equal to -99dBm.

Figure 2 Input spectrum

The fiber parameters are relevant to SMF-28 and are specified as "wavelength 
dependent" (from data files). Constant step-size is used with the maximum nonlinear 
phase shift equal to 5mrad and the nonlinear refractive index is:

The fractional Raman contribution is  0.18= .

The output spectrum (after 200m of propagation) is shown in Figure 3.

n2 2.6 10
20– m

2

W
------=
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Figure 3 Output spectrum

The gains obtained from Figure 3 are summarized in Table 1.

Table 1 Numerically obtained dependence of the gain on the probe frequency.

The pump power is 100W and the pump frequency is 193 THz. Fiber length is 200m.

On the other hand, the gain coefficient is given by:

g vs  2sIm 1111 vp vs–  = (1)

and using the fiber data, it is shown that the numerical results are in agreement (see 
table 2) with the formula in [1].

Probe frequency [THz] Gain [dBm]

188 16.252

183 34.106

178 45.02

175.5 9.535
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Table 2 Analytically obtained results for the gain.

Probe frequency 
[THz]

Im 1111 vp vs–   s 1 kmW  G 10 gP0L exp  dBm log=

188 4.045951e-001 1.28445 16.250

183 9.114571e-001 1.19659 34.103

178 1.251922e+000 1.149963 45.017

175.5 2.678715e-001 1.133812 9.496

Figure 4 Same asFigure 3, but the pump and one of the signals are converted to "parameterized".

Note that the same results can be obtained in this using arbitrary configuration of 
sampled and parameterized signals. Figure 4 shows the same output spectrum (as 
Figure 3) however the pump and one of the signals are converted to parameterized 
signals. The numerical values of the gain for each signals (parameterized or sampled) 
are one and same. Calculations with parameterized signals are faster; however 
replacing the sampled signals with parameterized is not always possible. 

Reference:

[1] G. P. Agrawal, "Nonlinear fiber optics", Academic press, 3rd edition, 2001 Chapter 8.
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SPM-induced spectral broadening

This lesson demonstrates the basic effects of self-phase modulation (SPM) on pulse 
propagation. These include:

• Pulse chirping

• Pulse spectral broadening

The effects SPM of are described by [1]:

E
z
------ i E 2

E ,= (1)

where E z t   is the electric field envelope, and the parameter   is given by:


n20

cAeff
------------= (2)

In Equation 2,  is the carrier (or reference) frequency,  is the nonlinear-index 

coefficient and  is the effective core area [1].

The straightforward solution of Equation 1: 

shows that the pulse shape (i.e. ) remains unaffected by 

SPM. The temporarily varying phase  implies that the 

instantaneous optical frequency across the pulse is different from the carrier 

frequency . The frequency difference  is given by [1]:

and the time dependence of  is referred to as frequency chirping. While the 

action of GVD also yields pulse chirping, the chirp associated with SPM has an 

entirely different origin - in the latter case, new frequency components are generated 

that result in spectral broadening, while the spectrum remains unaffected by GVD.

To demonstrate the effect of SPM we can use the following layout (Figure 1). In the 

Nonlinear Dispersive Fiber Total Field component properties, we disable all the effects 

except SPM (see Figure 2).

0 n2
Aeff

E z t  E z 0 t  i E z 0 t =
2
z exp= =

E z t  2
E z 0 t =

2
=

NL E z 0 t =
2
z=

0  t 

 t 
NL
t

------------–=

 t 
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With the values of the parameters shown in Figure 2, the value of 

.

Figure 1 Layout of SPM induced spectral broadening and parameters

  is  1.317W
1–
km

1–
=
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Figure 2 Setting the "nonlinearities" tab to observe the effects of SPM

With the pulse peak power equal to 10 mW and the fiber length to 10.73 km, the 
obtained results are shown in Figure 3. The pulse shape remains unchanged and the 
output pulse is chirped. Note that the sign of the chirp is reversed compared to the 
case of dispersion-induced pulse chirping in the case of anomalous GVD.

Figure 3 Input (left) and output (right) pulse shape and chirp with propagation distance of 10.73 km

In Figure 3, the leading edge of the pulse becomes red-shifted and the trailing edge 
of the pulse becomes blue-shifted. If the effects of anomalous dispersion were 
present, with the chirp induced by SPM some pulse narrowing would occur. This 
means that the effect of SPM counteracts GVD.
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To see the SPM induced spectral broadening let us introduce the quantity 

 where  is the peak power. Figure 4 shows the spectra for an 

unchirped Gaussian input pulse for several values of the maximum phase shift.

The effects of SPM-induced chirping and spectral broadening are related [1]. 
According to Figure 3, the same chirp occurs at two values of t  which means that the 
instantaneous frequency is one and same at two distinct points. These two points 
represent two waves of the same frequency that can interfere constructively or 
destructively producing, thus, the oscillatory structure of the pulse spectrum.

Figure 4 SPM broadened spectra for an unchirped Gaussian pulse

 

 

max P0z= P0



 
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The SPM induced spectral broadening depends on the pulse shape and on the initial 
chirp. The dependence on the pulse shape is shown in Figure 5 where the output 
spectra of Gaussian and super-Gaussian (third order) pulses are presented for 
max 4.5= :

Figure 5 SPM broadened pulse spectra at max 4.5=

Initially unchirped Gaussian pulses Third-order super-Gaussian pulses
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XPM-induced asymmetric spectral broadening

The purpose of this lesson is to demonstrate the asymmetric spectral broadening 
caused by XPM.

The layout along with the global parameters are shown in Figure 1.

Figure 1 Layout and global parameters
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The input consists of two superimposed Gaussian pulses [1] (Figure 2).

Figure 2 Superimposed Gaussian pulses
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The carrier wavelengths of the pulses are  and , 

and the corresponding peak powers are  and . 

Pulse duration (FWHM) is 0.5 bit (12.5ps). The fiber group delay, effective area are 

relevant to those of SMF-28 and are specified as "wavelength dependent".

The nonlinear refractive index value is . Constant step size 

(50 mrad) is used. The effects of GVD are not taken into account. The output (after 

20.9m, corresponding to five walk-off lengths) is shown in Figure 3.

Figure 3 Output

1 1487.4nm= 2 1600nm=
P1 749.05W= P2 1498.1W=

n2 2.6 10
20– m

2
W=
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The spectral asymmetry is caused by XPM. For the Pulse "1" (at 1487.4 nm) the 
asymmetry is more pronounced because the XPM is stronger for this pulse 
(P2 2P1= ). Since the XPM induced spectral broadening depends on the sign of 
group velocity mismatch, the spectra presented in [1] are "mirror" images of those 
presented in Figure 3 since the latter are obtained in the anomalous GVD region 
(infrared) while those presented in [1] correspond to the visible region (normal GVD).

Figure 4 Output probe spectra
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The time delays between the faster (pump) pulse and the slower (probe) pulse are 
equal to 0 ps (1), 15.014 (2) ps and 30.028 (3) ps.
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Figure 4 demonstrates the spectral broadening, caused by XPM, induced by a strong 
"pump" pulse on a weak probe. To achieve this effect, the following changes are 
applied to the design layout.

The peak of the faster, (pump) pulse at  is set to 1872.63 W. The 

fiber length is made equal to four walk-off lengths, or, 16.77 m. The power of the probe 

pulse (at 1600 nm) is set to a value much smaller than that of the pump pulse (0.06W). 

Figure 4 shows the output probe spectra for three different value of the initial time 

delay between the probe and the pump. The faster (pump) pulse is delayed with 

respect to the slower (probe) pulse. There is a good agreement between the results 

presented in Figure 4 and [1].

1 1487.4nm=
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Kerr shutter

The purpose of this lesson is to demonstrate that the Kerr effect in optical fibers can 
be used to produce ultra-fast all-optical switch (shutter).

Figure 1 Layout and global parameters

Figure 1 shows the layout and the global parameters.

Figure 2 gives the field configurations. Powerful pump beam, polarized along one of 
the fiber axis co-propagates with a weak "probe" beam at different frequency linearly 
polarized at an angle of 45 degrees with respect to a fiber axis. In the absence of the 
pump, a crossed polarizer blocks the probe beam.
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Figure 2 Field configurations

Considering CW conditions, and in the presence of the pump beam, the equations for 
the EX  and EY  components of the probe beam are [1].

EX
z

--------- i EX
2 2

3
--- EY

2
2 E0

2
+ + 

 EX=

EY
z

--------- i EY
2 2

3
--- EX

2
2 E0

2
+ + 

 EY=

(1)

Neglecting the probe power with respect to that of the pump, the solutions of (1) are:

 

EX z 
EP

2
--------- 2iP0z exp=

EY z 
EP

2
--------- 2

3
---iP0z 
 exp=

(2)

      (2)

As shown in Equation 2, the two components of the probe beam acquire different 
phase shift during their propagation, and consequently, the polarization state of the 
probe beam changes (from linear to elliptic) and the probe is partially transmitted 
through the polarizer.



 KERR SHUTTER

311

The transmitted power is given by:

PT
EX EY–

2
-------------------

2
= (3)

Using Equation 2, Equation 3 can be transformed to:

PT E
P 2

sin
2 2

3
---P0L 
 = (4)

where L is the fiber length. Since the probe and the pump are at different frequencies 
the pump power transmitted through the polarizer can be easily filtered out.

Figure 3 Probe transmission coefficient as function of pump power

Figure 3 shows the probe transmission coefficient as a function of the pump power as 

obtained from Equation 4 and from the simulation for  and 

.

The power dependent transmission coefficient of the device (Equation 4) can be 
exploited for ultra-fast optical switching and gating, since the fiber nonlinearity is of 
electronic origin and its response time is very low.

 1.284W
1–
km

1–
=

L 50m=
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Figure 4 shows a device that performs signal sampling at specified times by a Kerr 
shutter. Note that here we neglect the fiber birefringence and the fact that the group 
velocities are different for the pump and probe frequencies. 

Figure 4 Signal sampling at specified times by a Kerr shutter

The probe (or "signal") at 188THz is shown in Figure 5.

Figure 5 Probe at 188THz
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Figure 6 Pump at 193 Thz

The pump (at 193 THz) consists of a sequence of short pulses (Figure 6). 

Figure 6(a) shows the spectrum of the input signal (pump and probe).

Figure 6(a) Spectrum of input signal
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Each pump pulse opens the shutter and the device becomes transparent for the 
signal at 188 THz. The output appears in the form of "samples" exactly at times 
corresponding to the location of each pump pulse, as Figure 7 shows. Note that the 
filters have blocked the pump.

The ultra-fast switching properties of the Kerr-gate can be used for optical imaging in 
medicine (see [2] and the references therein). Light reflected from the tissue (a 
strongly scattering medium) is then passed through a Kerr shutter in which (nonlinear) 
birefringence is induced by short infrared pulses. By recording the light transmitted 
through the shutter, electronically or by using conventional photography, the shutter 
enables time-gated images to be acquired with a temporal resolution of a few 
picoseconds. High-resolution images through scattering (turbid) media may be 
obtained by selectively sampling the transmitted photons with the shortest flight times 
(i.e. the least scattered photons).

Figure 7 Results

References:

[1] G. P. Agrawal, "Nonlinear fiber optics", Academic press, 3rd edition, 2001.

[2] Jeremy C Hebden, Simon R Arridge and David T Delpy Phys. Med. Biol. 42 (1997) 825-840.
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Bidirectional fiber and Raman design

The objective of this lesson is to demonstrate a distributed Raman fiber design.

Initially, the system described in Figure 1 was designed. 

The system consists of 64 channels at 10 Gbits/s propagating for a 50 km SMF-28 
fiber. The attenuation in the fiber is compensated by the Raman amplification due to 
the 4 backward laser pumps launched in the input port 2. 

Figure 1 System layout

The 64 channels are spaced by approximately 100 GHz and go from 1548.92 nm to 
1562.4 nm. The input power is -17.44 dBm/channel. 

There are 4 pumps and the pump powers and wavelengths were chosen using the 
optimization tool and the Raman Amplifier-Average power model instead of the 
Bidirectional Fiber to guarantee a faster optimization. 

Figure 2 shows the input power spectrum at the input port 1 in the fiber (left input port).
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Figure 2 OSA at the Fiber input port 1

After simulating the system, the output spectrum is shown in Figure 3. 
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Figure 3 OSA at the Fiber output port 2

As we can see in the WDM analyzer (Figure 4), the average gain in the fiber was 1.27 
dB and the gain flatness was 1.5 dB.

Figure 4 WDM Analyzer
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Notes:
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Optical receivers

The first portion of this section provides introductory information about Modulation formats.

The remainder of the section contains the following advanced and illustrative simulation projects:

• Extracting the thermal noise parameter for a specific receiver sensitivity

• Receiver noise—PIN

• Receiver noise—Shot noise enhancement with APD

• Receiver sensitivity—Bit error rate (BER)

• Receiver sensitivity—Minimum input power

• Sensitivity degradation—Extinction ratio

• Signal degradation—Jitter

• Electrical PLL
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Notes:
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Modulation formats

The first step in the design of an optical communication systems is to decide how the 
electrical signal should be converted into an bit stream. There are two typical choices 
for the modulation format of the signal:

• return-to-zero (RZ)

• nonreturn-to-zero (NRZ)

Examples of the modulation formats are shown in Figure 1.

Figure 1 Modulation Formats

In the RZ formats, each pulse representing bit 1 is shorter than the bit slot, and its 
amplitude returns to zero before the bit duration is over (see Figure 3). In the NRZ 
format, the pulse remains on throughout the bit slot and its amplitude does not drop 
to zero between two or more successive 1 bits (see Figure 2). As a result, pulse width 
varies depending on the bit pattern, whereas it remains the same in the case of RZ 
format. 
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Figure 2 NRZ - Time

Figure 3 RZ - Time
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An advantage of the NRZ format is that the bandwidth associated with the bit stream 
is smaller than that of the RZ format by about a factor of 2, because on-off transitions 
occur fewer times (see Figure 4 and Figure 5).

Figure 4 NRZ - Frequency
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Figure 5 RZ - Frequency



 MODULATION FORMATS

325

Notes:
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Extracting the thermal noise parameter for a 
specific receiver sensitivity

In this tutorial, we provide a basic example of Goal Attainment optimizations. In this 
example we will use the optimization tool in the context of parameter extraction. 
Thermal noise parameter of PIN will be extracted to get a receiver sensitivity of -17 
dBm.

The design layout is shown in Figure 1. The transmitter power is selected to be 0 dBm. 
The bit rate is 10 Gbps and average received power is about -17 dBm when 
attenuation is 14.5 dB. 

Figure 1 Project layout for the extraction of thermal noise parameter of PIN
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Setting up the optimization

To set up the optimization, complete the following procedure.

Step Action 

1 In the Optimization dialog box, Optimization Name field, type Receiver 
Sensitivity.

2 Select Optimization Type: Goal Attaining.

3 Set the Result Tolerance to 0.6.

4 On the Parameters tab, select Thermal noise parameter: PIN from 
Parameters list, and add it to Selected list.

5 Set Minimum and Maximum values to 1.0E-25, 1.0E-21 respectively.

6 On the Results tab, select Max. Q Factor of BER analyzer from Results list 
and add it to Selected list.

7 Set Target Value to 6.

8 Close the Optimizations dialog box.

9 Run the optimization.

After about 3 passes, the optimizer will find the Thermal noise parameter to get a Q 
factor of 6 when received average power is -17 dBm. The proper Thermal noise is 
found to be 5E-22 W/Hz. The eye diagram in this case is shown in Figure 2. Figure 3 
shows the Max. Q factor, respect to received power. This figure is obtained by 
sweeping the transmitter power from -3 dBm to 4 dBm.

Figure 2 Thermal noise factor of PIN is 5E-22 W/Hz with received average signal power -17 dBm
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Figure 3 Max. Q factor vs. received power
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Receiver noise—PIN

There are two fundamental noise mechanisms in a photodetector:

• shot noise

• thermal noise

Receiver Shot and Thermal noise.osd details the signal degraded by thermal and 
shot noise in the PIN photodetector. The low-pass filter has a cutoff frequency with the 
same value as the bit rate.

Figure 1 Receiver Shot and Thermal noise

The upper system has the photodetector without thermal noise; the only noise 
generated at the output is the shot noise. In Figure 2, you can see that the shot noise 
is signal amplitude dependent.
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Figure 2 Receiver Shot noise

The lower system has the photodetector with shot noise; the only noise generated at 
the output is the thermal noise. In Figure 3, you can see that the thermal noise is 
signal amplitude independent.

Figure 3 Receiver thermal noise
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Receiver noise—Shot noise enhancement with 
APD

Optical receivers with APD generally provide a higher SNR for the same incident 
optical power. The improvement in the SNR is due to the internal gain that increases 
the photocurrent by the multiplication factor M.

Figure 1 Receiver PIN x APD

The APD photodetector systems (see Figure 2) has a Q factor higher that the one with 
PIN photodetector for a multiplication factor of 3 (see Figure 3).
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Figure 2 APD Q Factor

Figure 3 PIN Q Factor

If we increase the multiplication factor, there is a point at which the shot noise 
degrades the system performance, therefore, it is important to find the optimum APD 
gain.
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If you run the same simulation and vary the value of the multiplication factor, you can 
see the evolution of the Q factor in Figure 4.

Figure 4 Q factor x APD Gain

For a gain higher of 16, there is no advantage to using the APD, because it will not 
improve the receiver sensitivity.
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Receiver sensitivity—Bit error rate (BER)

The performance criteria for digital receivers if governed by the bit-error-rate (BER), 
defined as the probability of incorrect identification of a bit by the decision circuit of 
the receiver. Receiver BER - Q factor.osd shows the BER and Q factor at the 
data recovery stage for different values of input power.

Receiver BER - Q factor

If you change the signal input power, you can calculate Q Factor and BER versus 
attenuation, in addition to BER versus Q factor (see Figure 1 for Maximum Q factor 
vs. Attenuation, Figure 2 for Minimum BER vs. Attenuation, and Figure 3 for minimum 
BER vs. Maximum Q factor).

Figure 1 Q Factor x Attenuation
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Figure 2 BER x Attenuation

Figure 3 BER x Q Factor
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Receiver sensitivity—Minimum input power

This example shows the minimum optical power that a receiver needs to operate 
reliably with a BER below a specific value (see Figure 1). In this example, you 
calculate this input power by targeting a BER of 10-9, a Q factor equal to 6 for a PIN 
photodetector, and an APD.

Figure 1 Receiver Min. Received Power

This example shows that the receiver sensitivity by using the PIN -32.8 dBm (see 
Figure 2) and the APD with a gain equal to 3, the sensitivity increases to -41.4 dBm 
(see Figure 3).
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Figure 2 Power PIN

Figure 3 Power APD

Figure 4 EYE PIN Receiver
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Figure 5 EYE APD Receiver
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Sensitivity degradation—Extinction ratio

A simple source of power penalty is related to the energy carried by 0 bits. Some 
power is emitted by transmitters even in the off-state. Sensitivity Degradation 
- ER.osd includes an external modulated laser where you can specify the extinction 
ratio at the modulator (see Figure 1).

Figure 1 Sensitivity Degradation - ER

In this project we vary the value of the ER and we calculate the Q factor at the receiver 
(see Figure 2).
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Figure 2 Q factor x ER
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Signal degradation—Jitter

Jitter is defined as the short-term variations of a digital signal's significant instants 
from their ideal positions in time. Significant instants could be (for example) the 
optimum sampling instants. Project Signal Degradation - Jitter.osd (Figure 
1) demonstrates the setup for the 'Electrical Jitter' component. It requires an electrical 
signals and the clock signal from the PRBS in order to estimate the signal bit rate. 
Parameter sweeps are use to generate multiple eye diagrams for different values of 
jitter amplitude and frequency.

Figure 1 Signal degradation from jitter

Project Measuring Jitter.osd demonstrates how to measure Jitter using the Eye 
Diagram Analyzer histogram feature. Figure 2 shows the total jitter of an eye diagram, 
measured at the eye cross point, as the difference between the time values of marks 
A and B. Jitter is composed of two basic types: random and deterministic. In 
OptiSystem we can use the Eye Diagram Analyzer histogram feature to generate a 
histogram that shows the deterministic and random components of the jitter, as 
depicted in Figure 3
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Figure 2 Total jitter from the eye diagram

Figure 3 Using histograms to measure jitter
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Electrical PLL

The system demonstrates an electrical phase-locked loop.

Sample: EPLL.osd

The layout presented in the figure below is PLL system configured with a phase 
detector, a low pass filter and a voltage controlled oscillator. This example shows the 
response of a PLL to a sequence of pulses modulated in frequency to an electrical 
carrier at 1GHz.

Figure 1 PLL system

Since the single sample signals are used in this configuration, we can disable the 
display messages in the calculation window, as demonstrated in the figure below and 
the simulation will be faster.

Figure 2 Calculation window
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After running the simulation, the following results were obtained

Figure 3 (a) Input sequence and (b) output sequence recovered by PLL

(a) (b)
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Doped optical fiber amplifiers

This section contains the following advanced and illustrative simulation projects.

• Analysis of Gain and Noise in Erbium doped fiber

• Optimizing the EDFA gain for WDM lightwave systems

• Excited state absorption impact on EDFA performance

• Ion-ion interaction effects

• Rayleigh backscattering in EDFA

• Inhomogeneous broadening in EDFAs

• Power transients in EDFAs

• Temperature dependence in EDFA

• Ytterbium-doped fiber amplifiers

• SPO optimization—System margin

• SPO optimization—EDFA fiber length

• EDFA — Basic concepts

• Booster Amplifier

• Inline Amplifier

• Preamplifier

• Pumping requirements

• Transient Control in EDFAs

• Amplifier Characteristics

• Automatic Control Simulation

• Erbium-doped Fiber Laser

• Reflective Amplifier

• Split-Band Amplifier

• Dynamic Amplifier Using Ytterbium-Doped Fiber

• Gain Flattening Filter Optimization

• Amplification of multiple modes in Er-doped multimode fibers

• S-band amplification using Tm-DFA
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• Ultrashort Pulse Fiber Laser
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Notes:
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Analysis of Gain and Noise in Erbium doped 
fiber

This lesson demonstrates the performance of an amplifier (gain and noise) based on 
Giles and Desurvire [1] reference.

Figure 1 Layout of the system considered in the analysis of gain and ASE

The characteristics of noise and gain presented in Figure 4.b [1] are reproduced 
through the system shown in Figure 1. 

Figure 2 shows gain of pump and signal, and the power of backward and forward ASE 
as a function of the pump power. The parameters used in this simulation are displayed 
at Figure 1 and they are similar to the values presented in Table 1 [1], except for the 
values of the absorption and emission cross sections. Nevertheless, the results found 
are in good qualitative agreement with the paper.
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Figure 2 Amplifier gain and ASE power versus pump for an Er3+-doped fiber amplifier

Note: Figure 2 equivalent to Figure 4 b) [1]

In this second case, the saturation effect of an amplifier is shown using two 
wavelength multiplexed signals at 1545 nm and 1555 nm. The system layout is shown 
in Figure 3 and the parameters used are similar to the parameters in Table II [1].

Figure 3 Layout of the system used to demonstrate the saturation of the amplifier

Figure 4 shows the gain compression in the two signals due to the increase in the 
input power, causing the saturation of the amplifier.
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Figure 4 Output spectra of a two channel amplification of a saturated amplifier

In the next case, the amplifier has two stages and a filter is inserted between the 
stages (see Figure 5). The effects of the equalization in the ASE are demonstrated.

Figure 5 Layout of the system used to demonstrate gain equalization in the amplifier

The EDF parameters used in this simulation are the same as in the previous case. A 
filter centered at 1931 nm is introduced in the middle of the EDF in a way that 
equalizes the gain of the two channels. Figure 6 shows the results with and without 
the filter. This figure is equivalent to Figure 7 in [1].
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Figure 6 Amplifier gain-leveling with a filter centered at 1531 nm

The results of this lesson demonstrated a qualitative agreement with the results 
obtained by Giles and Desurvire in [1], considered to be one of the most important 
references in the EDFA modeling.

Reference:

[1] C. Randy Giles, and Emmanuel Desurvire, "Modeling Erbium-Doped Fiber Amplifiers". IEEE 
Journal of Lightwave Technology, Volume: 9 Issue: 2, Feb. 1991, Page(s): 271 - 283.



 OPTIMIZING THE EDFA GAIN FOR WDM LIGHTWAVE SYSTEMS

355

Optimizing the EDFA gain for WDM lightwave 
systems

In this tutorial, we provide an example of the gain flatness optimization type. The gain 
of the EDFA will be flattened by optimizing the fiber length and pump power.

One difficulty in implementing a WDM system including EDFA's is that the EDFA gain 
spectrum is wavelength dependent. This effect results in SNR differential between 
channels after passing through a cascade of EDFA's. Several method to correct this 
gain non-uniformity are suggested, for example using internal [1] or external filters [2], 
or thermally decreasing the homogeneous line broadening of the amplifier [3]. These 
methods require either extra components or are complicated. A promising method is 
suggested in [4]. This method is based on optimizing the EDFA itself by controlling the 
fiber length and pump power for a given input power and desired output power.

In this example we show how to flatten the gain of an EDFA by using this technique. 
The project layout is shown in Figure 1.

Figure 1 Project layout of gain optimized EDFA

Optimization targets are chosen as in [5] to have a comparison. However, note that 
the fiber parameters in our simulation might be different than that of [4] since no value 
is given there. The input of EDFA is 16 equalized wavelength multiplexed signals in 
the wavelength region of 12 nm (1546-1558 nm) with 0.8 nm separations. Power of 
each channel is -26 dBm. We have used default fiber parameters. The desired gain 
is 23 dB. We also want an output power of more than 8.5 dBm and a gain flatness 
(defined as Gmax/Gmin) of less than 0.5 dB.
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Fiber length and pump power is selected as parameters to be optimized to achieve 
the desired gain under output power and gain flatness constraints. The Dual Port 
WDM Analyzer measures gain and flatness, whereas the Optical Power Meter 
measures the output power. Initial parameter values are as follows: Pump power is 
100 mW; fiber length is 4 m. The pump power is bound between 0 and 160 mW. The 
fiber length is bound between 1 and 40 m. Parameter termination tolerance is 1, result 
and constraints termination tolerance is 0.1.

Note that no unit for parameters and results is indicated in the optimization tool. The 
units of parameters and results in optimization tool are taken to be same as the ones 
that are given in project layout for the corresponding parameter or result.

Figure 2 Signal and noise spectrum of an un-optimized EDFA

Figure 2 shows an un-optimized amplifier output signal and noise spectrum when 
pump power and fiber length are 100 mW and 4 m. In this case, even though the 
average gain is about 30 dB, gain flatness is about 2.24 dB, which is much higher than 
required.
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Figure 3 Output signal and noise power spectrum

After 24 passes, pump power and fiber length are optimized to achieve the desired 
goals. Optimum pump power and fiber length are found to be 24.13 mW and 
approximately 5.22 m.

At these values, an average gain of 23 dB and a gain flatness of 0.29 dB are achieved. 
The output signal power is about 8 mW. The output signal and noise spectrum is 
shown in Figure 3.

These results are comparable to results of [5] where optimization is done by using a 
semi-analytical method and then the findings are confirmed experimentally. 
Compared with the results of [5], our simulation results in a better gain flatness.



 OPTIMIZING THE EDFA GAIN FOR WDM LIGHTWAVE SYSTEMS

358

References:

[1] M. Tachibana, et al., "Erbium-Doped Fiber Amplifier with Flattened Gain Spectrum", IEEE 
Photon. Tech. Lett. 3, 118 (1991).

[2] S. F. Su, et al., " Flattening of Erbium-doped fiber amplifier gain spectrum using an acousto-
optic tunable filter", Electron. Lett. 29, 477 (1993).

[3] E. L. Goldstein, et al., "Inhomogeneously broadened fiber amplifier cascade for transparent 
multiwavelength lightwave networks", J. Light. Tech. 13, 782 (1995).

[4] M. A. Ali, et al., "Performance of erbium-doped fiber amplifier cascades in WDM multiple access 
lightwave networks", IEEE Photon. Tech. Lett. 6, 1142 (1994). 

[5] S. Y. Park, et al. "Doped fiber length and pump power of gain-flattened EDFAs", Elect. Lett. 32, 
2161 (1996).



 EXCITED STATE ABSORPTION IMPACT ON EDFA PERFORMANCE

359

Excited state absorption impact on EDFA 
performance

This lesson shows the influence of signal excited-state absorption (ESA) on the 
performance of an EDFA.

The effect of signal ESA happens because a signal photon is absorbed by an erbium 
ion in an excited state, thereby promoting it to an even higher energy state and 
causing degradation in the amplifier efficiency. This effect is wavelength dependent 
since it depends on matching photon energies to the transition energies between 
excited-states of the Er3+ ion. 

To show the impact of signal ESA on the EDFA performance, the system shown in 
Figure 1 was used in the simulations. It consists of a set of 47 input signals (see table 
1) multiplexed by an ideal multiplexer. The EDFA has a co-propagating pump signal 
at 1480 nm and some losses in the system are considered using optical attenuators. 
The gain and NF figure for each channel is calculated using the Dual Port WDM 
Analyzer component.

Figure 1 System layout used to analyze the performance of the EDFA

Some of the EDFA parameters are displayed in Figure 1. The simulations are taking 
into account the Rayleigh scattering effect too, but this effect does not cause any 
considerable difference in the results and it could be neglected in this case. 

When the ESA effect is taken in account, the user has to pay attention to the way that 
the ESA cross section is loaded. The Erbium doped fiber component accepts two 
formats for the ESA cross section: 

(1) The file with the ESA cross section contains the emission cross section and the 
ESA cross section together, eff esa emission+=

(2) The file contains only the ESA cross section. 
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For the first case, the user has to check the box extract ESA and the component will 
extract the ESA cross section from this file. Figure 2 shows an example with the 
enhanced tab for the two cases. As we can see in Figure 2, the signal ESA peak is at 
1680 nm.

Figure 2 ESA cross sections
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The simulations were done for three sets of signal input powers. Table 1 shows the 
wavelength and input powers for the 47 channels of each set.
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Table 1 Signal wavelengths and input powers of each channel in the three different sets 
used in the simulations

Wavelength (nm)

Set 1

Input Power 
(dBm)

Set 2

Input Power 
(dBm)

Set 3

Input Power 
(dBm)

1570.444 -7.4 -17.5 -27.6

1571.267 -7.6 -17.8 -27.8

1572.089 -7.5 -17.6 -27.6

1572.911 -8.3 -18.4 -28.5

1573.756 -6.5 -16.6 -26.6

1574.578 -6.4 -16.5 -26.6

1575.4 -6.4 -16.5 -26.5

1576.2 -7.1 -17.1 -27.1

1577.067 -6.5 -16.6 -26.6

1577.867 -6.5 -16.6 -26.6

1578.711 -6.6 -16.6 -26.6

1579.556 -6.5 -16.5 -26.5

1580.378 -6.9 -17.0 -27.0

1581.2 -6.7 -16.7 -26.7

1582.044 -6.5 -16.6 -26.6

1582.889 -6.6 -16.7 -26.7

1583.711 -6.6 -16.6 -26.6

1584.556 -6.5 -16.5 -26.5

1585.356 -6.7 -16.7 -26.7

1586.244 -6.7 -16.7 -26.7

1587.089 -6.8 -16.8 -26.8

1587.911 -6.5 -16.5 -26.5

1588.778 -6.7 -16.7 -26.7

1589.6 -5.9 -16.0 -25.9

1590.444 -6.6 -16.6 -26.5

1591.289 -6.7 -16.7 -26.6

1592.133 -6.4 -16.4 -26.4

1592.956 -6.0 -16.0 -26.0

1593.822 -5.8 -15.8 -25.8
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Two simulations were done for each set, one considering the ESA effect and other 
neglecting the ESA. In this way, the ESA impact in the results will be clearer. The gain 
and noise figure results found for each set are shown in Figure 3.

1594.689 -6.2 -16.2 -26.2

1596.378 -6.2 -16.2 -26.1

1597.222 -6.9 -17.0 -26.9

1598.089 -6.9 -16.9 -26.8

1598.933 -6.9 -16.9 -26.8

1599.778 -6.8 -16.8 -26.7

1600.622 -6.6 -16.6 -26.5

1601.467 -6.7 -16.7 -26.6

1602.333 -6.6 -16.6 -26.6

1603.2 -7.5 -17.5 -27.4

1604.022 -6.8 -16.8 -26.7

1604.911 -6.8 -16.7 -26.7

1605.778 -6.7 -16.7 -26.6

1606.622 -6.9 -16.9 -26.8

1607.489 -6.6 -16.6 -26.5

1608.356 -6.8 -16.8 -26.7

1609.222 -6.8 -16.9 -26.8

1610.089 -6.8 -16.8 -26.7
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Figure 3 Gain and noise figure results for signal input powers: Set 1, Set 2, and Set 3



 EXCITED STATE ABSORPTION IMPACT ON EDFA PERFORMANCE

365

In the graphs, it is possible to see that in all sets, the difference in the results obtained 
with ESA and without ESA starts to become serious for wavelengths larger than 
1600 nm. The ESA effect, as expected, caused a considerable decrease in the gain 
for   > 1600 nm.

From these results it is possible to conclude that the ESA effect cannot be neglected 
in the design of an L-band amplifier when the signal band goes beyond 1600 nm.
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Ion-ion interaction effects

This lesson demonstrates two of the ion-ion interaction effects on EDFAs:

• homogeneous upconversion effect (HUC)

• inhomogeneous pair-induced quenching (PIQ)

As explained in the technical description, the ion-ion interaction effects relate to the 
issue of energy transfer between rare earth ions. When the local concentration of rare 
ions becomes high enough, it is no longer valid to assume that each ion is an isolated 
ion that acts independently of its neighbors. This can have a negative impact on 
amplifiers performance when the upper state of an amplifying transition is being 
depleted by energy transfer. 

Homogeneous Upconversion

The homogeneous upconversion effect is an  interaction effect and its 

impact on the EDFA performance is linked to the concentration of erbium ions in the 

fiber. In a fiber with a high concentration of erbium ions ( ), the 

homogeneous upconversion tends to cause more impairment in the amplifier 

performance than in a fiber that has lower erbium concentration.

To demonstrate the impact of homogeneous upconversion in the EDFA, the system 
shown in Figure 1 was simulated for different fibers and the gain was analyzed.

Figure 1 System layout used to analyze homogeneous upconversion in an EDF
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First, to characterize each fiber, a new parameter is defined. The upconversion 
lifetime [1]:

up 1 nt Uc= (1)

where nt  is the concentration of erbium ions, and Uc  is the two particle upconversion 
coefficient.

Simulations were done for four fibers: one with no homogeneous upconversion effect, 
and three with upconversion lifetimes of 1 ms, 2 ms and 5 ms. 

The same erbium ion concentration was considered for all fibers. In the case of the 
fibers where the homogeneous upconversion was considered, the value of the 
upconversion coefficient (Uc ) was set to give the corresponding upconversion 
lifetime.

Figure 2(a) shows the tab set up for a fiber without homogeneous upconversion and 
Figure 2(b) considers the upconversion lifetime of 1 ms.

Figure 2 Enhanced tab setup for a fiber (a) without and (b) with homogeneous Upconversion effect
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After the simulations, the gain versus pump power curves were plotted for each fiber. 
Figure 3 shows the results found in the simulations. This result shows the degradation 
in the performance of the EDFA due the upconversion effect. To compensate for the 
decrease in the gain, the pump power has to be increased. These results agree well 
with those in [1].
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Figure 3 Signal gain at 1550nm for different values of upconversion lifetime: 1 ms, 2 ms, 3 ms and no 
upconversion effect

Because of its dependence on ion concentration, homogeneous upconversion is 
negligible at low concentrations.

Pair-Induced Quenching

The PIQ effect means that the energy transfer rate between two or more ions is on a 
time scale significantly faster than that of the pump rate, so that at the pump powers 
considered the pump is unable to keep both ions excited.

The Erbium-doped fiber component takes this effect into account when the user 
selects the inhomogeneous option for the ion-ion interaction effects parameter. In this 
case, the user has to specify the relative number of clusters (K ) in the fiber and the 
number of ions per cluster (mk ). Figure 4 shows an example of a doped fiber with 
K 1.4%=  and mk 2= .
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Figure 4 Setting inhomogeneous pair induced quenching in the Enhanced Tab

Simulations were done to demonstrate the influences of the PIQ in the performance 
degradation of an EDFA. The parameters of the fiber and the system layout used in 
the simulations are shown in Figure 5. This system is prepared to assemble the curve 
signal gain at 1530 nm versus pump power. The input signal power is kept at -20 dBm 
and the pump power at 980nm is varied from 2mW to 50mW.

Figure 5 System layout used to analyze PIQ in an EDF
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In these simulations, all fiber parameters are kept constant except for the relative 
number of clusters, which is different for each curve. Three curves were obtained in 
the simulations to demonstrate the decrease in the pump efficiency. Figure 6 shows 
the gain reduction for two values of relative number of clusters (K = 10% and K = 
20%), compared to a fiber without PIQ (k = 0).

Figure 6 Amplifier gain at 1530nm vs. input pump power, as a function of the relative number of clusters

The simulations results show a high degradation in the performance of an EDFA due 
the effect of pair-induced quenching. This result agrees well with the results 
demonstrated in [1].
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Rayleigh backscattering in EDFA

This lesson demonstrates the Rayleigh backscattering effect in the EDFA.

The backscattering from an EDFA exceeds backscattering from an equivalent length 
of a non-doped fiber. Because Rayleigh backscattering can cause degradation in the 
EDFA performance [1], this effect has to be considered in the simulations to give 
better accuracy in the results. The EDF component considers the Rayleigh scattering 
effect in the simulations.

This lesson demonstrates the backscattering caused by the Rayleigh effect and the 
results of simulations are compared to an analytical approximation given by [2]. The 
system used in the simulations is shown in Figure 1.

The WDM analyzer linking the coupler output port to the output port at the right end 
of the erbium-doped fiber gives the return loss of the signal at 1558nm. This return 
loss indicates the ratio between the input signal power and the reflection power 
generated by the Rayleigh backscattering effect.

Figure 1 System layout used to find the return loss of the EDFA

The characteristics of the EDF used in the simulations are shown in Figure 2 and 
Figure 3. In the enhanced tab in Figure 2, the values for the Rayleigh constant and 
capture fraction are defined. In the case of capture fraction, the option for the 
component was chosen. In this case, the value of the capture is given by the equation 
(25) in the technical background.
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Figure 2 Erbium-doped fiber characteristics (a) Main tab and (b) Enhancement tab
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Figure 3 shows the absorption and emission cross sections of the EDF used.

Figure 3 (a) Absorption and (b) emission cross sections of the EDF
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In accordance with [2], the return loss from an EDF in the presence of fiber scattering 
can be approximated by:

RL
C   s   L

2 G  
--------------------------------------- 2 G  

10 log
--------------------

10e 
  1–exp–= (1)

Where G  is the gain of the EDFA, L  is the fiber length, C  is the capture fraction and 
s  is the background loss due to scattering.

This equation gives a reference to compare the results obtained from the simulations. 
However, before you calculate the return loss, it is necessary to obtain the signal gain 
at 1558nm. 

The gain obtained from simulations without consider the Rayleigh scattering effect is 
shown in Figure 4. This gain as function of the signal input power was obtained for 
two fiber lengths, 10m and 20m. These two curves were used in Equation 1 to 
calculate the return loss. The results of the simulations, including the Rayleigh 
scattering, and the analytical results are shown in Figure 4.

Figure 4 (a) Simulated gain at 1558 nm. (b) Return loss at 1558 nm versus signal input power
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Note: Distance at 10m and 20m for both.

The results shows good agreement with the fiber length of 10m. For 20m of EDF, the 
results start to show considerable differences at input power of -15dBm. This happens 
because the analytical model is only reliable for population's inversion approximately 
constants [2].

For the case of 20m, the variations of the inversion of population along the EDF are 
related to the differences between the results. Figure 5 shows the normalized 
population of the metastable level for the EDF length of 10m (a) and 20m (b) for an 
input signal power of -10dBm. The variations of the normalized population along the 
fiber are approximately 0.01 for 10 m of fiber and larger than 0.11 for 20m of fiber. This 
explains the increase in the differences between analytical and simulation result for 
the fiber length of 20m.



 RAYLEIGH BACKSCATTERING IN EDFA

378

Figure 5 Normalized population at the metastable level as function of the fiber length for an input signal 
power of -10 dBm and EDF length of (a) 10 m, (b) 20 m
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Inhomogeneous broadening in EDFAs

This lesson demonstrates the inhomogeneous broadening in an erbium-doped fiber.

In this lesson, the saturation regime in an EDFA is analyzed based on two 
approaches: 

• homogeneous broadening

• inhomogeneous broadening. 

For this purpose, the EDF component is set to the inhomogeneous model and 
simulations are done for different input signal powers. Figure 1 shows the system 
used in the simulations.

Figure 1 System layout

The output spectrum is obtained for different input saturating signals. The signal at 
1531 nm is the saturating signal and the values of the input signal power are varied 
from 0 to 1 mW to characterize different levels of saturation. Some of the EDF 
parameters are displayed in Figure 1, and the Inhomogeneous absorption and 
emission cross sections loaded by the component are shown in Figure 2.
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Figure 2 Inhomogeneous (a) absorption and (b) emission cross section

The equations used in the inhomogeneous model [1] use the homogeneous cross 
sections. In this case, the component needs to be set to generate the homogeneous 
cross section from the inhomogeneous cross sections provided by the user, Figure 2.

Figure 3 shows the numerical tab with the parameters set to generate the 
homogeneous cross sections using 13 Gaussians for the fitting. See the technical 
description for more information about how to generate the homogeneous cross 
sections. In this lesson, the value used for the inhomogeneous line width was 
11.5 nm.
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Figure 3 Numerical tab set to generate the homogeneous cross sections

The homogeneous cross sections generated by the component are shown in Figure 
4. These homogeneous cross sections are in good agreement with the homogeneous 
cross section presented by Desurvire in Figure 4.25 in [1].
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Figure 4 Homogeneous (a) absorption and (b) emission cross section

For the homogeneous broadening case, the inhomogeneous line width is considered 
to be zero or near zero and the system is simulated for the same parameters as in the 
inhomogeneous case.

The results found with the simulations are shown in Figure 5 and Figure 6. The output 
spectrum obtained for the homogeneous and inhomogeneous cases are presented in 
Figure 5. It is possible to see the behavior of the curves start to become different as 
the input power is increased. Although in the homogeneous case the saturation 
seems to act uniformly in the spectrum, in the inhomogeneous case, the effect of 
saturation is stronger near the saturating signal. 
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Figure 5 Output spectra in simulations with (a) homogeneous and (b) inhomogeneous model

Note: Input signal powers at 1531 nm of 1, 5, 10, 50, 100, and 500 W
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The compression in the output power is shown in Figure 6. Those curves are obtained 
by subtracting each saturated spectrum from the spectrum obtained without the 
saturation signal power. As expected, the compression in the inhomogeneous model 
is lower than in the homogeneous model for wavelengths far from the saturating 
signal.

Figure 6 Compression caused by saturation in (a) homogeneous and (b) inhomogeneous cases

These results show the differences between the homogeneous and inhomogeneous 
broadening in different saturation levels. However, the differences between the 
homogeneous and inhomogeneous model are more significant than the results 
presented in [2]. These differences can be related to the use of different parameters 
for the fiber, such as absorption and emission cross section.
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Notes:
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Power transients in EDFAs

This lesson demonstrates the transient effects in an EDFA caused by the addition or 
deletion of channels using the EDFA Dynamic models of the OptiSystem.

The performance of a WDM system can be critically affected by the adding-dropping 
of WDM channels since all channels present are amplified simultaneously by each 
amplifier and share the available saturated gain. The add-drop of the channels 
causes transient effects in the surviving channels. 

In the first part on this lesson, the transient effects are analyzed using the EDF 
Dynamic component. The system simulated is shown in Figure 1. The simulations 
analyze the power transients caused by adding channels to the system.

The signal at 1536 nm represents the surviving channel and has the input power 
correspondent to a certain number of channels. The signal at 1552 represents the 
add-channel and has the input power correspondent to the number of channels to be 
added in the system. 

It is assumed that the sum of the input powers of the channels is -2 dBm, which would 
correspond to 32 channels with input power of -17 dBm each. The CW signal of the 
add channel is modulated to represent an addition of channels at the time of 2 ms.

Figure 1 System layout

The main parameters of the EDF are displayed in Figure 1. The cross sections used 
in the simulations are similar to the aluminogermano silicate fiber (fiber type III) shown 
in Fig. 4.22 of Desurvire's book [1].
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Figure 2 Absorption and Emission cross sections

The different power proportions for the modulated add-channel and the surviving 
channel approximate different combinations in adding channels. The system in Figure 
1 analyzes the addition of 4, 8, 12, 16, 20, 24 and 28 channels. The input power 
distribution for the channels is shown in Table 2.
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Table 2 

28 24 20 16 12 8 4

-2.58 -3.25 -4.04 -5.01 -6.26 -8.02 -11.03

-11.03 -8.02 -6.26 -5.01 -4.04 -3.25 -2.58

Input power distribution

The results found in the simulations are shown in Figure 3.

Figure 3 Evolution of the power excursion of the channel at 1536nm for adds 4, 8, 12, 16, 20, 24 and 28 
channels

As expected, the increment of the number of channels in the system caused power 
transients in the output of the surviving signal. The amplitude of the power excursion 
is proportional to the number of channels added. After some time, the system reached 
the steady state again, but in a lower output power.

In the following section, the transients are analyzed with the EDF dynamic analytical 
component. The system used in the simulations is shown in Figure 4. In this case, the 
add-drop of channels was investigated. The different power proportions for the 

Number of channels to add

Input power of the 
surviving channel (dBm)

Input power add-channel 
(dBm)
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modulated channel at 1557.2 nm and the surviving channel approximate different 
combinations in the number of dropped and surviving channels. It was assumed that 
the total power of the two channels corresponds to 8 channels, each of which 
launched -14.7 dBm of output power in the EDF.

Figure 4 System layout

The main parameters of the EDF are displayed in Figure 4, and the absorption and 
emission cross-sections are shown in Figure 5.
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Figure 5 a) Absorption and (b) emission cross section

The channels were dropped and added at 2 ms and 6 ms, respectively. Figure 6 
shows the results for different values of the proportion of surviving channel power to 
the total power (which is kept constant). The results of the addition of channels shown 
in Figure 6 agrees with Figure 3. The drop of channels in the system tends to cause 
an increase in the output power of the surviving channels.
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Figure 6 Evolution of the power excursion of the survival wavelength at 1554nm for 7 different values of 
the surviving wavelength power as a proportion of the total input power

In a second example, the effect of different pump powers in power excursion was 
analyzed. In this case the input power in the surviving channel (1554 nm) and the 
modulated channel (1557.2 nm) was the same: -8.67 dBm. The power excursions 
were examined for 4 pump powers: 10.3 dBm, 12.5 dBm, 13.9 dBm, and 15.1 dBm. 
The results found are shown in Figure 7.
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Figure 7 Power excursion of the surviving wavelength at 1554 nm for four different pump powers values

For increasing pump power values the evolution of the power transient begins from 
higher inversion/gain levels and settles to higher gain levels with an increasing in the 
ASE causing a decreasing in the power excursions.

The results presented here are in very good agreement with studies in the references.
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Temperature dependence in EDFA

This lesson demonstrates the temperature dependence in the absorption coefficient 
of an EDFA.

The temperature dependence in an EDFA manifests through the variation in the 
absorption   and gain g  coefficients (or absorption a  and emission e  
cross-sections) [1], [2]. Here, to demonstrate the effect of temperature dependence, 
simulations are done using different temperatures and a method to characterize the 
EDF's absorption coefficient at each temperature is used. 

In the first part of this lesson, the method for calculating the EDF's absorption 
coefficient is described. The system shown in Figure 1 is used for the characterization 
of the absorption coefficient. It consists of a CW laser source with signal power equal 
-20dBm and wavelength varying at the range of 1450nm to 1650nm (the CW laser is 
in the sweep mode).

The Optical Power Meter Visualizer gives the output power in the EDFA. The Erbium 
doped fiber has the physical parameters shown in Figure 2(a) and the original 
absorption coefficient loaded is shown in Figure 2(b).

Figure 1 System layout
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Figure 2 (a) Main tab with the parameters used in the simulations (b) Absorption coefficient loaded
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The following procedure was used to calculate the absorption coefficient from the data 

obtained in simulations. To determine the value of the absorption coefficient of the 

EDF, simulations for two fiber lengths (5m and 0.5m) were conducted in the 

wavelength range of 1450 to 1650nm. Using the corresponding output signal powers 

 and , the absorption coefficient can be 

obtained by the equation

In Figure 3 we compare the original absorption coefficient loaded on the EDF and the 
calculated one using Equation 1. You can see the agreement between the two sets of 
results. Therefore, this procedure can be used to calculate the absorption coefficient 
of an EDFA.

Figure 3 Comparison between the original and the calculated absorption coefficient

In the second part of this lesson, the temperature dependence of the absorption 
coefficient is demonstrated. The method used to calculate the absorption coefficient 
is used again, but this time, the simulations considered different temperatures. With 
this procedure, the temperature dependence in the absorption coefficient is 
demonstrated.

(1)

Pout  L 5= m  Pout  L 0.5m= 

  
Pout  L 0.5m=  Pout  L 5= m –

5 0.5–
---------------------------------------------------------------------------------------------=
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To consider the temperature dependence in the Erbium-doped fiber component, 
Include Temperature Effect on the Enhanced tab must be selected, and the 
temperature that the cross sections (loaded) were measured at must be provided.

Here, the original cross sections (Figure 2b) were measured at 20C . Finally, user 
the current temperature must be defined in order for it to be considered in the 
simulation temperature parameter. Figure 4 shows an example using 80C  for the 
simulation.

Figure 4 Enhanced tab with simulation setup

Simulations were done for three temperatures, 40C– , + 20C , and + 80C . For 
each temperature, the absorption coefficients were calculated using Equation 1. 
Figure 5 shows the results for the three temperatures simulated. It is possible to see 
the differences in the absorption coefficients caused by the changes in temperature.

These results seem in good qualitative agreement with presented studies in [1][2]. 
The same approach can be taken to analyze temperature dependence in the gain 
coefficient. However, the procedure and the system setup used to calculate the gain 
coefficient will be different, because it will be necessary to find the fluorescence 
spectrum.
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Figure 5 Absorption coefficient calculated for different temperatures

This variation in the absorption and gain coefficients causes variation in the 
performance of the amplifier, gain, and noise was demonstrated in [1] and [2].
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Ytterbium-doped fiber amplifiers

The objective of this lesson is to demonstrate the performance of ytterbium-doped 
fiber amplifiers.

First of all, the gain spectra are analyzed for the pump wavelength at 910 nm and with 
different input pump powers: 1mW, 10mW and 30mW. The system used in the 
simulation is shown in Figure 1.

Figure 1 System layout for gain analysis

Figure 2 shows signal gain spectra obtained for three different pump powers.

The parameters used in this simulation are displayed in Figure 1, and they have 
similar values to those presented in [1], except with regard to the values of the 
absorption and emission cross-sections. Nevertheless, the results found are in good 
agreement with the results presented in [1].
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Figure 2 Amplifier gain spectra for three different input pump powers

In a second case, the gain spectra are calculated for two different pump wavelengths, 
910nm and 975nm. The system layout simulated is showed in Figure 3, and the fiber 
parameters used are similar to the parameters used in the previous example.

Figure 3 System layout

The results obtained in the simulation are shown in Figure 4.
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Figure 4 Gain spectra obtained for pump wavelengths at 910 nm and 975 nm

In the next case, the Ytterbium-doped fiber is double-clad. To set the ytterbium-doped 
fiber component to work as double-clad, the parameter Double-clad fiber 
(Enhanced tab) has to be set to True and the value of the pump reference has to be 
specified. The system used to simulate the double-clad fiber amplifier counter-
pumped is shown in Figure 5.

Figure 5 Layout of double-clad fiber amplifier counter-pumped system
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The EDF parameters used in this simulation are similar to those used in [2]. The 
forward and backward output power is calculated for input signal power varying from 
-30dBm to -30dBm for co-pumped and counter-pumped configurations. Figure 6 
shows the results. This figure is equivalent to Figure 2 of [2].

Figure 6 Output power versus input signal power for different pump schemes

References:

[1] Paschotta, R.; Nilsson, J.; Tropper, A.C.; Hanna, D.C., "Ytterbium-doped fiber amplifiers". IEEE 
Journal of Quantum Electronics, Vol.: 33, Issue: 7, Jul 1997, Pages: 1049-1056.

[2] Yong Wang; Hong Po, "Dynamic characteristics of double-clad fiber amplifiers for high-power 
pulse amplification". IEEE Journal of Lightwave Technology, Vol.: 21, Issue: 10, Oct. 2003, 
Pages: 2262- 2270.



 SPO OPTIMIZATION—SYSTEM MARGIN

405

SPO optimization—System margin

OptiSystem can optimize parameters in order to maximize, minimize or to target a 
value for results. This can be done by either using MPO or SPO optimizations. 

By using the optimization tool you can, for example, 

• optimize the fiber length of the EDFA to obtain the maximum gain

• calculate the attenuation/gain to obtain a target Q-Factor

• minimize the BER by optimizing the fiber length of the link.

In this example we show optimization of a single parameter by using SPO. It shows 
how to estimate the system margin. This margin shows the amount of power penalty 
that may be added to the system to get a defined Q factor or BER. Our target BER is 
10-9, or a Q-Factor of 6.The project is given in System margin.osd, shown in 
Figure 1.

Figure 1 Project layout

In this project, for illustrative purposes, the subsystem System under test is an 
empty system. The optimization will optimize the attenuation parameter of the 
Attenuator component to attain Max. Q-Factor of 6. The parameter attenuation will be 
the system margin in dB.

To set up the optimization, go to Tools|Optimizations... and insert a SPO 
Optimization. Then, select Gain Attaining type of optimization in the Main tab and 
set Result tolerance to 0.05. In the Parameter tab, add Attenuation of the 
Attenuator component into the Selected list. In the Result tab, add Max. Q factor of 
the BER Analyzer into the Selected list.

Figure 2, Figure 3, and Figure 4 show the Main, Parameter and Result tabs of the 
optimization set-up.
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Figure 2 Main tab of the SPO
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Figure 3 Parameter tab of the SPO
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Figure 4 Result tab of the SPO

In order to run the optimizations, go to File > Calculate in the Main menu, and select 
the Run optimizations in the Calculation dialog box, which also runs the simulation.
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Figure 5 Enabling optimizations

After the optimization is done, you will see that the system margin is approximately 
19 dB for a Q-Factor of 6 (see Figure 6).
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Figure 6 Optimization results



 SPO OPTIMIZATION—EDFA FIBER LENGTH

411

SPO optimization—EDFA fiber length

In this example we show optimization of a single parameter by using SPO. It shows 
how to optimize the fiber length to maximize the amplifier gain. The project is given in 
EDFA fiber length optimizationFig.osd. In order to run the optimizations 
with the components shown in Figure 1, the Laser power is -40 dBm. Default EDFA 
parameters are used.

Figure 1 Project layout

The optimization will optimize the Length parameter of the EDFA to get maximum 
gain as measured by Dual Port WDM Analyzer. 

To set up the optimization, go to Tools > Optimizations and insert a SPO 
Optimization. Then, select Maximize type of optimization in the Main tab and set 
Result tolerance to 0.1. In the Parameter tab, add a Length parameter of the EDFA 
component into the Selected list. In the Result tab, add Gain 1 (dB) result of the Dual 
Port WDM Analyzer into the Selected list. 

In order to run the optimizations, go to File > Calculate from the Main menu, and 
enable Run optimizations in the Calculation dialog box, which runs the simulation.

After 11 passes, fiber length for maximum gain is found to be 9.86. In this case, EDFA 
gain is about 38.1 dB.
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Notes:
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EDFA — Basic concepts

The sample file EDFA Basic Concepts.osd shows the basic characterization of 
the Erbium Doped Fiber Amplifier (EDFA). There are three design layouts: Gain 
Spectrum, Gain Saturation, and Amplifier Noise. They enable the characterization 
of the gain, noise figure, and output power under unsaturated and saturated signal 
input regime. These layouts refer to the topics: Gain Spectrum and Bandwidth, 
Gain Saturation, and Amplifier Noise.

In this example, the amplifier performance is characterized by using sweeps for the 
input parameters of the amplifier. the layouts Gain Spectrum and Amplifier Noise 
sweep the signal wavelength, while the layout Gain Saturation sweeps the signal 
input power in order to evaluate the amplifier performance with the small signal input 
power (~ -30 dBm) and saturated input signal power (~ 0 dBm).

The three layouts created in this project file are shown in Figure 1. The basic layout 
used in each layout considers one Erbium-doped fiber stage setup in a co-
propagating pump scheme. Erbium Doped Fiber model was used in this simulation. 
A single input signal operating in the C-band wavelength range is set in the laser 
source where small and large signal inputs are considered in the simulations.

Figure 1 Three different layouts created in this project file
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For each design layout we have three graphs showing the Output Signal Power, 
Gain, and Noise Figure versus the Sweep Parameter. The components settings can 
be modified and the simulations repeated in order to analyze the differences observed 
in the amplifier performance as a consequence of the change in parameter settings.

The absorption and emission cross section, input parameters which are critical in the 
numerical solution of coupled rate and propagating equations, are displayed in 
Erbium doped fiber component. Figure 2 shows the cross-section file used in this 
project file.

The cross section input files are characteristic to a specific fiber as well as the fiber 
dimensions specified in the Er doped fiber dialog box component, shown in Figure 3. 
However, it is interesting to change some fiber specifications in order to evaluate how 
it can modify the calculated results.

Figure 2 Cross-section file displayed in the Erbium doped fiber component Graphs
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Figure 3 Er doped fiber specifications

The basic layout used in the calculations to each layout is shown in Figure 4. 

Figure 4 Layout used in the basic characterization of the Erbium doped fiber amplifier setup in one fiber 
stage and co-pumped by 980 nm laser diode



 EDFA — BASIC CONCEPTS

416

Layout Gain Spectrum

In this first layout named Gain Spectrum, the signal wavelength of the CW laser 
signal is swept from 1525 nm to 1600 nm, which enables evaluating the spectral gain 
and the bandwidth of the amplifier.

The spectral gain calculated to -20 dBm of input signal power is shown in Figure 5.

Figure 5 Gain versus signal wavelength given in [nm] units considering signal input power equal to –20 
dBm

An additional graph which can be checked in the Gain Spectrum layout is the output 
power versus signal wavelength shown in Figure 6.
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Figure 6 Signal output power versus signal wavelength given in [nm] units calculated to a signal input 
power equal to –20 dBm
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Layout Gain Saturation

The layout Gain Saturation enables evaluating the amplifier performance as a 
function of the signal input power. The signal input power is swept from small signal 
to large signal regime, i.e. -40 dBm to 0 dBm. The amplifier performance given by 
gain, output power and noise figure are respectively shown in Figure 7, Figure 8 and 
Figure 9.

Figure 7 Gain versus signal input power

Figure 8 Amplified signal versus signal input power
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Figure 9 Noise figure versus signal input power
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Layout Amplifier Noise

The signal wavelength is the parameter swept in this layout, which enables 
calculating the spectral noise of the amplifier. Signal and pump wavelength as well as 
the fiber parameters can be modified for further evaluation of the amplifier 
performance.

Figure 10 Noise bins as a function wavelength used in the calculations. Each curve in this graph resulted 
from the different iterations
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Booster Amplifier

The project file Booster Amplifier.osd shows the characterization of a 
booster/power amplifier setup in a single erbium-doped fiber stage heavily doped, 
bidirectionally pumped by two 980 nm pump lasers. A large signal input power is 
considered in this case, since high signal input helps to produce high output power, 
which is necessary to booster/power amplifiers. As a consequence, moderate gain 
will be observed in this case. The low noise figure requirement of EDFAs is not so 
critical in this case, because an increase in NF can be tolerated. It is important to 
mention that typical configurations of booster amplifiers include multiple Er-doped 
fiber stages.

Figure 1 shows the layout of the booster amplifier. A bidirectional pump was used to 
exemplify the typical pump scheme observed in booster amplifiers. The Optical 
Spectrum Analyzer connected at Output Port1 shows the amplified signal obtained 
after calculating this sample file. The component Dual Port WDM Analyzer gives the 
calculated results generated by all the propagating signals, signals and pump.

The output power, gain and noise figures calculated as a function of signal input 
power are shown in Figure 2, Figure 3 and Figure 4. It is possible to observe the gain 
being compressed as a function of the signal input increasing on Figure 3.

The noise figure curve calculated sweeping the signal input power to the booster 
amplifier utilized the same input parameters as before. There is a region in the curve 
in which NF is minimized as a function of the signal input considered. Observing 
graphs related with co- and counter-propagating ASE helps to understand how the 
noise figure curve appears as this shape.
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Figure 1 Layout used in the Booster amplifier

Figure 2 Signal output power versus signal input power calculated to the booster amplifier
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Figure 3 Gain versus signal input power calculated to the booster amplifier

Figure 4 Noise figure versus signal input power calculated to the booster amplifier

The power of both pump lasers co- and counter-propagating can be modified as well 
as the Er-doped fiber length. Fiber specifications can also be modified and the results 
compared with the previous case.
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Notes:
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Inline Amplifier

The project file Inline Amplifier.osd shows the characterization of an inline 
amplifier setup in a single erbium-doped fiber stage, pumped by one 980 nm-pump 
laser.

A small signal input power is considered in this case, where results with high gain and 
small noise figure values are desirable. The signal input power is swept from -40 dBm 
to -20 dBm to enable the checking of the gain, noise figure, output power, and OSNR 
as a function of signal input power. The signal input power swept is in the layout 
"Signal input power" contained in the file Inline Amplifier .osd.

After sweeping iterations over the signal input power, the amplifier performance can 
be checked in the graphs shown in Figure 1.

Figure 1 Graphs presenting the inline amplifier performance setup in a co-propagating pump scheme

Two different pump schemes which consider co- and counter-propagating pump are 
available, in "Co-pump power" and "Counter-pump power" layouts, shown in Figure 2 
and Figure 3. The performance of the inline amplifier with respect to the co- and 
counter-propagating pump scheme can be checked in the Gain, Noise Figure, and 
Output Power graphs.
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Figure 2 Inline amplifier layout considering a co-propagating pump scheme

Figure 3 Inline amplifier layout considering a counter-propagating pump scheme

The amplifier performance of the amplifier setup in a co- and counter-propagating 
pump scheme can be compared to the graphs available. Pump wavelength equal to 
980 nm was considered in both cases. Gain versus pump power is shown in Figure 4 
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considering the co- and counter-pump scheme, which allows for the evaluation of the 
most efficient pump scheme to the EDFAs.

Figure 4 Comparing gain performance of an EDFA setup in a co- and counter-propagating pump scheme

Different parameters can be changed in this example, in which the new results are 
compared with the previous ones. The wavelength pump power equal to 980 nm, 
considered in the three different layouts included in this project file, can be substituted 
with 1480 nm, for example. Different pump power, signal wavelength, and fiber 
parameters can be considered to perform additional simulations.
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Notes:
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Preamplifier

The project file Preamplifier.osd shows the characterization of an inline amplifier 
setup in a single erbium-doped fiber stage, pumped by one 980 nm-pump laser in a 
co-pump scheme.

A small signal input power is considered in this case, where results with high gain and 
small noise figure values are desirable. The erbium doped fiber length is swept from 
6 m to 15 m to enable the checking of the gain, noise figure, output power, and OSNR 
as a function of fiber length. The pump wavelength considered in layouts "Pump 980 
nm" and "Pump 1480 nm" is 980 nm and 1480 nm.

In both layouts, signal input power is -35 dBm at 1550 nm. The performance of the 
preamplifier with respect to the wavelength pump can be checked in the graphs of 
gain, noise figure, and output power.

The basic layout used in this preamplifier example is shown in Figure 1, where just 
the pump wavelength is changed from 980 nm to 1480 nm in the component Pump 
Laser 1.0.

Figure 1 Preamplifier layout

The gain of the preamplifier is shown in Figure 2. Different parameters can be 
changed to generate new results to be compared with the previous ones. Different 
pump power, signal wavelength, and fiber parameters can be used to perform 
additional simulations.
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Figure 2 Gain versus erbium doped fiber length considering 980 nm and 1480 nm as wavelength pump
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Pumping requirements

The amplifier performance characterized by the signal output power, gain and noise 
figure depends on the pump wavelength. The project file "Pumping 
requirements.osd" shown in two different layouts, "Pump power 980 nm" and 
"Pump power 1480 nm", details an amplifier pumped by 980 nm and 1480 nm. The 
980 nm and 1480 nm pump wavelengths are the most important ones used in EDFAs. 
Figure 1 shows the layout setup in a co-propagating pump scheme with 980 nm and 
1480 nm wavelength pumps.

Figure 1 Amplifier setup in a co-propagating pump scheme used with 980 nm and 1480 nm wavelength 
pump

High amplifier gains in the range 30-40 dB can be obtained in this project file, 
sweeping the pump power from 10 mW to 200 mW. The signal input power 
considered in this case is -20 dBm. Output power calculated in this project is in the 
range 6 - 17 dBm, while the noise figure varied between 3 - 5 dB. Different signal input 
power or signal wavelength as well as fiber parameters can be set in this example and 
the new results can be compared with previous one. Results obtained with these 
layouts are shown in Figure 2. New Erbium-doped fiber data can be used in this case 
and results compared. The cross-section or Giles parameters need to be updated as 
well as the fiber dimension and doping characteristics.

EDFAs can be designed to operate in such a way that the pump and signal beams 
propagate in opposite directions, a configuration referred to as backward pumping to 
distinguish it from forward-pumping configuration in which both beams propagate 
along the same direction. Backward or counter-propagating pump scheme is 
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exemplified in the layout "Backward pump @ 980 nm". The pump power is swept from 
10 to 150 mW and the signal input power is -20 dBm. 

Figure 2 Gain versus pump power considering a co-propagating pump schemes @ 980 nm and @ 1480 nm 
wavelength pump

The layout considering backward or counter-propagating pump scheme is shown in 
Figure 3. Figure 4 shows the gain versus pump power when 980 nm and 1480 nm are 
considered as wavelength pump. The influence of the selected pump scheme in the 
amplifier performance can be checked considering unsaturated or saturated regime 
just changing the signal input power range.
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Figure 3 Amplifier setup in counter-propagating pump scheme used with 980 nm and 1480 nm wavelength 
pump

Figure 4 Gain versus pump power considering a co-propagating pump schemes @ 980 nm and @ 1480 nm 
wavelength pump
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The layout Bidirectional pump @ 980 nm added to this project file considers the 
bidirectional pumping configuration, where the amplifier is pumped in both directions 
simultaneously by using to semiconductor pump lasers located at the two fiber ends. 
The advantage of this pump scheme can be checked setting small-signal or large 
signal input and observing the amplifier performance given by the gain, output power 
and noise figure graphs displayed in Views.
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Transient Control in EDFAs

Our goal here is to demonstrate how to use OptiSystem to simulate transient control 
schemes to avoid or minimize the impacts of transient effects in the system 
performance. 

As is well known, failures in some channels and/or add-drop of channels due to 
network reconfiguration can cause power transients that cause error bursts, which are 
unacceptable to service providers. 

To overcome this problem, several schemes to protect amplified networks against 
power transients have been developed. Here we have worked on one control 
scheme: EDFA gain clamping, which will be demonstrated in the next section.

In the examples simulated here, we have used a 16-channel WDM system. The 
addition and dropping of 8 channels are simulated by modulating the optical signal by 
a square wave at a low bit rate of 4K bits/s. 

The transmitter setup configuration and the optical signal waveform at modulator 
output are shown in Figure 1. 

Eight signals are dropped at t = 1.5 ms and added back at t = 5.5 ms. The signal power 
for each channel is -20 dBm (10 mW) and the modulated and surviving channels have 
the channel spacing of 1.6 nm between each other. 

The sample rate used in the signals was enough to allow the delay due feedback loop 
to be considered in the simulations.

Figure 1 Transmitter setup configuration with 16 channels, where 8 channels are modulated to represent 
add-drop of channels in the system. One modulated optical signal is shown in the optical vizualizer.
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Gain clamping

There are two basic configurations of EDFA gain clamping [1]. 

In the first configuration, the Fabry-Perot laser structure is used with two band-pass 
reflectors placed in the input and output ends of the amplifiers. The laser wavelength 
is determined by the center wavelength of the reflectors. 

The laser cavity loss is determined by the peak reflectivity of the reflectors and losses 
between the two reflectors. 

One example of this configuration can be seen in Figure 2 

Two components appear in this setup. They were created to allow the 
multiwavelength time-driven simulations, and consequently the transient control 
simulations. 

The "Convert To Samples" component receives the optical channels in this input port 
and transforms these block signals in individual samples that are launched forward 
sample by sample in the correspondent time step. 

The other component is the "Convert From Samples", which does the opposite. It 
receives the individual samples of each channel and assembles the different 
channels.

Figure 2 Gain-clamping EDFA in a Fabry-Perot laser configuration

We have run the simulation with the drop and add of 8 channels at 1.5 ms and 2.5 ms, 
respectively. The EDFA was designed to give a gain of approximately 19 dB for each 
channel. Simulation results for the surviving channel at 1540.3 nm can be seen in the 
Optical Time Domain Visualizer show in Figure 3 Small oscillations are present 
exactly at the point where the channels are dropped and added.
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Figure 3 Optical surviving channel at 1540.3 nm after the EDFA in a Fabry-Perot laser configuration

In the second configuration, the ring laser structure is used. 

Part of the signal and ASE is coupled in one end of the amplifier and fed back to the 
amplifier input through a feedback loop. In the feedback path, the signals (including 
ASE) are filtered and attenuated to control the lasing conditions. 

Figure 4 shows the gain clamping EDFA setups with the feedback loop including a 
band-pass filter and an attenuator.

Figure 4 Gain-clamped EDFA in a ring laser configuration

The same add-drop simulation was done for the gain-clamped EDFA ring laser. The 
EDFA was designed to give a gain of approximately 18 dB. 

Figure 5 presents 4 surviving channels after the EDFA amplifier. We can verify the 
oscillations caused by the drop and add of channels and see that the oscillations are 
higher and faster when the channels are dropped.
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Figure 5 Output signal power of 4 surviving channels

The simulations results presented here are in agreement with previous results 
presented in the literature. Simulations are not limited to these control schemes. 
Variations in the previous control schemes can be introduced.
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Amplifier Characteristics

There are many decisions to make regarding system implementation of specific 
amplifiers. 

To make these decisions, a group of typical key characteristics must be extracted 
from the amplifier. For example, the gain and noise figure versus the input signal 
wavelength, input signal power or input pump power.

To extract the key characteristics of the optical amplifier, OptiSystem allows the user 
to easily iterate over these parameters and characterize the amplifier design.

The project "Amplifier Characteristics.osd" shows how to obtain the gain, noise figure 
and output power versus input power and signal wavelength. 

The calculations are based on results from a WDM Analyzer inserted between two 
isolators. The user can replace the amplifier between these isolators and obtain the 
same curves for different amplifiers.

Figure 1 Project "Amplifier Characteristics.osd"
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Loading the project
• Go to the OptiSystem sample files folder, "…Optiwave Software\OptiSystem 

OptiSystem 9\Samples\Optical amplifiers".

• Open the Project "Amplifier Characteristics.osd". 

This project has three layout versions

• signal wavelength

• input power

• pump power

In the version "Signal Wavelength", the iterations are swept over the laser signal 
wavelength and generate the following graphs: 

• Gain x Wavelength

• Noise Figure x Wavelength

• Output Power x Wavelength

In the version "Input Power", the iterations are swept over the laser signal power and 
generate the following graphs: 

• Gain x Input Power

• Noise Figure x Input Power

• Output Power x Input Power

In the version "Pump Power", the iterations are swept over the pump power and 
generate the following graphs: 

• Gain x Pump Power

• Noise Figure x Pump Power

• Output Power x Pump Power

Running the simulation
• To run the simulation you can go to the File menu and select Calculate. You can 

also press Control+F5 or use the calculate button in the toolbar. After you select 
Calculate, the calculation dialog box should appear.

• In the calculation dialog box, press the Play button (Figure 2).
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Figure 2 Calculating project
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Viewing the results
• Go to the report page (Figure 3).

Figure 3 Report page

Figure 4, Figure 5, and Figure 6 display some of the graphs that are generated for this 
simulation. 

Observe the Gain x Wavelength, Output Power x Input Power and Gain x Pump 
Power for the amplifier.
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Figure 4 Gain x wavelength

Figure 5 Output power x input power

Figure 6 Gain x pump power
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Notes:
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Automatic Control Simulation

OptiSystem allows the user to optimize the layout in a variety of ways. 

User-defined optimizations allow the user to select a parameter and then select a 
result. The parameter is then manipulated through a number of iterations in order to 
hit the target value of the result. 

The user can select a target gain or output power that is measured with the WDM 
Analyzer and OptiSystem will search for the pump power to achieve the target value.

Loading the project
• Go to the OptiSystem sample files folder, "…Optiwave Software\OptiSystem 

9\Samples\Optical amplifiers".

• Open the Project "Automatic Control.osd".

Figure 1 presents the amplifier layout. 

This project has three layout versions:

• Automatic Gain Control (AGC)

• Automatic Power Control (APC)

• Automatic Peak Power Control (APPC)

Figure 1 Project "Automatic Control.osd"
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Automatic Gain Control

The automatic gain control (AGC) maintains the EDFA gain at a fixed level during 
signal perturbations or changes in the system loss. 

The implementation of AGC using OptiSystem requires inserting a WDM Analyzer 
between the two points of interest (to calculate the gain) and adding and configuring 
optimizations.

Because we want to keep the total gain constant while controlling the pump power, 
we need the WDM Analyzer (Figure 1) to calculate the gain and the optimization 
engine to calculate the pump power to achieve this gain.

Automatic Power Control 

The procedure to obtain Automatic Power Control (APC) is the same as that used to 
obtain AGC. However, instead of monitoring the gain, we will monitor the total output 
power.

We are assuming that the total output power must be kept constant by controlling the 
pump power. 

We need to insert a WDM Analyzer in the layout to calculate the signal output power 
and set an optimization to calculate the pump power to achieve the target signal 
output power. 

Automatic Peak Power Control 

The procedure to achieve Automatic Peak Power Control (APPC) is the same used 
to obtain APC and AGC. However, instead of monitoring the total gain or total output 
power, we will monitor the output power of one signal at a particular wavelength.

We are assuming that the total output power must be kept constant by controlling the 
pump power. We need a probe to calculate the signal power and an optimization to 
calculate the pump power to achieve this signal power.

Optimization

We will demonstrate the setup for the AGC. 

For this setup, the user must select the 

• parameter to be optimized (the pump power)

• result to be monitored (the total gain)

• range with a target value. 

The other two types of control follow the same basic steps.

• To open the simulation setup, you can go to the File menu and select Calculate. 
You can also press Control+F5 or use the calculate button in the toolbar. After you 
select Calculate, the calculation dialog box should appear.

• In the calculation dialog box, press the 'Optimizations…' button (Figure 2).

• Double-click on the SPO (single parameter optimization) Optimization item.

The SPO optimization parameters are described in Figure 2. 
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The user set the optimization type to goal attaining. The goal is to control the 
parameter Power from the Pump Laser to reach the target Total Gain from the WDM 
Analyzer. 

Pump power varies from 15 to 165 mw, and the gain target is 25 dB.

Figure 2 Optimization set-up for AGC amplifier
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Running the simulation
• To run the simulation, you can go to the File menu and select Calculate. You can 

also press Control+F5 or use the calculate button in the toolbar. After you select 
Calculate, the calculation dialog box should appear.

• In the calculation dialog box, enable 'Run all optimizations…' (Figure 3).

• Press the Play button.

• Select the Optimization tab in order to monitor the progress of the Optimizations 
(Figure 3).

Figure 3 Calculating project

Viewing the results
• Go to the report page.

• Select the tabs AGC, APC or APPC to see the results.

Observe the pump power and gain graphs for the AGC amplifier (Figure 4). 

The total signal power for the APC amplifier (Figure 5) and the signal power for the 
APPC amplifier (Figure 6).

The AGC provides a constant gain of 25 dB, the APC provides a constant output 
power of 10 dBm and the APPC a constant power of 10 dBm at 1530 nm.
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Figure 4 AGC amplifier, pump power and gain
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Figure 5 APC amplifier, pump and signal power
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Figure 6 APPC amplifier, pump and signal channel power
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Notes:
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Erbium-doped Fiber Laser

Er-doped fiber lasers (EDFLs) can be viewed as EDFAs operating in the particular 
regime where coherent oscillation of ASE occurs due to some feedback means. 

A standard definition could be the following: EDFLs are used as sources for coherent 
light signal generation, while EDFAs are used as wave-wave amplifiers for coherent 
light signal regeneration.

All EDFLs can be pumped with compact, efficient, and sometimes inexpensive laser 
diodes. They are compatible with different fibers and fiber optic components used in 
communications so they have negligible coupling losses. 

Fiber waveguiding and splicing alleviate any mechanical alignment of parts and 
provide superior environmental stability.

There are many possible laser cavity designs and configurations. 

The tunable EDFL configuration presented here uses an all-fiber ring laser cavity. 
Wavelength selectivity can be achieved by using a tunable transmission filter.

This example will show how OptiSystem can simulate laser ring design and ASE 
sources. 

The setup parameters are very important to obtain a steady state output power. This 
means the user must find the minimum number of convergence iterations to obtain 
correct results.
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Figure 1 Project "Ring Laser.osd"
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Loading the project
• Go to the OptiSystem sample files folder, "…Optiwave Software\OptiSystem 

9\Samples\Optical amplifiers".

• Open the Project "Ring Laser.osd".

Figure 1 displays the laser layout.

Observe that the laser wavelength is selected, which changes the filter center 
wavelength, and the laser linewidth is selected, which changes the filter bandwidth. 

This laser will generate power at 1550 nm with 1 nm of linewidth (Figure 2).

Figure 2 Filter component parameters
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The global parameter Iterations (Figure 3) is very important to obtain a steady state 
output power. The user must find the minimum number of iterations to obtain correct 
results.

Figure 3 Global parameters: iterations

Running the simulation
• To run the simulation you can go to the File menu and select Calculate. You can 

also press Control+F5 or use the calculate button in the toolbar. After you select 
Calculate, the calculation dialog box should appear.

Viewing results
• Double click on Optical Spectrum Analyzer.

• Increase signal index parameter to 30 (max value - same as global parameter 
Iterations).

Figure 4 shows the signal at the coupler output port. 

The user can increase the signal index parameter from 0 to 30, and see the signal 
changing until it reaches a steady-state value around 25 iterations.
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Figure 4 Signal at the coupler output
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Notes:
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Reflective Amplifier

In Reflective EDFAs, a device (e.g. mirror, grating) is placed at the EDFA output end 
to reflect whether the pump or the signal (double-passing the pump or signal through 
the EDFA) produces a net gain enhancement.

There are three basic configurations: 

• EDFA with reflected pump only

• EDFA with reflected signal only

• EDFA with reflected pump and signal

The configuration presented here is with reflected signal only. The signal is reflected 
using a reflective filter.

Loading the project
• Go to the OptiSystem sample files folder, "…Optiwave Software\OptiSystem 

9\Samples\Optical amplifiers".

• Open the Project "Reflective Amplifier.osd".

Figure 1 displays the amplifier layout. 

Observe that a circulator and a reflective filter are responsible for sending the signal 
to the fiber and reflecting it back.
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Figure 1 Project "Reflective Amplifier.osd"
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Observe that the reflective signal wavelength is selected by changing the filter center 
wavelength at the reflective filter properties dialog box (Figure 2).

Figure 2 Filter component parameters

The global parameter Iterations (Figure 3) is very important to obtain a steady state 
output power. 

The user must find the minimum number of iterations to obtain correct results.
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Figure 3 Global parameters: iterations

Running the simulation
• To run the simulation, you can go to the File menu and select Calculate. You can 

also press Control+F5 or use the calculate button in the toolbar. After you select 
Calculate, the calculation dialog box should appear.

Viewing results
• Double click on the visualizers (Dual Port WDM Analyzer and Optical Spectrum 

Analyzer).

• Increase signal index parameter to 20 (max value - same as global parameter 
Iterations).

Figure 4 displays the WDM Analyzer showing the Gain. 

The signal can be followed with the OSA tool to verify how the signal is changing 
along the amplifier. 

Figure 5 shows the signal at the coupler output port.
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Figure 4 WDM Analyzer

Figure 5 Signal spectrum at the coupler output
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Notes:
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Split-Band Amplifier

The gain peak shifts to longer wavelengths as the fiber length increases and the 
population inversion decreases. 

The bandwidth of an EDFA can be increased by separating the gain spectrum into two 
bands, 1530-1560 nm and 1570-1610 nm, with a band-splitting filter. The gain can 
then be optimized in the two regions separately.

Loading the project
• Go to the OptiSystem sample files folder, "…Optiwave Software\OptiSystem 

9\Samples\Optical amplifiers".

• Open the Project "s Amplifier.osd". 

Figure 1 displays the project. 

The first path was optimized to work in the 1530-1565 nm region, and the second path 
was optimized to work in the 1570-1605 nm region.

Figure 1 Project "Split Band Amplifier.osd"
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The 3 Port Filter component splits the signal in the two paths. 

In Figure 2, the 3 Port filter properties dialog boxes has the center wavelength at 
1587.5 nm and 35 nm of bandwidth. The first port will have the rectangular transfer 
function and the second will have the complementary transfer function.

Figure 2 Filter component parameters
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Running the simulation
• To run the simulation, you can go to the File menu and select Calculate. You can 

also press Control+F5 or use the calculate button in the toolbar. After you select 
Calculate, the calculation dialog box should appear.

Viewing results
• Double click on the visualizers (Dual Port WDM Analyzer and Optical Spectrum 

Analyzer).

• Increase signal index parameter to 7 (max value).

Figure 3 displays the WDM Analyzer showing the Gain. 

Note that the gain is approximately 20 dB (1530-1575nm) for the first path, and 11 dB 
(1580-1605nm) for the second path.

The signal can be followed with the OSA tool to verify how the signal is changing 
along the amplifier. 

Figure 4 shows the signal at the coupler output port.

Figure 3 WDM Analyzer
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Figure 4 Signal spectrum at the coupler output
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Dynamic Amplifier Using Ytterbium-Doped Fiber

The objective of this lesson is to demonstrate the amplification of a sequence of 
Gaussian pulses by an ytterbium-doped fiber amplifier using the dynamic model.

To analyze the dynamic characteristics of the high-power ytterbium-doped double-
clad fiber amplifier considering pulses in repetition rates of KHz, a dynamic ytterbium-
doped fiber model is necessary. 

In this case, a sequence of 5 Gaussian pulses with a repetition rate of 100 KHz was 
used. 

Figure 1 shows the system designed for this simulation. See sample 
Ytterbium_Double_Clad_Dynamic_100KHz.osd.

Figure 1 System layout of the fiber amplifier

The input pulse peak power is 50 W and the energy in the pulse is 1uJ. The optical 
signal in the amplifier input with the sequence of Gaussian pulses is shown in Figure 
2(a)
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Figure 2 Optical signal at the amplifier (a) input and (b) output

(a)

(b)

The optical signal amplified is shown in Figure 2(b). 



 DYNAMIC AMPLIFIER USING YTTERBIUM-DOPED FIBER

471

The first output pulse exceeds the successive ones because the energy stored in the 
amplifier was not recovered before the successive pulse. 

The first output pulse can be seen in Figure 3.

Figure 3 First output pulse
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Notes:
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Gain Flattening Filter Optimization

EDFAs have a wavelength-dependent gain; i.e., some wavelengths are amplified 
more than others. A gain flattening filter restores all wavelengths to approximately the 
same intensity. Project Gain Flattening Filter Optimization.osd demonstrates the 
gain flattening filter optimization engine that is included with OptiSystem. 

The system layout is presented in Figure 1. The WDM Transmitter generates eight 
channels from 195 THz to 196.4 THz, with power of -20 dBm per channel.  The Gain 
Flattening Filter component is placed after the EDFA and it will equalize the amplifier 
gain. 

Figure 1 System layout of the fiber amplifier

Figure 2 shows the steps to access OptiSystem optimization dialog box.
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Figure 2 Accessing the optimizations

Figure 3 shows the main parameters of the optimization. The optimization will run 10 
times, targeting a gain ripple of 0.1 dB from 1500 to 1600 nm. The minimum 
transmission value for the filter is -40 dB and the maximum value is -0.1 dB. The 
transmission values of the filter will be optimized at the user defined frequencies 
defined in the filter. The components tab should have the filter component selected 
and the visualizers tab should have the dual port analyzer selected. 

In order to run the optimization, simply calculate the project. Make sure the 'Run all 
optimizations' check box is enabled. During the calculation the user can click on the 
Optimization tab and visualize the progress of the optimizations (Figure 4).



 GAIN FLATTENING FILTER OPTIMIZATION

475

Figure 3 Optimization main parameters
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Figure 4 Optimizing the filter

In this particular project we have the signal before and after the gain flattening filter 
available in the report page (Figure 5). The shape of the filter is also available in the 
report. The user can also visualize the overall gain of the amplifier using the WDM 
analyzer and the value of the filter transmission values by looking at the filter 
‘Transmission’ parameters.
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Figure 5 Signals before and after the filter:
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Notes:
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Amplification of multiple modes in Er-doped 
multimode fibers

The Er-doped Multimode Fiber component was designed to allow the analysis of 
multiple modes amplification in large mode area fibers. The components are very 
similar to the original single-mode doped fiber amplifiers, however now the refractive 
index information and ion distribution profile can be defined by the user (see main tab 
parameters in the figure below).

Figure 1 Doped fiber parameters

Based on the parameters specified, the component's mode solver calculates the 
modes supported for the signal, pump and ASE bands. The user can also define if all 
supported modes will be equally excited ( for pump and/or signal channels) or the 
power distribution ratio between the supported modes will be calculated based on 
coupling coefficients, in this case an initial optical excitation field has to be defined for 
pump and/or signal.

The following example shows an erbium-doped fiber (double clad fiber), where all 
signal modes supported are equally excited (MM EDFA 
ExampleAllModesEquallyExcited.osd).
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Figure 2 System layout.

The refractive index profile (step index) and Er ion distribution (uniform) used are 
displayed in the figures below: 

Figure 3 (a) Refractive index profile and (b) Ion distribution.

After running the simulation, the following results were obtained:

Total Signal, Pump, and ASE power evolution along the fiber length.
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Figure 4 Total Signal, Pump, and ASE power evolution along the fiber length.

The fiber at 1550 nm (signal wavelength) supports 3 guided modes: LP01 and LP11 
(two helical polarities). 

The normalized radial intensity (azimuthal angle is 0) for LP01 (black line) and LP11 
(red line) are displayed in the figure.
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Figure 5 Radial profiles.

The power evolution along the fiber length for LP01 (black line) and LP11 - sum of the 
sin and cos components - (red line) were also calculated.

Figure 6 Power evolution.

Based on the modes power distribution at the fiber output, the profile of the output 
beam is displayed:
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Figure 7 Output beam.
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Notes:
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S-band amplification using Tm-DFA

The system designed amplifies a set of 16 channels in the S-band going from 1450 
nm to 1525 nm. Three different amplifier lengths are simulated and the gain curve is 
plotted in the report page.

Sample: MODB_ModulationSystem.osd

Figure 1 Thulium-doped fiber amplifier layout.
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Figure 2 Gain curves for 2.4 m (black), 7 m (red), and 8.1 m (green) of Tm-doped fibers.
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Ultrashort Pulse Fiber Laser

The system demonstrates a fiber laser, based on passive mode locking using a 
saturable absorber, capable of producing ultrashort pulses

Sample: UltraShortFiberlaser.osd

The system layout presented in the figure below is a unidirectional ring cavity 
composed of an optical fiber amplifier (here represented by a gain fiber numerical 
modeling that is emulating an ytterbium-doped fiber), an undoped fiber and a DC 
component that can be varied to change the net cavity dispersion. The saturable 
absorber is used to achieve mode locking and generate the optical pulse. The white 
light source provides the noise that initialize the pulse generation.

Figure 1 Ultrashort pulse fiber laser layout.

The system run multiple iterations and the convergence monitor component stops the 
calculation once the output pulse reaches a stable condition.
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Figure 2 Output (a) spectrum and (b) time-domain signal after first iteration

Figure 3 Output (a) spectrum and (b) time-domain signal after convergence in the results (1293 iterations).
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